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LICENSE NUMBER
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To install ASM as an evaluation copy, select the evaluation option on the licensing page of
the setup wizard. Installing an evaluation copy of ASM will not require you to enter any
licensing or license server information. The evaluation version of ASM is valid for 30 days.
ASM automatically sets up an Alert notifying you of the pending expiration of your
evaluation version each time the ASM service starts.

Once you purchase a license for ASM, you must contact your sales representative to obtain
the product license number. A license number based on your machine ID and other licensing
requirements you provide them will be sent to you for activating ASM. Enter that license
information using the New License Wizard in the License Server Administrator.

Once the ASM license is entered in the License Server, use the Setup wizard to update the
licensing information for ASM.  Select the Edit product license information option in the
Setup wizard and enter the name for the License Server computer into the wizard on the
Licensing Information page.

For further information about registering license information in the License Server, refer to
the License Server System Guide.
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PREFACE

APPLICATION STORAGE MANAGER AND DISKXTENDER

The Windows NT/2000 edition of Application Storage Manager (ASM) was
developed for StorageTek by OTG Software and is based on their DiskXtender (DX)
product.  With ASM and a full line of world-class tape drives and tape libraries,
StorageTek can deliver A COMPLETE SOLUTION for cost-effective storage
management of your standalone and distributed Windows NT/2000 systems.

BENEFITS

MEDIASTOR allows you to make storage media available to external applications like
DISKXTENDER, and to manage the media in storage devices attached to the
MEDIASTOR computer. All drive, library, and media specific issues are handled and
optimized by MEDIASTOR, allowing clients to simply save and retrieve files as
needed.

MS provides comprehensive drive and library management capabilities, allowing
you to make multiple types of media and media devices available to applications
designed to communicate with MEDIASTOR. MS also monitors system warnings and
errors, and can be configured to send alerts to specific users or computers.

The System Guide explains how to install, configure, and utilize MEDIASTOR to
manage the hardware being used for file migration. It contains all the necessary
information to achieve the best results for implementing and customizing your
automated data storage solution.
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DOCUMENTATION CONVENTIONS

The following conventions are used throughout the MEDIASTOR manual to represent
specific types of information.

Table 1: Documentation Conventions

THIS CUE: REPRESENTS:

monospaced text Characters that must be typed on your screen exactly as
they appear in this document.

<SMALL CAPITALS> Keys on your keyboard used in combination or
sequence. For example <ALT>+B means to hold down
the <ALT> key while pressing B, and <ALT>, F, X means
to press and release each of the keys in order: first
<ALT>, then F, then X.

ALL CAPITALS Directory names, filenames, and acronyms.

italics References to manual titles, chapter titles, and section
headings; placeholders; and emphasis.

WARNING ����
Precautionary note between
two lines.

Warnings about actions that could have adverse affects
on the functionality of the MS system.

NOTE ����
Explanatory note between
two lines.

Additional information needed as you follow the step-
by-step operations in this manual.

CHAPTER SUMMARY

The following table summarizes each chapter of this document:

Table 2: Chapter Summary

CHAPTER: DESCRIPTION:

Chapter One: Introduction on
page 1

This chapter provides a brief overview of the
system, including its concepts and components.

Chapter Two: Getting Started
on page 11

This chapter contains instructions for installing
MEDIASTOR software.

Chapter Three: Using the
Administrator on page 35

This chapter describes the Administrator interface
and basic functionality.
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CHAPTER: DESCRIPTION:

Chapter Four: Managing
MediaStor on page 59

This chapter details basic MEDIASTOR computer
and service management issues, including
computer registration, report capabilities, error
lookup, service management, and computer
properties. This chapter also details diagnostic and
recovery capabilities such as event and error
logging and repair disk (registry backup)
functions.

Chapter Five: Managing
Hardware on page 121

This chapter provides details on configuring
MEDIASTOR hardware and details on drive, library,
and tower management.

Chapter Six: Managing
MediaStor Media on page 181

This chapter deals primarily with accessing
information about the media and how to move the
media between the Application and Scratch Pools.

Chapter Seven: SCSI Manager
on page 195

This chapter describes the SCSI Manager utility,
which allows you to view all SCSI devices
connected to the MEDIASTOR computer and
perform diagnostics independent of MS.

Chapter Eight: Jukebox
Manager on page 227

This chapter describes the Jukebox Manager
utility, which allows you to view all libraries
connected to the MEDIASTOR computer,
independent of MS.

ONLINE HELP

Help is available online from any MEDIASTOR dialog box. For a description of the
dialog box, press the <F1> key. A Help window will be displayed, outlining the
dialog box parameters and fields.

A knowledgebase help file with error descriptions, tech notes, software notes,
fixed/known bugs is also available from the Help option in the OTG MEDIASTOR
program group. This system guide is also available in PDF format on the installation
CD.
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CCHHAAPPTTEERR
OONNEE

INTRODUCTION

DISKXTENDER MEDIASTOR (MS or MEDIASTOR) is a remote storage solution that
provides transparent hardware control and support for multiple media types and
device types. You can use MS to make terabytes of data accessible to applications
that need extended storage capabilities.

For example, users on your network may typically save data to an NTFS volume on
your Windows NT/2000 file server. If OTG’s DISKXTENDER (DX) is installed on
the file server, DISKXTENDER can migrate files to media in devices attached to a
computer where MEDIASTOR is installed. MEDIASTOR receives requests from
applications for pieces of media in devices and retrieves media within a device
according to those requests.

You are the architect of the MEDIASTOR system. MS allows you to leverage your
existing hardware configuration or create a new one. MS combines an easy-to-use
graphical user interface with extensive device support to provide a device
management solution that can be adapted to almost any Windows NT/2000
environment. Because MS supports several media types and file systems, and a
multitude of storage devices, you can select the configuration most suited to your
available resources and your storage needs.

Before setting up your storage system, you should be comfortable with MS
terminology and concepts. Please take the time to read all sections of this manual, as
this will help you attain the best performance, functionality, and organization for
your storage solution.

This section identifies key terminology and concepts that are central to an
understanding of MS. Included are descriptions of MS modules, conceptual and
practical definitions, as well as guidelines for planning and implementing your MS
storage strategy.
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A MEDIASTOR GLOSSARY

Several terms will be used in the following concepts discussions. The following table
provides brief definitions of those terms.

Table 3: MEDIASTOR Glossary

TERM: DEFINITION:

Application Pool An application pool is a reserve of pieces of media allocated
for use with a particular application (DX extended drive).

File Migration File Migration refers to the movement or “migration” of files
and their file data from one type of media (a hard drive) to
the media in the devices managed by MEDIASTOR.

File System A file system is software that provides an interface for saving
and retrieving files on storage media. File systems control all
aspects of media management, including directory/file
structures, data layout, and data transfer.

Hardware Device A hardware device is a device that contains one or more
drives where magnetic or optical media is mounted for read
or write access.

Jukebox / Library A jukebox or library is a hardware device containing one or
more removable media drives, shelves for pieces of media,
and a mechanism for moving pieces of media between the
shelves and the drives.

The terms “jukebox” and “library” are interchangeable. In
most instances in this manual, the term “library” is used to
refer to libraries or jukeboxes.

Media Media refers to a physical medium on which data is written
and from which data can be retrieved. Depending on the type
of media, the medium may be different and the information
may be recorded in different ways.

In most instances in this manual, the term “media” refers to
the storage media contained in a device managed by
MEDIASTOR.

Media Service A media service provides access to the media to which other
applications migrate files and data. In the case of
MEDIASTOR, the media service is a device management
service that will retrieve a specific piece of media and mount
the media in a device (such as a library drive) when it is
requested. For devices that do not have a mechanism to
mount media, MS will prompt the administrator to mount the
requested media.
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TERM: DEFINITION:

Media Type The type of a piece of media is determined by the
composition of the media and the method used to record
information on that media. Some examples of media types
are optical media, CD-ROM media, DVD-RAM media, and
tape media.

Mount Media Mounting media is the process of inserting media into a
drive. In the case of a standalone drive or tower, the media is
mounted by manually inserting it in the drive. In the case of
a library, the media is mounted by an internal mechanism in
the library that retrieves the piece of media from a shelf and
inserts it in the appropriate drive.

MEDIASTOR COMPONENTS

MS comprises several components (or modules) and each has specific functionality
within the system. The MediaStor Setup and MediaStor Remote Administrator Setup
modules install the components that make up the MS system.  The MS system
includes the MS Service, the MS Administrator or Remote Administrator, Online
Help and the SCSI Manager and Jukebox Manager utilities (installed with full
installations of MEDIASTOR).  In addition, your installation CD contains a copy of
the OTG License Server program.

MEDIASTOR SETUP
 The MEDIASTOR Setup module is used to install MEDIASTOR and to upgrade from
previous versions of MS. The MEDIASTOR Setup module installs the MS
Administrator, Online Help, and Jukebox and SCSI Manager utilities. The module
remains in the OTG MEDIASTOR program group where it can be used to modify
registration and license information. If necessary, the module can also be used to
uninstall MEDIASTOR.

MEDIASTOR REMOTE ADMINISTRATOR SETUP
 The MEDIASTOR Remote Administrator Setup module is used to install the
MEDIASTOR Remote Administrator, and to upgrade from previous versions of the
MS Remote Administrator. The MEDIASTOR Remote Administrator Setup module
will install the MS Administrator interface only. The module remains in the OTG
MEDIASTOR program group where it can be used to modify registration information.
If necessary, the module can also be used to uninstall the MEDIASTOR Remote
Administrator.
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MEDIASTOR SERVICE
The MEDIASTOR service is a Windows NT/2000 service that runs on the computer
where MS is installed. All of the hardware devices used to access media in the MS
system are attached to the MS computer. MS coordinates all hardware device
management in response to requests for media from other applications. MEDIASTOR
service functionality can be managed through the MS Administrator, either on the
MS computer or from any remote installation of the MS Administrator.

OTG LICENSE SERVER
Licensing information for your MS system is managed on the OTG License Server.
The License Server is the program through which the licenses for your OTG
products are registered and maintained. The OTG License Server program is
included on the DISKXTENDER CD, and can be installed on the MEDIASTOR
computer or on a separate computer, as long as that computer is visible to the MS
computer through the network.

Use the Edit product license information option in the Setup wizard (accessed
through the OTG MEDIASTOR program group) to point to the License Server
computer once your MS licensing information has been registered in the License
Server.

MS ADMINISTRATOR
The MS Administrator allows you to view and configure the underlying structure of
the MS system, providing a single interface for managing the hardware devices in
the system and the allocation of media in those devices. Through this interface, you
can manage all major aspects of the MS system, such as:

� Hardware (storage devices attached to the MS computer)

� Allocation of media to applications

� MS status (tracking of events, errors, or warnings, running of reports, and
configuration restoration if needed)

The Administrator has an intuitive “tree” view where each of the hardware devices
added to MS are listed as nodes on the tree. The tree also has nodes for application
pools, which list media that has been allocated for use by an application. In addition,
a “Scratch” media pool lists media not yet allocated to an application.

Within the Administrator, you define the resources that will be used by MS. You can
add and configure hardware and configure system parameters. The Administrator
provides an interface for management of MS hardware (standalone drives, towers,
and libraries). Devices can be set online or offline and device properties can be
viewed or modified through the Administrator.

When you add media to devices in use by MS, each piece of media appears in the
Scratch pool. Media listed in MS are shown under nodes describing the media
(original, copy, duplicate, blank, foreign, unknown, and unformatted). As
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applications configure MS for use as their media service, those applications appear in
the MS Administrator as Application Pools. You can assign storage media to for use
by particular applications by moving media from the Scratch Pool to the appropriate
Application Pool.

For example, if you are using OTG’s DISKXTENDER for file management, you can
assign media to DISKXTENDER extended drives by allocating the media to the
application pool for the extended drive. Adding media to an application pool is as
simple as dragging the media from the Scratch media pool to the media pool for the
application.

ENTERPRISE (REMOTE) ADMINISTRATION
Regardless of whether you are running a full installation of MEDIASTOR or only the
Remote Administrator, the Administrator interface for MS can be used to configure
any MS computer visible on the network (provided security settings allow access).
Because enterprise (remote) administration capability is automatically installed when
you install MEDIASTOR, you can remotely administer any MS computer from any
other MS computer. You can also use the MS Remote Administrator Setup to install
only remote administration components, if that is all you need on the administration
computer.  MS (full installation) needs only to be installed on computers where the
hardware devices containing the storage media for the DX/MS system will be
attached. It is important to be sure, however that the same version of MS (or MS
Remote Administrator) is installed on both the administering computer and the
remote MS computers it is being used to administer.

ONLINE HELP
 MEDIASTOR contains context-sensitive help links that provide instructional help and
examples. The Online Help is automatically installed with MS and with the MS
Remote Administrator). Press the <F1> key at any time to get help on the currently
displayed dialog box, window or wizard page. There is also a knowledge base
available from the OTG MEDIASTOR program group in the Start menu.

COMMAND LINE UTILITIES
MS includes several utilities that allow you to perform device independently. These
utilities are located in the \WINNT\OTG\MEDIASTOR\BIN\ directory, and are
performed from the command prompt.

SCSI MANAGER
The SCSI Manager utility is a diagnostic tool for performing direct SCSI device
commands independent of the MEDIASTOR Administrator. Included are features for
viewing device profiles, browsing media (drives only), issuing standard or vendor
unique commands, and retrieving sense, log or other data from devices.
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JUKEBOX MANAGER
The Jukebox Manager utility provides an interface for performing direct library
device diagnostics independent of the MEDIASTOR Administrator. Both SCSI and
serial libraries can be managed through this utility. Included are features for viewing
library profiles, performing a library inventory, performing media operations (mount,
dismount, insert, eject, flip), and reporting errors for specific SCSI or serial sense
information.

THE ROLE OF A MEDIA SERVICE IN REMOTE STORAGE

Media services provide access to media. MS was designed for use in conjunction
with OTG’s DISKXTENDER (DX) product, which provides file migration services.
MS provides device management services, passing commands to the robotics within
hardware devices on behalf of the DX system.

For example, a DX computer is storing files to media in an optical library managed
by MS. When a DX computer requests a piece of media so it can write files to that
media or retrieve files from the media, MS sends commands to the library that cause
the picker arm for the library to move to the shelf where the piece of media is
located. The picker arm picks up the piece of media and inserts it in a drive for use
by the DX computer.

Figure 1: MEDIASTOR With DISKXTENDER

Drive,
Library,

and
Tower

Devices

Computer with
MediaStor Media Service

DISKXTENDER D:\
NTFS

C:\
NTFS

OTGMS Media Service Being
Used by DX DX Computer

Network
connections to

MediaStor and to
drives in attached

devices   via
Remote Procedure

Call (RPC)

Several hardware configurations can be used with MS, allowing you to create a
storage system suited to your needs and available resources. MS can reside on the
same computer as the applications that use its device management services, or
installed on a separate computer. An MS system can manage devices on behalf of
multiple applications.
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STORAGE DEVICES

Storage devices are hardware devices that allow you to access multiple pieces of
high capacity removable storage media. Adding a new piece of media can always
increase the total storage capacity available through a storage device. Use of a
storage device through MEDIASTOR provides you with practically unlimited storage
space.

DEVICE
The term “device” refers to hardware and is used throughout this guide to describe
towers, standalone drives and library systems. MS can manage one or many
standalone drive and library devices (limited only by software licenses and system
bus resources).

STANDALONE DRIVE
Standalone drives (internal or external) are non-library drive devices managed by
you, MEDIASTOR, and the applications to which MS provides media services. You
are responsible for mounting and dismounting media in standalone drive devices,
and MEDIASTOR and the applications it services automatically manage the media,
once in the drive.

When using standalone drives, you will receive an error when accessing data files on
offline media. The MS alert viewer tells you what media to mount, and, once the
media has been mounted, you can retry the request and retrieve the file.

TOWER
A tower is a case containing several standalone drives. You, MEDIASTOR, and the
applications to which MS provides media services manage tower devices. You are
responsible for mounting and dismounting media in tower drive devices, and
MEDIASTOR and the applications it services automatically manage the media, once in
the drives.

When using tower drives, you will receive an error when accessing data files on
offline media. The MS alert viewer tells you what media to mount, and, once the
media has been mounted, you can retry the request and retrieve the file.

LIBRARY
Sometimes referred to as autochangers or jukeboxes, libraries have shelves for
storing media, one or more drives, and a robotic arm (or picker) arm that can be
controlled via software to mount and dismount media. MS manages library devices
and handles mounting and dismounting of requested media automatically,
transparent to the client application.
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MEDIA TYPES

MEDIASTOR supports many high-capacity storage media types. The functionality
accessible through a device depends on the type of media used in the device. The
following table defines all media types currently supported:

Table 4: Currently Supported Media Types

MEDIA TYPE: SUPPORT TYPE:

WORM Read/Write

Erasable Optical Read/Write

CD-ROM Read Only

Tape Read/Write

DVD-RAM Read/Write

FILE SYSTEMS
When hardware devices are configured, a file system must be selected for each
device: either a Windows Native file system or an OTG file system. A file system is
software that provides an interface for saving and retrieving files on storage media.
File systems control all aspects of media management, including directory/file
structures, data layout, and data transfer. Media can be formatted for any file system
supported by the device. However, once a file system is selected for a device, all
media used in the device must be formatted with that file system.

Windows NT/2000 installs the Native file system drivers, which include CDFS,
FAT, and NTFS file system drivers. DISKXTENDER also includes three OTG file
systems: OSS, CSS, and TSS. The following table displays DX/MS file system
support by media type:

Table 5: MEDIASTOR File System Support By Media Type

MEDIA TYPE: SUPPORTED FILE SYSTEMS:

WORM OSS (Optical Storage Subsystem)

Erasable Optical OSS (Optical Storage Subsystem)

NTFS (New Technology File System)

FAT (File Allocation Table) (read-only)

DVD-RAM OSS (Optical Storage Subsystem)

CD-ROM CDFS (CD-ROM File System) (read-only)

CSS (CD-ROM Storage Subsystem) (read-only)

Tape TSS (Tape Storage Subsystem)
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If you are using DISKXTENDER applications to store files through MEDIASTOR, you
can select OTG file systems when formatting media within DX. OTG file systems
improve performance when used with DX, and MEDIASTOR supports the use of these
OTG file systems. However, if you decide to use OTG file systems in DX, you need
to make sure you choose the same file systems for the media you are using in DX
and for the device that is used to access the media through MEDIASTOR.

Depending on the media types and portability requirements of the storage solution,
certain file systems should be chosen over others. This basic decision depends on
your performance and media portability concerns. OTG file systems provide
maximum performance, while Windows NT/2000 Native file systems provide media
portability.

WARNING ����
FAT and NTFS cannot be used with WORM media. For optical media, FAT and
NTFS are not recommended unless media portability is essential. Windows NT/2000
file systems are not designed for used with optical media. Formatting optical media
with Windows NT/2000 file systems can cause significant performance degradation.

OTG File Systems
OTG file systems are optimized for performance. Unlike Windows Native file
systems, which are more generic and feature-rich, OTG ‘storage subsystems’
implement the minimum set of features required to store and retrieve data. As a
result, runtime overhead is very low, data is contiguously organized, and overall
performance is enhanced.

As a general rule, if portability of storage media is not a concern choose an OTG file
system to provide the best overall system performance.  In addition, some types of
media are only supported with OTG file systems.  Those media include tape, DVD
and WORM media.

Windows Native (NT/2000) File Systems
Windows Native file systems are provided with Windows NT/2000 and are loaded
onto the system at the time of Windows NT/2000 installation. These are feature-rich
file systems meant for hard drives, but may be desirable for portability concerns.

As a general rule, if portability of optical media is a concern, choose Windows
Native file systems to achieve this goal. While these file systems have a significant
performance disadvantage for optical media in comparison to OTG file systems, they
are 100% portable (media written in these formats can be read on any Windows
NT/2000 system, with or without DISKXTENDER).



Chapter One: Introduction

10 MEDIASTOR System Guide

WARNING ����
For optical media, FAT and NTFS are not recommended unless you are using an
application other than DX with MEDIASTOR, or media portability is essential.
Windows NT/2000 file systems are not designed for used with optical media.
Formatting optical media with Windows NT/2000 file systems can cause significant
performance degradation. FAT and NTFS cannot be used with WORM media.

NOTE����
DISKXTENDER 2000 can read media formatted with FAT, but cannot format or write
to FAT media.
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GETTING STARTED

Getting your MEDIASTOR (MS) system up and running requires a series of
installation and configuration steps. First, MEDIASTOR must be installed on the
computer to which your media devices are connected. Then you can use the MS
Administrator to add those hardware devices to MEDIASTOR and place the media
residing in those devices into Application Pools for use by other applications. Once
MS configuration is complete, you can use the MS Administrator and the associated
Jukebox and SCSI Manager tools to manage certain device and media functions.

This chapter contains a step-by-step guide to installing MEDIASTOR. MS is easy to
install, with system prompts to guide you through every step of the process. Before
installing MEDIASTOR, however, certain system components should be checked, such
as the hardware connections and network configuration. This ensures that the MS
installation will run smoothly, and minimizes the time it takes to get the system up
and running. Installing MEDIASTOR involves assembling the hardware required for
the MEDIASTOR service, installing Windows NT or Windows 2000 and installing
MS. Use the System Requirements that follow as a guideline for your installation.
Consult your Windows documentation for information on installing the operating
system.
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STEPS FOR CONFIGURING MEDIASTOR

Figure 2: Steps For Configuring MEDIASTOR
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THE BASIC STEPS

The following is a condensed list of the steps necessary to start using MEDIASTOR to
manage your library, tower, or standalone media.

To use MEDIASTOR:
1 Verify system requirements. (For instructions, see System Requirements below.)

2 Install Windows NT/2000 and attach hardware devices.

3 Install MEDIASTOR.

4 Add and configure hardware devices. (For instructions, see Chapter Five:
Managing Hardware on page 121.)

5 If not already present, add media to hardware devices. (For instructions, see
Chapter Five: Managing Hardware on page 121.)

6 Configure the MEDIASTOR media service to the application (like DISKXTENDER)
to create application pools in MEDIASTOR.
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7 Add media to application pool. (For instructions, see Chapter Four: Managing
MediaStor on page 59.)

NOTE ����
If you are converting your DX system from 3.2 or 4.2 to DX2000, please refer to the
DX2000 Getting Started Guide before installing MEDIASTOR. Depending on the type
of conversion, not all of the above listed steps will be required.

NOTE ����
If you are using SANXTENDER with your DX/MS system, please see the SANX
system guide before installing MEDIASTOR. Physical configuration of the storage
devices will be different if you are using SANX and migrating files using a SAN.

SYSTEM REQUIREMENTS
MEDIASTOR has a component that manages access to media in mass storage devices
for use by applications using MEDIASTOR as a media service. To determine hardware
requirements, you will need to decide whether the MEDIASTOR service and the
application(s) using MEDIASTOR will be installed on the same machine, or whether
there will be a MEDIASTOR machine and a separate machine for the application.

MEDIASTOR requires the Windows NT 4.0 (Service Pack 6a or greater) or Windows
2000 operating system on the MEDIASTOR computer. The Windows NT/2000 Server
editions optimize performance and are recommended but not required. Systems
running on Windows NT systems lower than Windows NT 4.0 with Service Pack 6a
must upgrade to Windows NT 4.0 and apply Service Pack 6a or greater before
installing MEDIASTOR.

NOTE����
For information on the latest Windows service packs and hot fixes certified for use
with MEDIASTOR, refer to your technical support representative. For information on
operating system issues that may affect performance on your MEDIASTOR system,
refer to the MEDIASTOR Knowledge Base, which can be accessed from the Help
option in the OTG MEDIASTOR Program group on the Start menu.

MEDIASTOR Requirements
The computer on which you install MEDIASTOR  must have the following minimum
configuration:

� Pentium class PC

� At least 128 MB of RAM for Windows NT/256 MB of RAM for Windows 2000

� One or more SCSI host adapters supported by Windows NT/2000

� One or more SCSI or serial storage devices supported by MEDIASTOR
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� Windows NT 4.0 Service Pack 6a or Windows 2000 Service Pack 1

Recommended Upgrades for Optimization
The following upgrades are recommended for optimization:

� Faster than minimum CPU to improve processing speed

� As much memory as possible to provide faster data access

� A one-to-one ratio of SCSI host adapters to SCSI devices

� That the MEDIASTOR computer NOT be a Primary Domain Controller or a
Backup Domain Controller for your network

NOTE����
Storage devices should never be on the same adapter as a SCSI hard drive.

MAXIMIZING MEDIASTOR PERFORMANCE

The following are some suggestions for maximizing MEDIASTOR and Windows
NT/2000 performance. Although not required, implementation of these methods will
help to achieve the greatest system efficiency.

OPTIMIZING STORAGE DEVICES
One of the factors to consider when setting up a MEDIASTOR system is the device (or
array of devices) that will be used to store file data.

Appropriate Hardware for Desired Performance
Hardware requirements vary depending upon an organization’s needs. A careful
assessment of these needs should be performed to determine what combination of
storage devices (drives and libraries) would provide the greatest efficiency. For
example, an organization that requires many users to access a large amount of
information at once would benefit the most from a library with many drives, whereas
one that requires only a small amount of information to be accessed may only need a
library with one or two drives. A complete listing of MEDIASTOR supported drives
and libraries can be found in the online help.

Dedicated Host Adapter for Each SCSI Device
A separate host adapter for each SCSI drive or library device will improve
MEDIASTOR performance. If, for example, there are three drives or libraries on one
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host adapter, then the three devices are sharing the adapter resources. If there is a 1:1
ratio, then all devices have optimal throughput.

INCREASING COMPUTER PERFORMANCE
In addition to the storage devices attached to the MEDIASTOR computer, the system
resources on the MEDIASTOR computer should be taken into consideration when
planning an MEDIASTOR system. The size and number of hard drives, amount of
available RAM, processing power, and network cabling and configuration can all
affect the performance of the MEDIASTOR system.

Dedicated MEDIASTOR Computers
If many other processes are running on the same machine as MEDIASTOR,
performance may decrease. System resources may become overloaded if other
programs are running on the same computer, particularly if the MS computer is
running DISKXTENDER as well. Therefore, you may want to consider installing
MEDIASTOR on a machine specifically for MS and nothing else.

Two Hard Drives on the MEDIASTOR Computer
If you do decide to install DISKXTENDER on the same computer as MEDIASTOR, two
hard drives– one containing the Windows NT/2000, the DISKXTENDER and the
MEDIASTOR program files and one for use by DISKXTENDER – will maximize
performance. DX Data can be written to one drive, while system processes use the
other drive. Dedicating one drive for data storage provides better read/write
performance, especially in a system where large amounts of data are being saved
through MEDIASTOR (for example, heavy scanning environment).

As Much RAM as Possible
The more memory on the MEDIASTOR machine, the faster Windows NT/2000 and
MEDIASTOR performance will be.   

Multiple-Processor Machines
MEDIASTOR fully supports the use of multiple-processor machines. Using a multiple-
processor machine for the MEDIASTOR service will improve MEDIASTOR
performance. With multiple processors, multiple application requests can be
performed at the same time, each processor carrying out a separate task concurrently.

Fast Network Topology
MEDIASTOR uses a dedicated RPC connection for communication between
MEDIASTOR service and the applications using the service. MEDIASTOR will detect
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and enable RPC settings during installation. Because MEDIASTOR handles the RPC
connection, no optimization of the MEDIASTOR service/application connection is
necessary. However, network topology and Windows NT/2000 configuration can
affect throughput between network MEDIASTOR service machines and the associated
application machines.

In cases where network MEDIASTOR services are installed, network cabling designed
for high volume throughput, such as Fast Ethernet or fiber optic, can improve file
transfer speeds between the MEDIASTOR machines and the application machines
using the MEDIASTOR media service.

CLUSTERING

Clustering is the process of connecting two or more computers together in such a
way that they behave like a single computer, and so that they share a single storage
device.  The server computers that are part of the cluster are called nodes or systems.

A typical clustered environment consists of two servers and a RAID array. One of
the servers is called the Primary node; the other is called the Secondary node. The
figure below shows a basic clustered environment.

Figure 3: Example of Clustered Architecture
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Because the cluster is designed to function as a single computer, users and programs
do not access individual nodes when connecting to the cluster. They instead access a
logical cluster name. The logical cluster name represents the “single computer” that
all of the individual components within the cluster have formed to create.

The Primary node constantly updates the Secondary node with registry information
so it can intervene when needed. The Secondary node assumes the functions of the
Primary node if the Primary ever goes off-line.
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The ability of a cluster to transfer functions to a Secondary node when the Primary
fails is called fault tolerance. The act of transferring functions to the Secondary node
is called fail-over. If the Primary node fails or is paused for repairs, the processes
will fail-over to the Secondary node. Because the Secondary node has the same
configuration as the Primary node, the Secondary node can run cluster operations
with little or no disruption of server activity.

When the Primary node comes back on-line, it is now available to take over the
processing functions if/when necessary, and effectively becomes the Secondary
node.  In the event the new Primary node (which was the Secondary node before the
fail-over) fails, the Cluster operations will return to the original Primary node. The
act of transferring functions back to the original Primary node is called fail-back.

MEDIASTOR has the capability to run on a clustered environment. Little interaction is
needed by the administrator, as the installation procedure recognizes that the
program is being installed on a cluster, and modifies the installation appropriately.
The Windows operating system handles all other special cluster-related functions.

MS cluster installation is supported on a Windows NT Enterprise Edition or
Windows 2000 Advanced Server Edition cluster server using Microsoft Cluster
Server in active/passive mode.

If you are planning to run MEDIASTOR in a clustered environment, you must install
the MEDIASTOR program either from a remote machine or directly on the Primary
server computer (the server node currently in control).  If installing from a remote
machine, be sure to select the logical cluster name to add to the list of computers for
install. If installing directly on the Primary server computer, be advised that the
installation program can detect whether the computer is the current Primary node,
and will fail if initiated on a machine other than the Primary node of the cluster. See
Installing MEDIASTOR on page 20 for specific instructions on installation.

In addition, you must to obtain a cluster-enabled MS license when licensing a
cluster-installed copy of MS. Be sure to inform your sales representative when
purchasing your MS license that you will be running MEDIASTOR in a clustered
environment.

Remote administrators and DISKXTENDER clients will access the MS program by
connecting to the logical cluster name via the network.

WINDOWS SECURITY

Because Windows NT/2000 security protects the MEDIASTOR service and the
MEDIASTOR applications, security issues need to be addressed in certain situations.

REMOTE ADMINISTRATION
The MEDIASTOR interface uses a Remote Procedure Call or RPC connection for
communicating between the MEDIASTOR Administrator and any remote MEDIASTOR
computer. Security for that connection is managed by managing membership of the
MSAdministrators group on the MEDIASTOR machine.
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Verifying that Remote Administrators are MSAdministrators
Members
In order to prevent unauthorized users from connecting to MEDIASTOR, MEDIASTOR
creates a local MSAdministrators group on the MEDIASTOR computer. To access a
remote MEDIASTOR service through the MEDIASTOR Administrator (either a full
installation or a remote administrator installation), you must be a member of that
group.

MEDIASTOR automatically adds the Domain Admins group for the MEDIASTOR
machine’s primary domain to the MSAdministrators group. By default, Windows
adds administrators to this group when an administrative account is created.
Therefore, if an administrative account is on the same primary domain as the
MEDIASTOR machine, and no users have been removed from the Domain Admins
group, no configuration may be necessary. You can verify that a user is a member of
MSAdministrators in a few steps.

NOTE ����
If you are running MEDISTOR in a clustered environment, changes or additions to the
MSAdministrators group must be configured on each of the servers in the cluster.

To verify membership in MSAdministrators:
1 Depending on your operating system, your options are:

� For Windows NT, from the Start menu, select Programs → Administrative
Tools → User Manager.

� For Windows 2000, from the start menu, select Programs → Administrative
Tools → Computer Management.

The groups for the local domain are listed in the Groups list. The
MSAdministrators group was automatically added to this list when the
MEDIASTOR service was installed.

2 Double-click the MSAdministrators group name (or highlight the name in the
list and select Properties from the User menu), and the Local Group Properties
dialog box for MSAdministrators appears.
The Members list for the group lists all of the users and groups that are members
of the MSAdministrators group. In order for users to remotely administer the
MEDIASTOR Service, their user names must be listed here, or they must be
members of a group listed here.

3 If a user is not listed and does not belong to any groups listed, you must add
them to the group.

To add a user to the MSAdministrators group:
1 Click the Add button in the Local Group Properties dialog box. The Add Users

and Groups dialog appears.

2 Select the appropriate domain from the drop-down list of domains,

3 Highlight the user name in the Names list.
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4 Click the Add button to add the user to the Members list for the
MSAdministrators group.

NOTE����
To view the members of a group, you can double-click the name of the group in the
Names list in the Add Users and Group dialog box. A list of the current members of
the group appears.

VERIFYING HARDWARE CONNECTIONS

Before installing MEDIASTOR, you should confirm that the hardware is properly
configured, specifically SCSI devices. For any SCSI device to work correctly
(regardless of its use with MEDIASTOR), all devices and the SCSI adapter must be
properly terminated.

Additionally, all SCSI devices should be powered on before starting Windows
NT/2000. If the devices you are using require that specific drivers be installed, those
drivers should be installed and access to the devices should be tested, if possible
through Windows NT/2000 prior to adding the devices to MEDIASTOR.

NOTE����
Keep in mind that SCSI cable length includes not only the external cable, but the
internal cabling as well. For each drive, one foot of cable should be added to the total
cable length.

NOTE����
For more information on SCSI and library devices, see Chapter Seven: SCSI
Manager on page 195 and Chapter Eight: Jukebox Manager on page 227. These
utilities aid in verifying hardware connections and troubleshooting hardware
problems.

NOTE ����
If you are using SANXTENDER with your DX/MS system, please see the SANX
System Guide before installing MEDIASTOR. Physical configuration of the storage
devices will be different if you are using SANX and migrating files using a SAN.
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INSTALLING MEDIASTOR

When installing MEDIASTOR (MS), you must enter registration and product license
information, and specify the computer(s) on which you want to install MEDIASTOR.
If you are planning to run MEDIASTOR in a clustered environment, you must install
the MEDIASTOR program either from a remote machine or directly on the Primary
server (the server node currently in control).  If installing from a remote machine, be
sure to select the logical cluster name to add to the list of computers for install. If
installing directly on the Primary server, be advised that the installation program can
detect whether the computer is the current Primary server, and will fail if initiated on
a machine other than the Primary server of the cluster.

In addition, during the installation of MEDIASTOR you will be prompted to select
whether you are installing a licensed version of MS or a 30-day evaluation version.
OTG Software product licenses are managed through the OTG License Server,
which is a separate product and installed separately from MEDIASTOR, though the
License Server software is included on the DISKXTENDER CD. For information on
installing and configuring your license server, see the License Server System Guide.

Once software has been installed, you can use the Administrator module to define
system hardware, and media parameters.

MEDIASTOR Setup is a wizard that leads you through the necessary steps for
installing MEDIASTOR. The Next button continues to the following step; the Back
button (when active) returns to the preceding step. The Cancel button exits Setup,
aborting the process.

For your convenience, the setup wizard allows you to install MEDIASTOR on multiple
computers at once, providing those computers are visible on your network, and you
have Administrator privileges and rights to log onto the destination computer(s) as a
service.  To take advantage of this feature, you may want to determine which
computers are to have MEDIASTOR installed on them (and configure the appropriate
rights if necessary) before you run the installation wizard.  This enables you to only
run the installation once rather than multiple times.  To configure the appropriate
rights, see Verifying that Remote Administrators are MSADMINISTRATORS Members
on page 18.

NOTE ����
If you are planning to use MEDIASTOR on a SAN environment, in conjunction with
SANXTENDER, please review the SANX System Guide before installing MS.
Operating system requirements and pre-installation configuration information for a
SAN installation of MS is slightly different than with a standard installation of MS.

NOTE ����
If you are converting your DX system from 4.2 to DX2000, do not install
MEDIASTOR, as will be installed for you as a part of the conversion process. If you
are converting from 3.2 to DX2000, be sure to install MEDIASTOR on a different
computer than 3.2. See the DX2000 Getting Started Guide for additional
information.
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NOTE����
Before running Setup, exit all applications. Setup may not be able to write to all
necessary files if other software is running.

NOTE����
Setup can only be run if the user whose account is logged into the Windows
NT/2000 workstation has Administrator privileges.

To install MEDIASTOR:
1 Insert the MEDIASTOR setup CD-ROM into the drive. From the Windows Start

menu, select Run. The Run dialog box appears.

Figure 4: Run Dialog Box

2 You can either browse to the file or type the path in the Open text box:
D:\DX2000.XXX\MEDIASTOR\SETUP.EXE

In this path, D represents the CD-ROM drive holding the CD and XXX represents
the version number.

3 Once the file/path appears in the Open text box, click OK. MEDIASTOR setup is
initiated (which may take a few minutes), and then the MEDIASTOR Setup
wizard appears, starting with the MEDIASTOR Installation page.

Figure 5: MEDIASTOR Installation Page
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The MEDIASTOR Installation page briefly describes the installation process.

4 Click Next. The MEDIASTOR Installation Options page appears.

Figure 6: MEDIASTOR Installation Options Page

5 Select Install new product. Click Next. The MEDIASTOR License Agreement
page appears.

Figure 7: MEDIASTOR License Agreement Page

6 You must accept the terms of the license agreement before you can proceed with
the installation. Click the checkbox next to Accept terms of agreement. Click
Next. The MEDIASTOR Registration Information page appears.
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Figure 8: MEDIASTOR Registration Information Page

7 Enter the customer name and organization name. Click Next. The Service
Account Login Page appears.

Figure 9: MEDIASTOR Service Account Page

8 Enter the account information for the account that you want to use as the MS
Service account.

9 Click Next. The Service Account Licensing page appears.
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Figure 10: MEDIASTOR Service Account Licensing Page

10 You have two choices:

� Select the Install a 30-day evaluation license option to install MS without
using a license server. This allows you to use MEDIASTOR for 30 days.
After the 30-day evaluation period, you can use the Setup option in the
OTG MEDIASTOR Program group to update your license.

� Select the Install a licensed copy of the software option if you have installed
and configured the MS license server already. Type in the name of the
computer where the license server is installed, or use the Browse button to
find the License Server computer on the network.

11 If you select to install a licensed copy of MS and click Browse, a dialog box
appears listing all network computers where License Server is installed, and
noting with each computer whether or not there is an MS license configured on
that License Server.

Figure 11: Available License Servers Dialog Box
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Highlight the License Server computer to be used to license this installation of
MS and click OK. The Product License page returns, displaying the selected
License Server computer in the License Server Computer Name text box.

12 Click Next. The Select Target Computers page appears.

Figure 12: Select Target Computers Page

13 The local computer is automatically listed as the target computer. If you want to
install MEDIASTOR on more computers, click Add. The Browse Computers
dialog box appears.

Figure 13: Browse Computers Dialog Box

14 Under Available Computers, navigate to and select the computer on which you
want to install MEDIASTOR. Click Add. The computer you have added appears
in the Selected Computers list. Repeat this step for each additional computer on
which you want to install MEDIASTOR.
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NOTE ����
If you are using a remote computer to install MEDIASTOR to a clustered
environment, be sure to select the logical cluster name to add to the list of
computers for install.

15 Click OK. You are returned to the Select Target Computers page.

Figure 14: Select Target Computers Page

16 When the Target Computers list is complete, click Next. The MEDIASTOR Setup
Summary page appears.

Figure 15: MEDIASTOR Setup Summary Page

The MediaStor Setup Summary page appears.  The Summary page shows the
customer name and organization and lists the target computers for MEDIASTOR
installation.
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17 Verify the accuracy of the information. If all information is correct, click Finish.
MEDIASTOR Setup adds MEDIASTOR configuration entries and the program
group to the system configuration of every target computer selected. A progress
bar displays the status of the operation, while an MEDIASTOR window displays
information about MEDIASTOR, its components, and utilities.

Figure 16: MEDIASTOR Setup Progress Dialog Box

NOTE����
If necessary, you can abort the setup procedure at anytime by clicking Cancel.

The MEDIASTOR Setup Results dialog box appears, listing the installation results
for each computer you specified.

Figure 17: MEDIASTOR Setup Results Dialog Box

18 Take note of any computers that need to be restarted (or computers on which the
installation failed).

19 Click OK to close the Result window

The MEDIASTOR Setup dialog box appears, indicating whether the MEDIASTOR
installation has been successfully completed.

INSTALLING THE REMOTE ADMINISTRATOR
For Remote Administrator workstations connecting to a MEDIASTOR computer, a full
MEDIASTOR setup is not necessary. Connecting workstations only need access to the
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Administrator. A Remote Administrator installation sets up the Administrator
module on the workstation, as well as online help. Remote Administrator can be run
on a Windows NT/2000 server or workstation.

Remote Administrator Setup is a wizard that leads you through the necessary steps
for installing the MEDIASTOR Remote Administrator. The Next button continues to
the following step; the Back button (when active) returns to the preceding step. The
Cancel button exits Setup canceling the process.

For your convenience, the setup wizard allows you to install the Remote
Administrator on multiple computers at once, providing those computers are visible
on your network, and you have Administrator privileges and rights to log onto the
destination computer(s) as a service.  To take advantage of this feature, you may
want to determine which computers are to have the Administrator installed on them
(and configure the appropriate rights if necessary) before you run the installation
wizard.  This enables you to only run the installation once rather than multiple times.
To configure the appropriate rights, see Verifying that Remote Administrators are
MSADMINISTRATORS Members on page 18.

NOTE����
Before running Setup, exit all applications. Setup may not be able to write to all
necessary files if other software is running.

To install the remote administrator:
1 Insert the MEDIASTOR setup CD-ROM into the drive. From the start menu,

select Run. The Run dialog box appears. You can either browse to the file or
type the path in the Open text box:
D:\DX2000.XXX\MEDIASTOR REMOTE ADMINISTRATOR\SETUP.EXE

In this path, D represents the CD-ROM drive holding the CD and XXX represents
the version number.

2 Once the file/path appears in the Open text box, click OK. MEDIASTOR Remote
Administration setup is initiated (which may take up to two minutes), and the
MEDIASTOR Setup wizard appears, starting with the MEDIASTOR Remote
Administrator Installation page.
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Figure 18: MEDIASTOR Administrator Installation Page

The Administrator Installation page briefly describes the installation process.

3 Click Next. The Administrator Installation Options page appears

Figure 19: Administrator Installation Options page

4 Select Install New Product. Click Next. The Administrator License Agreement
page appears.
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Figure 20: Administrator License Agreement Page

5 You must accept the terms of the license agreement before you can proceed with
the installation. Click the checkbox next to Accept terms of agreement.

6 Click Next. The Administrator Registration Information page appears.

Figure 21: Administrator Registration Information Page

7 Enter the customer name and organization name. Click Next. The Select Target
Computers page appears.
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Figure 22: Administrator Select Target Computers Page

8 If you want to install Remote Administrator on more computers, click Add. The
Browse Computers dialog box appears.

Figure 23: Browse Computers Dialog Box

9 Under Available Computers, navigate to and select the computer on which you
want to install Remote Administrator. Click Add. The computer you have
selected is highlighted under Selected Computers. Repeat this step for each
additional computer on which you want to install Remote Administrator.

10 Click OK. You are returned to the Select Target Computers page.

11 In the Select Target computers page, click Next. The Administrator Setup
Summary page appears. This page shows the customer name and organization
and lists the target computers for the Remote Administrator installation.
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Figure 24: Administrator Setup Summary Page

12 Verify the accuracy of the information. If all information is correct, click Finish.
Remote Administration Setup copies all program files onto the system, and adds
MEDIASTOR Administrator entries and the program group to the system
configuration for each target computer selected. A progress bar displays the
status of the operation, while an MEDIASTOR window displays information
about MEDIASTOR, its components and utilities.

Figure 25: MEDIASTOR Remote Administrator Setup Progress Bar

NOTE����
If necessary, you can click Cancel at anytime to abort the setup process.

The Administrator Setup Results dialog box appears, listing the installation
results for each computer you specified.
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Figure 26: MEDIASTOR Administrator Setup Results Dialog Box

13 Take note of any computers that need to be restarted (or computers on which the
installation failed). Click OK.

14 If the installation was successful, a window appears asking if you would like to
start the Administrator now. You have the following choices:

� Click Start to close the Remote Administration Setup wizard and open the
Administrator

� Click Exit to close the Remote Administration Setup wizard without
starting the Administrator.

The MEDIASTOR Administrator program group is installed, with the necessary icons.
The Administrator is now ready for use by the client workstation.

STARTING THE REMOTE ADMINISTRATOR THE FIRST TIME

Because the Remote Administrator functions as an interface for a MEDIASTOR
service installed on other machines, you must register the other computers through
the administrator in order to use the remote functionality. The first time you start the
Remote Administrator, a message appears prompting you to register a computer to
the Remote Administrator.

Figure 27: Add A Computer?

� Clicking No will close the message box, but leave the empty Administrator
window open.
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� Clicking Yes will open the Register Computers dialog box, through which you
can add one or more connections to remote computers where MEDIASTOR is
installed.

Registering MS computers can be done either using the Auto-Detect function or by
adding the MS computer manually through the interface. For information on remote
administration and for procedures on registering remote MS computers, see Remote
Administration on page 49.

NOTE ����
If you need to register a MEDIASTOR service that is installed on a clustered
environment, be sure to select the logical cluster name from the list of computers.
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USING THE ADMINISTRATOR

Because MEDIASTOR (MS) is a Windows-based package, the same easy, intuitive
navigational standards apply to all of its components. The Administrator provides a
user-friendly interface that allows you to easily create and configure MEDIASTOR
components as well as manage MS computer and extended drive properties.

The Administrator has an intuitive “tree” view that displays the underlying structure
of the MS system. Each hardware device appears as a primary tree node and the
configured drives are grouped as sub-trees for ease of use.  In addition, the media in
the Scratch Pool and Application Pool(s) are grouped by media classification.

Using the Administrator module, you can configure the following MEDIASTOR (MS)
components for all registered and connected MS computers:

� Hardware, including libraries and standalone drives

� Device inventory and file system selections

� Media, including media activity restrictions and assignment to application pools

� Configure alerts to send messages alerting a particular user or workstation to MS
errors or warnings relating to the extended drive.

� View event, warning, and error logs and run reports on various aspects of MS
system functionality.

MS Administration can be performed on the same computer where MEDIASTOR is
installed or from a remote workstation running Windows NT or Windows 2000. This
chapter explains the basic layout of the Administrator, as well as the general
functionality. Included are explanations of window features, and methods for
carrying out system operations.

Before an application can use MEDIASTOR media, MS hardware must be configured
in the Administrator module and media mounted in that hardware must be assigned
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to the appropriate application pool. The settings selected help determine MS
functionality, from the storage devices used to the way media is organized in the MS
system.

STARTING THE ADMINISTRATOR

Starting the Administrator allows you access to media and hardware information in a
tree-like structure. You can connect to the MS service through the Administrator
interface either on the local MS computer or from a remote workstation using the
Remote Administrator. The interface for both is the same, and the service is used to
control the storage devices connected to the MS computer. Using the Administrator,
you can add and remove hardware devices, set drive properties and make media
available to applications using the MS service by adding media to application pools.

Upon successful connection to a MEDIASTOR service, all configured MS components
appear in the Administrator, displayed in a tree-like structure below the
corresponding MS computer. The components in the tree structure consist of
Hardware, Scratch Pool, and Application Pool for each MS media service.

Figure 28: MEDIASTOR Administrator

To open the administrator:
� From the Windows Start menu, select Programs and then OTG MEDIASTOR (or

OTG MEDIASTOR Administrator if you are running the Remote Administrator).
Then select Administrator. The MEDIASTOR Administrator window appears.

When the Administrator opens, it automatically connects to all registered MS
computers.  If this is a full installation of MS (as opposed to a Remote Administrator
installation) the local computer is automatically registered, and therefore
automatically appears in the Administrator. Once the connection has been made, the
window displays information relevant to each connected MS service.
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If you want to administer the MS service on computer(s) other than those currently
connected, you must register those MS computers through the Administrator. For
more detail on registering MS computers, see Registering an MS Computer on page
50.

THE ADMINISTRATOR WINDOW

The Administrator window is made up of several components: the main menu, the
Computer drop-down list box, a toolbar and a status bar. The menu bar contains the
main menu commands and can be found at the top of the window. The Computer
drop-down list box can be found just below the main menu on the left, and the
toolbar can be found just below the main menu to the right of the Computer drop-
down list box. The status bar can be found at the bottom of the window.

The main portion of the window is for navigation and information display. The main
portion of the window is split into three panes. The left pane of the window contains
the tree-like structure from which most commands are performed. The top right pane
displays the contents of the item currently selected in the tree. The bottom right pane
displays a description or detailed properties of the item selected.

Split bars separate the panes of the Administrator window. These split bars can be
moved to change the size of each pane.

To move the split bar:
� Drag the bar to its new location.

THE TREE VIEW: EXPLORING MS
The left pane of the Administrator window contains a tree showing all hardware
configured for registered MS computers. Commands for managing MS functionality
can be accessed from the tree. When you right-click on a tree node, a shortcut menu
containing commands for performing MS functions appears. The shortcut menu
commands will vary, depending on what item you selected in the tree view.

Each node in the tree indicates whether it is expandable; that is, whether it contains
items beneath it. A plus sign (+) marks a node that is expandable. Once a node has
been expanded, the plus sign changes to a minus sign (-), indicating that it has been
expanded and can now be collapsed.

To expand a node:
� Click the plus sign, or double-click the item.

To collapse a node:
� Click the minus sign, or double click the item.

If a node appears with neither sign, that means it currently contains no items within
it. For example, if the Blank node of the Available media tree does not have a plus
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(+) or minus (-) sign in front of it, there are no Blank media available for that
extended drive.

THE CONTENTS VIEW: NODE DETAILS
The top right pane of the Administrator window contains the contents of the node
currently selected in the tree on the left. The contents include the same information
contained underneath the node in the tree, if the node was expanded. For example,
selecting the Original node of the Scratch Pool tree will list all available formatted
and labeled media in the Contents view. The same information is listed underneath
the Original node when that node is expanded. You can select an item in either the
directory tree or in the Contents view section to make the appropriate commands
available.

THE DESCRIPTION VIEW: ITEM DETAILS
The bottom right pane of the Administrator window contains a description of the
item currently selected in the tree on the left. This section provides helpful
information about the current configuration and settings. For example, if a piece of
media is selected, the Description view will display information about that piece of
media including Name, File System, Serial Number, Total number of bytes and the
device in which that media is located.

TOOLBAR
The toolbar contains buttons that provide quick access to many of the Administrator
commands and features. For more information on using the toolbar and details on
each of the buttons, see the Toolbar section on page 44.

MENU BAR
The main menu contains a list of menus with commands for carrying out functions in
the Administrator. Although functions are easily performed using shortcut mouse
clicks, all functions can be performed through the main menu commands as well.
When you select a node, the Edit menu changes to contain the same commands
available on the shortcut menu for that node.

COMPUTER DROP-DOWN LIST
The Computer drop-down list displays the name of the currently active computer.
You can use the drop-down feature of this text box to activate a different MS
computer in the Administrator. Selecting a computer from this list has the same
effect as clicking on or highlighting a different computer in the tree view of the
administrator.
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In order for a computer to appear in the Computer drop-down list, the computer must
be registered through the administrator. For additional information on registering MS
computers to add them to this list box, see Registering an MS Computer on page 50.

STATUS BAR
The status bar is located at the bottom of the Administrator window and displays
information about a command or toolbar button.

To show or hide the status bar:
� From the MS Administrator’s View menu, select Status Bar. A checkmark

beside the command indicates that the status bar is displayed.

WORKING IN THE ADMINISTRATOR

The following sections describe several features and functions available in the
Administrator, as well as basic navigation through MEDIASTOR. For information on
unfamiliar techniques, see Documentation Conventions on page viii, or refer to your
Windows user manual.

COMMON INTERFACE FEATURES
Most MS dialog boxes contain four buttons which function the same way, regardless
of what dialog box is open. The following table lists those buttons and their function.

Table 6: Common Dialog Box Buttons

BUTTON: DESCRIPTION:

The OK button applies all changes made and closes the dialog
box.

The Cancel button closes the dialog box and discards any
changes made.

The Apply button applies any changes made while leaving the
dialog box open.

The Help button opens specific online help for the open dialog
box.
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All MS wizards also have common buttons which function the same way regardless
of which wizard is open. The following table lists those buttons and their function.

Table 7: Common Wizard Buttons

BUTTON: DESCRIPTION:

Returns to the previous page (disabled on the first page).

Moves to the next page in the sequence (replaced by Finish
button on final page).

Discards any information provided, terminates the process
and closes the window. The function the wizard is designed to
execute is not executed.

Applies the settings entered on all pages and executes the
function for which the wizard was designed, according to
your selections throughout the wizard.

Opens online help related to the current wizard.

A checkmark next to an option, whether that option is located in a dialog box or in a
menu, signifies that the option has been enabled. Clicking a checked option will
disable the option and clear the checkmark.

USING THE KEYBOARD WITH THE ADMINISTRATOR
MS is designed for use with a mouse for quickly accessing commands and features.
However, a combination of mouse and keyboard techniques can be used to
efficiently carrying out any action in MS. Keep in mind that keys are often used in
combinations or sequences. The following table describes how key combinations and
key sequences are represented in this document:

Table 8: Documentation Conventions For Keyboard Techniques

KEYBOARD
TECHNIQUE:

DOCUMENTATION
CONVENTION:

EXAMPLE:

Key combination Keys separated by a plus
sign should be pressed at
the same time.

The example, <SHIFT> + <F1>
means to hold down the < SHIFT >
key while pressing the <F1> key.

Key sequence Keys listed in sequence
and separated by
commas should be
pressed in sequence.

The example, <ALT>, <F>, <A>
means to press and release each of
these keys in order: first <ALT>,
then <F>, then <A>.
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Hot Keys
There are certain keys that can be used through the MS Administrator to carry out
functions.

Table 9: Hot Keys

KEY: DESCRIPTION:

<DEL> Press this key to select Delete when there is a Delete command
available in the interface. This key can also be used to delete selected
items in the Tree view or in lists.

<F2> Press this key to open an item’s Properties dialog box when the
Properties button is available in the interface You can also double-
click an item to view or edit the properties.

<INS> Press this key to create a new item wherever a New option is
available.

<CTRL> Press and hold this key while selecting items in a list to select
multiple items.

<SHIFT> Press and hold this key while selecting items or pressing the up or
down arrow key to select sequential items in a list.

<TAB> Press this key to move from one option to the next in a dialog box.
(For more information, see Using the Keyboard in a Dialog Box on
page 42.)

Using the Keyboard with Menus
To carry out commands, select a menu, and then choose a command from that menu.
Choosing the command carries out the action. Every menu, as well as every item in a
menu, has one underscored letter or number, which is used for carrying out keystroke
commands. Instead of using the mouse to open the menu and choose a command,
you can utilize the underscored letters.

NOTE ����
In Windows 2000, the underscores that indicate shortcut keys in menus and dialog
boxes are not visible by default. To view the shortcut keys, press the <Alt> key.

To perform commands using only the keyboard:
1 Press the <ALT> key to activate the menu bar.

2 You have the following choices:

� Press the underscored letter for the menu you want to open.

� Use the right and left arrow keys to highlight the menu you want to open,
and then press <ENTER>.
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3 The selected menu opens. The first command is selected by default. You have
the following choices:

� Press the underscored letter (or number) of the menu command you want to
perform.

� Use the up and down arrow keys to highlight the menu command you want
to perform, and then press <ENTER>.

The command is performed.

NOTE ����
Shortcut key combinations are listed to the right of some menu items. Instead of
opening the menu and choosing a command, you can simply press a key
combination.

Using the Keyboard in a Dialog Box
The <TAB> key can be used in any dialog box to move from field to field. This
includes text boxes, check boxes and option buttons, drop-down lists and list boxes,
and command buttons. Another method of moving through a dialog box is to press
and hold the <ALT> key, while typing the letter that is underscored in the option
name or group name.

NOTE ����
In Windows 2000, the underscores that indicate shortcut keys in menus and dialog
boxes are not visible by default. To view the shortcut keys, press the <Alt> key.

The following table lists the keyboard commands for selecting each type of field.

Table 10: Using The Keyboard In A Dialog Box

FIELD: KEYBOARD ACTION:

Command
Button

Press <TAB> to move to the button, then press the <SPACEBAR>
or <ENTER>. If the button has an underscored letter, press and
hold the <ALT> key while typing the underscored letter.

Option Button Press <TAB> to move to the group of options, and then use the
arrow keys to select the appropriate option button. If the option
has an underscored letter, press and hold the <ALT> key while
typing the underscored letter.

Check Box Press <TAB> to move to the check box, and then press the
<SPACEBAR> to select or clear the check box. If the check box
has an underscored letter, press and hold the <ALT> key while
typing the underscored letter.
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FIELD: KEYBOARD ACTION:

Text Box Press <TAB> to move to the text box, then enter or delete text as
appropriate. Use the arrow keys to move between characters in
the box. To select text, place the cursor by the first character to
be selected and press and hold the <SHIFT> key while pressing
the appropriate arrow key.

List Box Press <TAB> to move to the list box, then use the up or down
arrow key to scroll to the item to be selected. Or, type the first
letter of the item to be selected; the first item that starts with that
letter is selected.

Drop-down
List Box

Press <TAB> to move to the list box, then press <Alt> + the
down arrow key to open the box. Use the up or down arrow key
to scroll to the item to be selected. Press <Alt> + the up arrow or
the down arrow to select it.

USING THE MOUSE WITH THE ADMINISTRATOR
The Administrator was designed for easy use with a pointing device. The following
table lists terms used in this manual that refer to use of a mouse as a pointing device.
If your pointing device is not a mouse or if you have configured your mouse for use
with the left hand, you may need to reinterpret procedures that use these terms.

Table 11: Pointing Device Conventions

TERM: DESCRIPTION:

Point Move the pointer to an item.

Click Point to an item. Quickly press and release the left mouse button
to select an object.

Double-click Point to an item. Quickly press and release the left mouse button
twice to activate a function.

Right-click Point to an item. Quickly press and release the right mouse
button to select an object.

Drag Point to an item. Press and hold the mouse button down. Move
the pointer to the target location and release the button.

For most items (such as, a node in the tree), when selected with the right mouse
button, a shortcut menu appears, consisting of the same commands found in the Edit
menu. This feature provides a quick and easy method of performing many MS
actions.
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Shortcut Menus
For most items in the Tree and Contents views of the Administrator, you can access
a shortcut menu by clicking on the item using the right mouse button. You can then
use either mouse button to select commonly used functions from the shortcut menu
that appears.

Drag and Drop
You can drag any item in the Tree or Contents view to the Delete toolbar button to
delete it. You can also drag and drop media to and from the Scratch Pool and the
Application Pools to allocate and deallocate the media.

Toolbar
The toolbar contains buttons that provide quick access to many of the Administrator
commands and features. To see the function of a button, point to the button with the
mouse. The button’s function appears in the status bar at the bottom of the window.

To show or hide the toolbar:
� From the Administrator’s View menu, select Toolbar. A check mark beside the

command indicates that the toolbar is displayed.

Figure 29: MEDIASTOR Administrator Toolbar

Table 12: MEDIASTOR Administrator Toolbar Buttons

BUTTON: NAME: MENU OPTION: FUNCTION:

Connect From the Service
menu, select Connect

Connects to the selected MS
computer.

Disconnect From the Service
menu, select
Disconnect

Disconnects from the
currently active MS
computer.

Service
Manager

From the Tools
menu, select Service
Manager

Opens MS Service Manager
for the configured computer.

Register
Computer

From the Service
menu, select Register

Displays the Register
Computers dialog box, which
allows you to register MS
computers.
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BUTTON: NAME: MENU OPTION: FUNCTION:

New
Object

From the Edit menu,
select New

Displays a dialog box that
allows you to create a new
object. What dialog box
appears depends on the
current selection.

Delete
Object

From the Edit menu,
select Delete or

Deletes or removes the
selected object.

Object
Properties

From the Edit menu,
select Properties

Displays the Properties dialog
box for the selected object.

REFRESHING THE ADMINISTRATOR WINDOW

Refreshing updates the contents of the display window after a command has been
processed, and repaints everything in the window. The Administrator window is
refreshed when each of the following occurs:

� After each command is performed.

� Each time a node in the tree is expanded or collapsed.

� When you press <F5>. (This is considered a forced refresh.)

� When the time specified for automatic refresh frequency has elapsed.

Configuring Auto Refresh Frequency
You can configure the frequency of the automatic refresh of the Administrator
window. The default refresh rate is 5 seconds.

To enable or disable auto refresh:
� From the Tree menu, select Auto Refresh.
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To change the auto refresh frequency:
1 From the Tree menu, select Auto Refresh Frequency. The Auto Refresh

Frequency dialog appears.

Figure 30: Auto Refresh Frequency Dialog Box

2 In the Frequency text box, enter the number of seconds between refreshes.

3 Click OK.

HARDWARE TREE

The Hardware tree contains all hardware devices currently managed by MS. You can
add or remove hardware devices from the Hardware tree, as well as manage those
devices and the media they contain. Three types of devices can be added to MS:
libraries, towers, and standalone drives.

When a hardware device is added to the MS system, the media in the system is
automatically added to the appropriate node of the Scratch Pool. For more
information, see the Scratch Pool Tree section below.

LIBRARIES
Libraries, also referred to as jukeboxes or autochangers, have shelves for storing
media, one or more drives, and a robot (or picker) arm that can be controlled via
software to mount and dismount media. From the Hardware tree, you can add new
libraries. Library properties can be accessed from the library node of the hardware
tree, and the library and its drives can be set online or offline. Library media appears
in the Scratch Pool and can be managed from there until it is assigned to an
application pool.

TOWERS
A tower is a case containing several standalone drives. From the Hardware tree, you
can add new towers. Tower properties can be accessed from the tower node of the
hardware tree, and the tower and its drives can be set online or offline. Tower media
appears in the Scratch Pool and can be managed from there until it is assigned to an
application pool.
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STANDALONE DRIVES
Standalone drives (internal or external) are non-library drive devices. From the
Hardware tree, you can add new drives. Drive properties can also be accessed from
the same location, and the drive can be set online or offline. Standalone media
appears in the Scratch Pool and can be managed from there until it is assigned to an
application pool.

SCRATCH POOL TREE

The Scratch Pool tree contains all media in the MS system that is not currently
assigned to an application. The media in the Scratch Pool is grouped by type:
original, copy, duplicate, blank, foreign, unknown, and unformatted media. For more
information on media functions in the MS system, see the Managing MediaStor
Media chapter beginning on page 181.

ORIGINAL MEDIA
All media that have been prepared for use for an application but are not currently
assigned to one are listed under the Original Media node. For a piece of media to
appear in this list, the media must be:

� Formatted for the file system for which the hardware device is configured,

� Labeled, and not currently assigned to an application.

COPY MEDIA
Copy media are media that are identical copies of other media in the MS system. The
only difference between an original piece of media and its copy is the serial number
for each piece of media.

DUPLICATE MEDIA
Duplicate media is any media with the same serial number as another piece of media
in the MS system. Duplicate media is unusable with MS and its associated
applications and will have to be reformatted before it can be used.

BLANK MEDIA
Blank media are media that have been formatted for use with MS and its associated
applications, but not labeled.
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FOREIGN MEDIA
Any media that has been formatted for a file system other than that of its current
device, or media unsupported by MS is considered by MS to be “foreign” media and
is placed in the Foreign node.

UNKNOWN MEDIA
Unknown media encompasses any media in the hardware device that MS does not
recognize. The problem could be an unsupported media type or an unsupported file
system.

UNFORMATTED MEDIA
All unformatted media are listed under the Unformatted Media node. This media will
have to be formatted before it can be used.

APPLICATION POOL TREE

The Application Pools tree displays all application media pools currently using MS
as a media service. Under each application media pool, the MS media assigned to
that media pool is listed. The media in each application media pool is grouped by
type: original, copy, duplicate, blank, foreign, unknown and unformatted media. For
a description of each type, see the descriptions under Scratch Pool Tree above.

Each application media pool is identified by three characteristics: the application, the
name of the computer and the drive letter using MS as a media service.

For example, the name of an application media pool, as it appears in the Application
Pool tree might be: DX_WSTVERNON1_D. What this means is that the application
or program using MS is identified as “DX”, the name of the computer running that
application is “WSTVERNON1”, and the drive on that computer using MS as its
media service is “D” or the D: drive. This naming convention allows you to quickly
identify where you should assign the media from the Scratch Pool.

For more information on media functions in the MS system, see the Managing
MediaStor Media chapter beginning on page 181.

SEARCHING IN THE ADMINISTRATOR

As multiple components (hardware devices, media, application drives) are added to
the system, the MS tree may become so large as to become difficult to locate a
specific node of the tree. The Find command in the Tree menu can be used to quickly
locate occurrences of text within the MS tree. This can be especially useful for
finding a specific piece of media or a specific hardware device.
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The Administrator searches from the currently highlighted position in the tree either
to the end or to the beginning of the tree, depending on the direction you choose. To
search the entire tree, select an item at either the top or bottom of the tree before
beginning the search.

To search for specific text in the tree:
1 Select Find from the Tree menu. The Find dialog box appears.

Figure 31: Find Dialog Box

2 In the Find What text box, type the text to be found.

3 Select the Up or Down option to search up or down in the tree from the currently
highlighted position.

4 Click a check the Match Case check box to find only words having a certain
pattern of uppercase and lowercase letters. For example, enable this option to
find “MEDIA” but not “media.”

5 Click Find Next. The first occurrence of the text is highlighted in the tree. If the
tree is not visible, move the Find dialog box by dragging its title bar.

6 To find the next occurrence, click Find Next again.

7 Click Cancel to close the dialog box.

NOTE ����
After the Find dialog box is closed, you can select Find Next from the Tree menu (or
press F3) to find the next occurrence of the most recently specified text.

REMOTE ADMINISTRATION

MEDIASTOR (MS) allows you to administer the MS system both from the computer
on which MS is installed and from remote computers. You can use the Administrator
function that comes with a full installation of MEDIASTOR to administer other MS
computers, or you can install the Remote Administrator, which simply provides you
with the Administrator interface and the registration capability to attach remotely to
any networked MS computer.

The remote administration function is the same whether you use an MS
Administrator (full installation) or a Remote Administrator. Regardless of which
Administrator function you have installed, you have to register the remote MS
computer in order to allow the Administrator you are running to find and connect to
the remote MS computer.
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REGISTERING AN MS COMPUTER
You can remotely administer one or more MS computer(s) both from the
Administrator function installed with a full installation of MEDIASTOR and by using
the Remote Administrator. The Register command available through the Service
menu of the Administrator allows you to access other MS computers by connecting
through the network.

If access to a MEDIASTOR computer on the network is necessary, you must register
the MS computer to add the MS computer’s name to the Computer drop-down list
and to the tree view of the Administrator. Only computers where MEDIASTOR is
currently installed can be registered.

Registering MS computers can be done either using the Auto-Detect function, or by
adding each MS computer manually. For procedures, see Registering an MS
Computer using Auto Detect below or Registering an MS Computer manually on
page 54.

NOTE ����
If you need to register a MEDIASTOR service that is installed on a clustered
environment, be sure to select the logical cluster name for registration.

Registering an MS Computer using Auto Detect
For large systems with several MS computers, the normal registration process
becomes unwieldy, since you must browse and select each computer on the network.
The Auto-Detect feature lets you detect and select all currently running MS services
on the network without browsing the system to find individual MS computers.

The Auto-Detect function works as a wizard that leads you through the registration
process.

To start the Auto-Detect Wizard:
1 In the Administrator, select the Register option from the Service menu or click

the icon on the toolbar.

Figure 32: Register Computer Icon

The Register Computers dialog box appears.
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Figure 33: Register Computers Dialog Box

NOTE����
All computers already registered with the currently open Administrator appear
in the Register Computers dialog box, to include the local computer. If you are
registering through a Remote Administrator, and you have not yet registered any
MS computers, the Register Computers dialog box is blank.

2 Click Detect to start the Auto-Detect wizard. The Introduction page appears.

Figure 34: Introduction Page

3 Read the Introduction and click Next. The Computer List page appears.
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Figure 35: Computer List Page

The Computer List page lists all detected computers on which MS is installed
and where the MS service is actively running (stopped services or powered-off
computers will not be detected).

4 Select the computers you want to register and click Next. To select two or more
computers in sequence, select the first computer, then press and hold the
<SHIFT> key while selecting the last item. To select two or more computers out
of sequence, press and hold the <CTRL> key while selecting computers.

NOTE ����
If a computer that you want to register does not appear in the Computers
Detected list, you will have to register the computer manually. See Registering
an MS Computer manually on page 54.

5 Click Next. The Summary page appears.
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Figure 36: Summary Page

6 The Summary page lists the selected computers. Review the list to make sure the
computers you want to register are listed. Click Back to return to the Computer
List page, if necessary.

7 If the information in the summary is correct, click Finish. The selected
computers are registered and now appear in the Computer List in the Register
Computers dialog box.

Figure 37: Register Computers Dialog Box

8 If you inadvertently list a computer you do not want to register, or you wish to
delete a previously registered computer, select that computer and click Delete.
The computer is removed from the list.
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9 Once the appropriate computers appear in the Register Computers dialog box,
click Close. The Administrator attempts to connect to all registered MS
computers. All registered computer name(s) now appear in the Computer drop-
down list located directly beneath the main menu in the administrator, and in the
tree view of the administrator window.

The Administrator can now be used to administer the MEDIASTOR service on the
registered MS computer(s). You can switch between registered computers by
selecting different computer names from the Computer drop-down list or by clicking
on and highlighting the computers in the tree view of the Administrator.

Registering an MS Computer manually
To manually register an MS computer:
1 In the Administrator, select the Register option from the Service menu or click

the icon on the toolbar.

Figure 38: Register Computer Icon

The Register Computers dialog box appears.

Figure 39: Register Computers Dialog Box

NOTE����
All computers already registered with the currently open Administrator appear
in the Register Computers dialog box, to include the local computer. If you are
registering through a Remote Administrator, and you have not yet registered any
MS computers, the Register Computers dialog box is blank.
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2 Click Add to register a new MS computer. The Select Computer dialog box
appears.

Figure 40: Select Computer Dialog Box

The Select Computer dialog box allows you to select any visible network
computer. To successfully register, the selected computer must have
MEDIASTOR installed.

3 Select the computer you want and click OK (or double-click the computer). You
are returned to the Register Computer dialog box and the computer you selected
appears in the computer list.

Figure 41: Register Computers Dialog Box

4 Repeat this process for every computer you wish to manually register as a
MEDIASTOR computer for remote administration.
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5 If you inadvertently list a computer you do not want to register, or you wish to
delete a previously registered computer, select that computer and click Delete.
The computer is removed from the list.

6 Once the appropriate computers appear in the Register Computers dialog box,
click Close. The Administrator attempts to connect to all registered MS
computers. All registered computer name(s) now appear in the Computer drop-
down list located directly beneath the main menu in the administrator, and in the
tree view of the administrator window.

The Administrator can now be used to administer the MEDIASTOR service on the
registered MS computer(s). You can switch between registered computers by
selecting different computer names from the Computer drop-down list or by clicking
on and highlighting the computers in the tree view of the Administrator.

CONNECTING TO MS COMPUTERS

When the Administrator is opened, it attempts to connect to all registered MS
computers (to include the local computer for full installations of MS). Once these
connections have been made, the window displays information pertaining to each
MS service. The Administrator allows you to switch easily between registered MS
computers by clicking on and highlighting the computers in the tree view, or by
selecting different computers from the Computer drop-down list.

Figure 42: Computer Drop-Down List

Remember, in order to successfully connect to an MS computer, you must have
administrator rights on the selected MS computer.

DISCONNECTING THE ACTIVE SERVER
You may wish to disconnect from the currently active MS computer. Disconnecting
from the active service removes that computer’s MS components from the tree view,
though the computer will still appear, listed with a status of (Disconnected).
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To disconnect from the active MS computer:
� Highlight the computer from which you want to disconnect, and click the

Disconnect toolbar button or select Disconnect from the Service menu.

Figure 43: Disconnect Computer Toolbar Button

RECONNECTING THE ACTIVE SERVER
Once disconnected from an MS computer, the computer name will still appear in the
tree view, but with the status of (Disconnected). You can reconnect to any of
the registered MS computers at any time.

To reconnect to an MS computer:
� Highlight the computer to which you want to connect, and click the Connect

toolbar button or select Connect from the Service menu.

Figure 44: Connect Computer Toolbar Button
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MANAGING MEDIASTOR

MEDIASTOR (MS) acts as a controller for the storage devices you are using for your
OTG applications. MS keeps track of hardware and media and will mount and
dismount media as needed by the application to which that media is assigned. The
MS interface is designed for ease of use, and allows you to control and administer
the hardware devices and their media.

This chapter also describes service management for MS, both through the MS
interface and through the Windows NT/2000 control panel. This chapter also
discusses how to view and work with the MS event and error logs so you can keep
track of system activity and troubleshoot any potential problems.

Troubleshooting can be done using the diagnostic utilities in the Tools menu and the
Service menu. You can look up error definitions in the Administrator using the Error
Glossary feature. In addition, the Report Wizard allows you to create reports relating
to several items, including several categories of media, the current hardware
configuration and MS Registry settings. Information on each of these utilities is
provided in this chapter.

The Tools menu also provides the option to back up your registry settings, for
disaster recovery purposes. The Repair Disk function and the associated procedures
for saving, scheduling regular backups and recovery of your registry information is
included in this chapter.

In addition, at the end of this chapter you will find procedures for uninstalling or
removing the MS program and the MS remote administrator from your computer, if
that becomes necessary for any reason.
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MANAGING THE MS WINDOWS NT/2000 SERVICE

MS functions as a Windows NT/2000 service rather than a user-mode application.
As a Windows service, MS can be configured for various startup settings, including
Automatic startup, which starts MS upon Windows system startup, Manual startup,
which allows you to start the service manually, and Disabled, which disables the
service and does not allow it to start until that status is changed. As a Windows
NT/2000 service, MS can continue to be active even after you log off Windows, as
long as the computer is still running.

SERVICE MANAGEMENT VIA AN MS ADMINISTRATOR
With MS, you can perform the following functions:

� Check MS status on both local and remote MS computers

� Start and stop MS service on local and remote MS computers

� Set service startup options

The MS service must be started in order for the Administrator to connect to it.

Opening Service Manager
MS service management can be performed through the MS Service Manager, which
can be accessed from the Tools menu (located on the main menu) or the icon on the
toolbar. You can select which MS computer to manage services for from the
Computer drop-down list box, or by selecting a computer in the tree view.

To open the service manager:
� From the Tools menu, select Service Manager, or click the icon on the toolbar.

Figure 45: Service Manager Icon

The Service Manager dialog box appears.
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Figure 46: Service Manager Dialog Box

Service Manager indicates the status of the MS service just below the traffic light
signal in the center of the Service Manager dialog box. A green light indicates the
service is started and a red light indicates the service is stopped.

Table 13: Service Manager Status Indicator

STATUS: INDICATOR APPEARANCE: DESCRIPTION:

The MS service
is stopped.

When the service is stopped, the
red light is lit, and the word
Start is active in the window.

The MS service
is started.

When the service is started, the
green light is lit and the word
Stop is active in the window.

Starting and Stopping MS
The Service Manager dialog box allows you to easily start and stop the MEDIASTOR
Media Service. Stopping the service suspends all user and application access to the
hardware devices and the media in those devices.

As a courtesy to users connected to the service, either through remote administration
or through an application, we recommend you send out a broadcast message
informing users that you are stopping the service, and then again, to inform users
when you start the service again.
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NOTE ����
You can start and stop the service for any registered MS computer, even if the
selected computer is not currently connected through the administrator. MS
computers that are not connected are listed in the tree view with a status of
(Disconnected).

Starting the MS service
Service Manager allows you to start the MS service for the currently active MS
computer. Starting the MS service allows users and applications to access the
MEDIASTOR Media Service on the selected computer.

To start an MS computer service:
1 Select the MS computer name in the Computer: drop-down list box, or highlight

the computer in the tree view.

2 Select the Service Manager command from the Tools menu, or click on the
Service Manager icon.  The Service Manager dialog box appears.

3 Double-click the word Start in the Service Manager dialog box.

4 Click Yes in the “Start the OTG MediaStor service?” message box.

Stopping an MS service
Stopping the MS service not only disconnects the administrator from the MS
computer but also suspends access to the MS service for all other users and
applications until it is started again.

To stop an MS service:
1 Select the MS computer name in the Computer: drop-down list box, or highlight

the computer in the tree view.

2 Select the Service Manager command from the Tools menu, or click on the
Service Manager icon.  The Service Manager dialog box appears.

3 In the Service Manager dialog box, double-click the word Stop.

4 Click Yes in the “Stop the OTG MediaStor service?” message box.

NOTE ����
When you plan to stop or pause an MS service, it is a good idea to broadcast a
message and give users enough time to finish their tasks before service is suspended.

Configuring Service Settings
The  MS service, like any Windows NT/2000 service, can be set to start in a number
of ways. For example, you may want MS service to start immediately upon system
startup, or you may want the ability to manually start or even disable the MS service.
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The following lists the possible service settings  for MS (or any Windows NT/2000
service).

Table 14: MEDIASTOR Service Settings

SETTING: DESCRIPTION:

Automatic Automatic services start every time the system starts.

Manual Manual services can be started by a user or by a dependent service.

Disabled A disabled service cannot be run until the disabled status is
changed.

To edit service settings:
1 In the Service Manager dialog box, click Edit Service Settings. The Edit Service

Settings dialog box appears.

Figure 47: Edit Service Settings Dialog Box

2 Select the appropriate option for startup type.

3 In the Log On As section, This Account option is enabled by default and should
contain the login and password entered on installation of MEDIASTOR on the
computer. To select to have the service login as the System Account, enable that
option.

4 Select OK to return to the Services dialog box and then Close to exit.

NOTE����
Check with your network administrator to determine if the System Account or This
Account option is appropriate for your MS system.
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SERVICE MANAGEMENT THROUGH WINDOWS
The Control Panel in Windows NT and the Administrative Tools application in
Windows 2000 allow you to modify the system while working in Windows. An icon
in the Control Panel represents each option that can be changed. The Services option
allows you to start and stop Windows NT services, as well as configure service
parameters. The Services and Applications option in the Administrative Tools allow
you to start and stop Windows 2000 services as well as configure service parameters.
Control Panel and Administrative Tools options affect only the local machine.

Starting and Stopping the MS service
You can start and stop the MS service through the Windows services tools.

For Windows NT:
1 On the MS computer, open the Windows Service Manager. From the Start

menu, select Control Panel → Services.

Figure 48: Windows NT Services Dialog Box
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For Windows 2000:
1 On the MS computer, open the Windows Service Manager. From the Start

menu, select Programs → Administrative Tools → Services. The Services
dialog box appears.

Figure 49: Windows 2000 Services Dialog Box

2 From Windows Services dialog box, highlight OTG MEDIASTOR from the
service list. From Windows 2000 Services dialog box, double-click OTG
MEDIASTOR from the service list.

3 Select Start, Stop, Pause, or Continue as needed.

4 Select Close when finished.
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Configuring Settings
The Control Panel (Windows NT) and Administrative Tools (Windows 2000) can
also be used to edit MS service settings. From the Services dialog box, Windows
services can be set for automatic or manual startup (it can also be disabled).

To edit MS service settings via Windows NT:
1 In the Service dialog box, highlight OTG MEDIASTOR and click Startup. The

Service dialog box appears allowing startup options to be changed.

Figure 50: Service Dialog Box

2 Select the appropriate option for startup type.
In the Log On As section, This Account option is enabled by default and should
contain the login and password entered on installation of MEDIASTOR on the
computer. To select to have the service login as the System Account, enable that
option.

3 Select OK to return to the Services dialog box and then Close to exit.

NOTE����
Check with your network administrator to determine if the System Account or This
Account option is appropriate for your MS system.

To edit MS service settings via the Windows 2000 service panel:
1 On the MS computer, open the Windows Service Manager. From the Start

menu, select Programs → Administrative Tools → Services. The Services
dialog box appears.
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Figure 51: Windows 2000 Services Dialog Box

2 From the Services dialog box, double-click OTG MEDIASTOR from the service
list. The OTG MEDIASTOR Properties dialog box appears.

Figure 52: OTG MediaStor Properties Dialog Box

3 Select the appropriate startup type option from the drop-down list in the Startup
type section of the General tab.
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4 Click on the Log On tab to activate it.

Figure 53: OTG MediaStor Properties Dialog Box – Log On Tab

5 In the Log On As section, This Account option is enabled by default and should
contain the login and password entered on installation of MEDIASTOR on the
computer. To select to have the service login as the System Account, enable that
option.

6 Click OK to return to the Services dialog box and then Close to exit.

NOTE ����
Check with your network administrator to determine if the System Account or This
Account option is appropriate for your MS system.

CONFIGURING MS PROPERTIES

MEDIASTOR allows you to view and configure MS service properties in the Service
Properties dialog box. You can view information relating to the MS installation on
the computer.

Each MS computer has a Service Properties dialog box that displays three tabs of
information pertaining to the MS service. These tabs include: General, Alerts and
Licensing Information.
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OPENING MS SERVICE PROPERTIES
Properties for the MS service are accessed from the Service menu.

To open the MS Service Properties dialog box:
� From the Service menu, select Properties.

GENERAL TAB
The General tab displays identifying information for the MS computer.

Figure 54: Service Properties Dialog Box: General Tab

Table 15: MS Service Properties: General Tab

ITEM: DESCRIPTION:

Computer Name The Windows NT/2000 computer name for the MS
computer.

Installation Date The date that MS was installed (or updated).

Version The installed version of MS.
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THE ALERTS TAB
The Alerts tab allows you to configure MEDIASTOR to send alerts to specific users,
workstations, email addresses, or domains. There is also a text box on the bottom of
the Alerts tab allowing you to specify the SMTP Mail Server you want to use to send
the configured alerts.

Figure 55: Service Properties Dialog Box: Alerts Tab

For details on configuring alerts, see Configuring Alerts, below.

CONFIGURING ALERTS
An alert is a message box that instantaneously appears notifying the recipient of an
error or warning on the MS system. Alerts that are configured for the MS computer
will broadcast any warnings or errors relating to the MS computer or MS service.

The alerts tab allows you to enter the name of the mail server being used to distribute
the alerts. You can add email addresses, or the names of domains, computers, or
users on your network to the Send Alerts To list. For each category added, you can
choose whether to configure notification of warnings, errors, or both.

NOTE ����
If no error or warning notification is enabled for an assigned user or computer, then
no alerts will be broadcasted to that user or computer. You can leave a name on the
list and then disable both options to temporarily hinder alerts.

The computer or user names entered in the Alerts dialog box should correspond to
existing user or computer names on your Windows NT network.
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To configure alert settings:
1 From the Service Properties dialog box click the Alerts tab. The Alerts tab

appears.

Figure 56: Service Properties Dialog Box: Alerts Tab

The alerts tab provides a text box at the bottom in which you can enter the name
of the mail server that will be used to distribute the configured alerts. The well-
known port for SMTP servers is supported, so no additional configuration
should be required for use with mail servers, routers or firewalls.

2 Type in the name of the mail server being used to deliver the configured alerts in
the Mail Server text box at the bottom of the Alerts tab.

3 Click Add. The Alert Settings dialog box appears.

Figure 57: Alert Settings Dialog Box

4 From the Type drop-down list box, select the type of alert that you would like to
configure. You have the following choices:

� Computer

� Domain
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� E-Mail

� User

5 In the Send To text box, enter the email address, or the domain, user, or
computer name to which you want alerts to be sent.

6 Below the Send To box you may configure the following options:

� If you want the alert to be sent for warnings and errors, enable both the
Notify warnings and Notify errors checkboxes.

� If you want an alert to be sent for warnings but not for errors, enable the
Notify warnings checkbox.

� If you want an alert to be sent for errors but not warnings, enable the Notify
errors checkbox.

� If you want to temporarily disable the alert, disable both the Notify
warnings and Notify errors checkboxes. You can enable either of these
options at a later time.

7 When you are finished choosing the alert settings, click Add. The information in
the Send To box disappears as the recipient is added to the alerts listing.

8 After a recipient has been added, you may enter another recipient into the Send
To box and/or change the Type setting and options and click Add again.

9 When you have finished configuring all of the alerts desired, click Close on the
Alert Settings dialog box. The chosen alert configurations appear in the Alert list
in the Alerts tab.

Once Alerts have been established, you may use the Alerts tab in the service
properties dialog box to edit or delete configured alerts.

To change configured alert settings:
1 From the Service menu in the Administrator, select Properties.

2 Select the Alerts tab. The Alerts tab appears, listing all currently configured
alerts.
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Figure 58: Service Properties – Alerts Tab

3 You have the following choices:

� To remove an alert from the list, select the name in the list and click Delete.
A message appears asking you to confirm the deletion. Click Yes. The alert
is deleted.

� To edit an alert, select the name in the list and click Edit. The Alerts dialog
box appears. Change the Type and Send To and other setting information as
appropriate and click Add, then click Close.

� When you have made all necessary changes to the Alert list, click OK to
save the changes and close the Service Properties dialog box or click Apply
to apply the changes without closing the Properties dialog box.
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The Licensing Information Tab
The Licensing Information tab displays license information for the MS computer. It
will display the information for the License Server you selected during installation.
It also shows which computer has the License Server installed and a detailed
description of the MS licenses configured in the License Server. This includes the
number of MS Licenses and type and file size capacity of the media services
available for use with MS.

Figure 59: Service Properties – Licensing Information Tab

Table 16: MS Service Properties: Licensing Information Tab

ITEM: DESCRIPTION:

Licensee The user information entered during the MS installation.

Company The company information entered during the MS
installation.

License Server The name of the computer containing the installation of
License Server that is currently administering the MS
licenses for this MS service.

Licensing Details Detailed description of the MS licenses configured in the
License Server. This includes the number of MS Licenses
and type and file size capacity of the media services
available for use with MS.

MS ADMINISTRATIVE AND DIAGNOSTIC TOOLS

MEDIASTOR provides a number of ways to perform diagnostics on the MS computer.
MS logs can be used to view and track system events, errors, and warnings.
Comprehensive error messaging is built in, so every time an error condition occurs, a
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message with information about the condition causing the error appears. The Error
Lookup feature helps you translate MS error codes provided in MS messages.

In addition to diagnostic capabilities, MS provides an administrative tool that allows
you to repair the MS computer. In the event that the MS computer drive becomes
corrupted, MS contains a Repair Disk utility that periodically creates a snapshot of
the Windows registry. You can create a copy of the registry at any time, or, in the
event of an MS computer crash, use an existing registry copy to restore the MS
configuration.

The Service and Tools menus contain most of the diagnostic and administrative
commands that can help you manage your MS system.

TRACKING MS EVENTS, ERRORS AND WARNINGS
MS has built-in utilities for monitoring events, errors, and warnings within the
system. The Event Viewer contains a listing of all system events, errors, and
warnings. This information is also logged to event, error, and warning logs. Errors
and warnings are logged automatically while other events are not logged by default
(however, event logging can be enabled).

The logs provide a quick look at the activities of MS. They allow you to monitor all
aspects of system events. Logs can help identify and solve potential problems during
runtime that might otherwise become critical problems if ignored. MS event tracking
utilities include:

� Event Viewer: where events, errors, and warnings are all displayed in one
location.

� Event Log: used for debugging and problem identification, through a
chronological listing of MS events.

� Error Log: used for detecting and diagnosing system errors.

� Warning Log: used to warn you of possible problems in MS.

Using the Event Viewer
The Event Viewer displays all events for the currently active MS service. If you do
not want to automatically save a record of the events on your MS computer, you can
disable event logging in the Event Configuration dialog box and simply view events
in the viewer.

Within the Event Viewer, you can take a “snapshot” of the contents of the viewer, to
save that snapshot for later use. You can also clear the viewer.



Chapter Four: Managing MEDIASTOR

76 MEDIASTOR System Guide

To open the event viewer:
� From the Service menu, select Event Viewer. The All Events dialog box

appears.

Figure 60: Service Event Viewer: All Events

Taking Snapshots
 A snapshot can be taken of a viewer in order to save or “capture” the contents of the
viewer as displayed at the time of the snapshot. A snapshot is a capture of up to the
last 2048 lines of the Service Event Viewer.

To take a snapshot in the event viewer:
� From the File menu in the Service Event Viewer, select Snapshot.

A snapshot is then taken of the current viewer. RtfPad automatically opens,
displaying the viewer’s text. MS also creates a temporary file when the snapshot is
taken. This file should be saved, so that you can view the information at a later time
(once RtfPad is closed).  For instructions, see Saving, Sending and Printing Logs on
page 80.

Using MS Logs
In addition to the viewing capabilities offered by the Event Viewer, MS also contains
log features, which save events, errors, and warnings to log files. MS automatically
saves messages by default to the Error and Warning logs, and to the Event Log if you
enable that option. Event Logging is disabled by default because of the amount of
system resources required to log every system event. However, logging can be
enabled and is very useful for trouble shooting purposes when necessary.
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You can control the size of the logs by setting maximum log sizes in Event
Configuration. MS also allows you to select which events will be logged. In addition,
you can enable tracing of event messages at startup. Errors, warnings and events can
be configured to log to the Windows NT/2000 event log.

Opening MS Logs
You can open the MS Event, Error, and Warning logs from within MS. When
opened, the logs will contain only events and errors relating to the connected MS
service. All logs are accessed from the Administrator’s Service menu. When open,
the logs slow down MS performance. When closed, they have a negligible impact on
performance. For this reason, the logs should be opened and used only for debugging
purposes.

To open a log:
1 From the Service menu, select Event Logs.

2 From the Event Logs menu, select the log you want to open: All Events Log,
Warnings Log or Errors Log.
A separate window containing the log appears.

NOTE����
You can also open any of the three logs through the Logs option in the OTG
MEDIASTOR program group accessed through the Windows Start menu.

Event Log
The Event Log is used for debugging purposes only, and is not used on a normal
basis. This viewer provides logging services for internal subsystems to assist with
problem identification. If technical support is needed, you may be asked to open this
log and specify the information reported.

The Event Log displays the time each event occurred and a message for each event.
The most recent events are last on the list (the list automatically scrolls to display the
most current events).
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Figure 61: Event Log Window

Error Log
The Error Log is a useful tool for detecting and diagnosing system errors. Every MS
error passes through the Error Log. All system errors appear in the Event Viewer and
the Event Log as well, but the Error Log provides a more precise focus specifically
designed for error tracking. Because these tools are integral to system diagnostics,
error logging cannot be disabled.

Figure 62: Error Log
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The Error Log displays the time each error occurred and a message for each error.
The most recent errors are last on the list (the list automatically scrolls to display the
most current errors).

Warning Log
The Warning Log includes caution messages to warn you of possible problems in
MS. The Warning Log provides warnings for problems such as:

� Requests for media (either to read a file or to write a file) that could not be
satisfied because the media was not present on the MS system (not in any drive
or library).

� Files that could not be migrated, due to media being full.

The purpose of this list is to provide a simple means of discovering where problems
exist that may be hindering MS performance. These warnings also pass through the
Event Viewer and the Event Log, but the Warning Log provides a more narrow focus
for system warnings.

Figure 63:Warning Log

The Warning Log displays the time each warning occurred and a message for each
warning. The most recent warnings are last on the list (the list automatically scrolls
to display the most current warnings).
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Using RtfPad
 The Service Event, Warning, and Error Logs appear in RtfPad. You can view the
event logs at any time to monitor the progress of scheduled events or to troubleshoot
problems. Logs from RtfPad can be saved or printed, or you can send a copy of the
log via email. Using RtfPad, you can also easily find and view descriptions of system
errors.

Saving, Sending and Printing Logs
Logs that appear in RtfPad can be saved, sent by email, or printed. These commands,
accessed through the File menu of RtfPad are standard Windows commands, and
function in RtfPad as they would in any Windows-based program.

To save, send or print a log:
� With the Log open, select the command you want to perform from the File

menu.

Error Format
 RtfPad can be viewed in a black-and-white interface, or with color to contrast errors
and warnings from other events. If RtfPad is set for Error Format, errors appear in
red text and warning messages appear in yellow text so that they are easily noticed.
Header text appears in green.

To set RtfPad to display information in error format:
� From the View menu, select Error Format. This is a toggle command. When

enabled (selected), a checkmark appears to the left of the command.

Errors appear in red text when enabled, while message-logging enabled/disabled
appears in green and warnings appear in yellow text.

To disable error format:
� From the View menu, select Error Format again. This is a toggle command.

When disabled, no checkmark appears to the left of the command.

RtfPad Error Lookup
When an error appears in RtfPad, an error number appears in parentheses with the
error message. This error number identifies the error and allows you to use the
RtfPad error lookup feature to obtain additional information about the error,
including the error name and a brief description.

To obtain additional information about an error:
1 With the error log open, highlight the error number.
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2 You have the following choices:

� From the View menu, select Error Lookup.

� Press <F2>.
A dialog box appears with the error name and description.

CONFIGURING MS SERVICE EVENT LOGGING
Event logging is necessary only when tracing events of interest to you. You can
configure which events are traced. Because tracing events impedes system
performance, no events are traced by default, though errors and warnings are logged
automatically because of their necessity for troubleshooting.

MEDIASTOR allows you to configure which events are logged, and whether to trace
the local service events or remote procedure calls (remote administration events).

For all logs, you can control the format of the log entries, and adjust the maximum
sizes for the log files. For the Event Log, you can disable logging and enable the
tracing of events upon startup. You can enable logging to the Windows Application
Log for the Warning and Error Logs.

Log Properties Configuration
You can control several aspects of logging functionality, including log entry format,
log file size, MS event logging, automatic startup of event logging and logging of
errors and warnings to the Windows Application Log.

To configure log properties:
1 From the Service menu, select Event Settings. The Service Event Configuration

dialog box appears. The Configuration Tab is active by default.
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Figure 64: Service Event Configuration Dialog Box

2 In the Line Format section, enable or disable logging of particular event
attributes by clicking in the checkbox next to each option to place or clear the
checkmark.

Table 17: Service Event Configuration: Line Format Options

ATTRIBUTE: DESCRIPTION:

Time: The time the event occurred

Date: The date the event occurred

Thread ID: The thread which the event used to communicate with the
processor

3 To disable logging to the event log, click the checkbox Disable log file (viewer
only).

4 If event logging is enabled, the Maximum Log Size text box is active. Use this
box to set the maximum event log size by typing the number of megabytes into
the Maximum Log Size text box. The default size is 5 megabytes.

5 To automatically initiate event logging when MS is started, click a check in the
checkbox next to Trace messages on startup.

6 In the Warning Log, enter the maximum size for the Warning Log file. The
default size is 5 megabytes. You can also enable logging to the Windows
Application Log by clicking a check in the checkbox next to the Write to
Windows Application Log option.
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7 In the Error Log section, enter the maximum size for the Error Log file. The
default size is 5 megabytes. You can also enable logging to the Windows
Application Log by clicking a check in the checkbox next to the Write to
Windows Application Log option.

NOTE ����
The Warning Log and Error Log files are always written and cannot be disabled.

Event Tracing Configuration
You can configure which events are to be traced and reported to the Event Log. By
default, all event tracing is disabled. Unless instructed to enable tracing of events by
a technical support representative, you can leave the default settings in place.

NOTE ����
Event tracing configuration affects events only; errors and warnings relating to
events of the types listed are logged regardless of event tracing settings.

WARNING ����
Enabling event tracing hinders performance and should be performed only when
debugging is required.

To configure events to be logged:
1 From the Service menu, select Event Settings. The Service Event Configuration

dialog box appears.
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2 Click the Trace tab. This tab allows you to configure which events will be
logged. The System drop-down list displays Server Processing by default.

Figure 65: Service Event Configuration: Trace Tab

3 From the System drop-down list, select whether to trace Server Processing (local
machine service events) or Remote Procedure Calls (remote administration
service events).

4 In the Options window, individual events are listed. Click the checkbox next to
an event to enable tracing of that event. To disable tracing, clear the checkbox
by clicking it again.

5 After selecting the appropriate options, you have the following choices:

� Click Apply to save changes for the tab without closing the dialog box.

� Click OK to save the new settings and close the dialog box.

� Click Cancel to close the dialog box without saving any changes.

MEDIASTOR ADMINISTRATIVE TOOLS
MEDIASTOR provides a number of ways to perform diagnostics on the MS system.
Comprehensive error messaging is built in, so every time an error condition occurs, a
message with information about the condition causing the error appears. MS contains
an error lookup feature that allows you to quickly translate the error codes provided
in MS messages. In addition, reports can be created on the Windows Registry and
the media services configured to your MS system to help you monitor MS status.

In addition to diagnostic capabilities, MS provides an administrative utility to help
you repair the MS computer in the event of system failure.
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Error Lookup
Each MEDIASTOR error is displayed as an error number. The System Error Lookup
feature allows you to obtain additional information about the error, including the
error name and description.

To look up an error:
1 From the Help drop-down menu in the Administrator’s window, select Error

Glossary. The System Error Lookup dialog box appears.

2 Enter the error number in the Error Number text box and click Look Up.

Figure 66: System Error Lookup Dialog Box

3 The error string (if applicable) and its description are displayed in the dialog
box.

4 Click the forward or backward arrows to scroll through the list of system errors.
Click Help to access context-sensitive help for the error glossary. Click Tech
Notes to launch the Xtender Solutions Knowledge Base.

Click Close to exit the dialog box.

USING THE REPAIR DISK FUNCTION
In the event that the MEDIASTOR computer drive becomes corrupted, MS contains a
Repair Disk utility that periodically creates a disk image of the MS computer system
drive. You can create a current disk image when needed using the Repair Disk utility
or, in the event of a MS computer crash, use an existing disk image to restore the MS
configuration.

The Repair Disk utility can be used to create a backup copy of the registry
information for MS system. Every time a change is made to the MS configuration,
MS automatically updates the registry backup. You can set the location where the
repair disk is automatically saved, set a location for a copy of the registry for the
current MS configuration, or restore MS registry settings using the Repair Disk
Wizard.
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Setting the Repair Disk Location
The Repair Disk Wizard allows you to designate where MS will store the backup
registry information image it creates. In order to ensure fail-proof disaster recovery,
the image should be copied to a location separate from your Windows NT/2000
server files. Ideally, you should copy them to a different volume.

NOTE����
The location of the backup registry should be backed up to tape regularly.

To set the repair disk location:
1 Select Repair Disk from the Tools menu to start the Repair Disk Wizard. The

Repair Disk Wizard page appears.

Figure 67: Repair Disk Wizard

2 Choose the Set the automatic repair disk location option and click Next. The
Automatic Repair Disk Location page appears.

Figure 68: Automatic Repair Disk Location
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3 The default directory path appears in the Location text box. You may change it
by entering a different directory path in the Location text box. To search for a
location, click the Browse button and select a path in the Browse for Folder
dialog box, then click OK to return to the Automatic Repair Disk Location page.

4 Once you have entered a path in the Location text box, click Next. The
Summary page appears.

Figure 69: Repair Disk Summary Page

5 Review the information in the summary. To change the location, click Back to
return to the previous page.

6 When the information in the Summary is correct, click Finish to complete the
wizard. A progress message appears, indicating that the auto disk repair location
is being saved. Once the message disappears, the location change is complete.

Copying the Current Configuration
 In addition to designating where the registry backup is stored, The Repair Disk
Wizard also allows you to store a copy of the current registry settings at will. When
you use the Repair Disk Wizard to set a location for a copy of the current
configuration, MS creates a copy of the MS configuration as soon as the wizard is
completed.

NOTE����
Setting a location for a copy of the current configuration does not affect the location
for automatic backup. MS will continue to back up MS registry information to the
location set for automatic repair disk creation.

NOTE����
You must stop the MS service in order to create a backup of the service registry.
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To store a copy of the current disk image:
1 Select Repair Disk from the Tools menu to start the Repair Disk Wizard. The

Repair Disk Wizard page appears.

Figure 70: Repair Disk Wizard

2 Select the Copy current repair disk information to another location option and
click Next. The Copy Repair Disk Information page appears.

Figure 71: Copy Repair Disk Information Page

3 Enter a directory path in the Location text box. To search for a location, click
Browse and select a path in the Browse for Folder dialog box, then click OK to
return to the Copy Repair Disk Location page.

4 Once you have entered a path in the Location text box, click Next. The
Summary page appears.
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Figure 72: Create Repair Disk Copy Summary Page

5 Review the information in the summary. To change the location, click Back to
return to the previous page.

6 When the information in the Summary is correct, click Finish to complete the
wizard. A progress message appears, indicating that the copy disk repair
location is being saved. Once the message disappears, the repair disk
information copy is complete.

Restoring MS Registry Settings
 When NTFS corruption occurs on your MS computer, you can restore your MS
registry configuration by restoring the disk image using the backup registry copies.
Once you have reinstalled all of the necessary software components, you can use the
Repair Disk Wizard to restore your MS service configuration.

Before You Restore MS Settings
When Windows NT/2000 corruption occurs, the following steps should be taken
before running the Repair Disk Wizard to restore the disk image:

To prepare for restoring MS settings:
1 Reformat MS computer hard drive.

2 Reinstall Windows NT/2000.

3 Reinstall MS.

Restoring the Service
Once you have reinstalled all of the necessary software components, you can use the
Repair Disk Wizard to restore the MS configuration.
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To restore the MS registry configuration:
1 From the Tools menu, select Repair Disk to start the Repair Disk Wizard. The

Repair Disk Wizard page appears.

Figure 73: Repair Disk Wizard

2 Choose the Restore service configuration from a repair disk option and click
Next. The Restore Repair Disk page appears.

Figure 74: Restore Repair Disk Location Page

3 Enter the directory path to the repair disk in the Location text box. To search for
a location, click Browse and select the path in the Browse for Folder dialog box,
then click OK to return to the Restore Repair Disk page.

4 Once you have entered a path in the Location text box, click Next. The Restore
Repair Disk – Warning page appears. Please read carefully.
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NOTE����
In the event that there is a problem with the stored disk image, you may want to
go back and copy the current configuration to a different location before
proceeding. This will save an image of the current MS configuration.

Figure 75: Repair Disk – Warning page

5 Click Next. The Restore Repair Disk – Note page appears. This page provides a
reminder that the current product configurations will be overwritten with the
saved configuration from the specified repair disk location.

Figure 76: Restore Settings Note Page

6 To continue, click Next. The Summary page appears. The Summary page lists
details about the restore.
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Figure 77: Summary Page

7 Review this information carefully. To change the location, click Back three
times to scroll back through the wizard and return to the Location page. Click
cancel to exit the process without restoring the configuration. When the
information in the Summary is correct, click Finish to complete the wizard. The
registry information is copied and the backup MS configuration is restored to
your machine.

MS REPORTING UTILITY

The MS reporting feature is a useful tool for tracking system statistics. The Report
Wizard allows you to quickly create reports relating to several items, including
media, the current hardware configuration and MS Registry settings.

The Report Generator wizard allows you to create various reports of system
activities on multiple registered MS computers, including information about media,
hardware configuration, and product registry.  It also allows you to select to run
more than one report at a time, allowing you to view several different aspects or
details about several different registered MS computers, in one consolidated report.

You can create reports in MS and create custom layouts for your reports. Custom
layouts are particularly useful because they can be saved and reused every time you
run a report.

CREATING REPORTS - REPORT WIZARD
The Report Generator wizard allows you to create various reports of system
activities on one or more registered MS computers, including information about each
of its components and media. It also allows you to select to run more than one report
at a time, allowing you to view several different aspects, or details about several
different registered MS computers, in one consolidated report.
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NOTE ����
MS allows you to run multiple reports at once. If you choose to do this, the
appropriate report wizard pages for each report will be merged to form one wizard
that will lead you through the report generation process.

Once a report has been generated, it appears on your screen in RtfPad. RtfPad allows
you to save, print or send the report via email. For instructions, see Saving, Printing
and Mailing Reports on page 103.

To open the report wizard:
1 From the Tools menu, select Report Generator. The Report Wizard opens and

the Select Report(s) To Run page appears.

Figure 78: Select Report(s) To Run Page

The Select Report(s) To Run page lists all available MEDIASTOR reports. A
description of the report appears as a pop-up text box when you rest the mouse
pointer on any report option.

2 Select the appropriate report type(s). You can use a standard Windows <SHIFT>
or <CTRL> technique to select more than one type of report.

3 Click Next. The next report wizard page for the chosen report type appears.
Select Cancel to abort the procedure.

Specific information about creating each type of report is provided in the sections
below.
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Media Report
The Media Report displays information about selected groups of media that are part
of the MS system. The Media Report includes information on the selected media,
either as a summarized list of the pieces of media or a detailed description of the
properties of each piece of media. Information displayed in the detailed report
includes file system, free and used space counts, and read/write/mount statistics.

To create a media report:
1 From the Select Report(s) To Run page, highlight Media from the Report Types

list.

Figure 79: Select Report(s) To Run Page

2 Click Next. The Select Computer(s) page appears.

Figure 80: Report Wizard Select Computer(s) Page

The Select Computer(s) page lists all registered and connected MS computers.
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3 In the Select Computer(s) page, select the MS computer(s) for which you want
to generate a report.

4 Click Next. The Select Media page appears.

Figure 81: Select Media Page

The Select Media for Media Report page lists all available media for which you
can generate a report. It lists the MS computer where the media is located and
the name of the media.

5 Select one of the media types from the Listed Media drop-down list. Selecting a
specific media type from the drop-down list will narrow the number of media
listed in the Media list, and may make it easier to find and choose media for the
report.

6 Select a media pool to report on from the Media Pool drop-down list. Selecting a
specific Media Pool from the drop-down list will narrow the number of media
listed in the Media list, and may make it easier to find and choose media for the
report.

7 Highlight one or more of the media from the Media list and click Next. The
Options page appears.
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Figure 82: Media Report Options Page

The options page allows you to select the level of detail for the report (if
applicable) and select the layout for the report being generated. If you want to
edit a selected layout, click Edit Layouts. For detailed information on using the
Reports Layout Editor, see Reports Layout Editor on page 104.

8 If there is more than one computer/layout listed, select the one you want to use
for your report.

9 Select the amount of detail you want on the report: Full or Summary.

10 Click Next. The Summary page appears.

Figure 83: Media Report Summary Page
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11 Review the information in the summary page. If the information in the Summary
is correct, click Finish to create and display the report. The report appears in the
RtfPad.

Figure 84: Media Report Window

Hardware Configuration Report
The Hardware Configuration Report displays information about all of the hardware
devices configured as part of the MS system. This includes hardware properties and
whether the device is automatically set online when the service starts. Full reports
also display statistics for the media in each hardware device.
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To create a Hardware Configuration report:
1 From the Select Report(s) To Run page, highlight Hardware Configuration from

the Report Types list.

Figure 85: Select Report(s) To Run Page

2 Click Next. The Select Computer(s) page appears.

Figure 86: Report Wizard Select Computer(s) Page

The Select Computer(s) page lists all registered and connected MS computers.

3 In the Select Computer(s) page, select the MS computer(s) for which you want
to generate a report.

4 Click Next. The Options page appears.
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Figure 87: Media Report Options Page

The options page allows you to select the level of detail for the report (if
applicable) and select the layout for the report being generated. If you want to
edit a selected layout, click Edit Layouts. For detailed information on using the
Reports Layout Editor, see Reports Layout Editor on page 104.

5 If there is more than one computer/layout listed, select the one you want to use
for your report.

6 Select the amount of detail you want on the report: Full or Summary.

7 Click Next. The Summary page appears.

Figure 88: Hardware Configuration Report Summary Page
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8 Review the information in the summary page. If the information in the Summary
is correct, click Finish to create and display the report. The report appears in the
RtfPad.

Figure 89: Hardware Configuration Report Window

Product Registry Information Report
The product registry information report includes information about the system
registry, including a listing of all registry keys (and associated values) used by MS.

To create a Product Registry Information report:
1 In the Report Wizard, from the Select Report(s) To Run page, highlight the

Product Registry Information option.
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Figure 90: Select Report(s) To Run Page

2 Click Next. The Select Computer(s) page appears.

Figure 91: Report Wizard Select Computer(s) Page

The Select Computer(s) page lists all registered and connected MS computers

3 In the Select Computer(s) page, select the MS computers for which you want to
generate a report.

4 Click Next. The Options page appears.
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Figure 92: Media Report Options Page

The options page allows you to select the level of detail for the report (if
applicable) and select the layout for the report being generated. If you want to
edit a selected layout, click Edit Layouts. For detailed information on using the
Reports Layout Editor, see Reports Layout Editor on page 104.

5 If there is more than one computer/layout listed, select the one you want to use
for your report.

6 Select the amount of detail you want on the report: Full or Summary.

7 Click Next. The Summary page appears.

Figure 93: Product Registry Report Summary Page
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8 Review the information in the summary page. If the information in the Summary
is correct, click Finish to create and display the report. The report appears in the
RtfPad.

Figure 94: Registry Report Window

Saving, Printing and Mailing Reports
Once generated and displayed in the MS Report window, a report can be saved or
printed for future reference using RtfPad. In addition, you can send a report to
someone by email.

Figure 95: Report Window File Menu

By default, once the report (RtfPad window) is closed, the information is lost. While
the MS Report window is open, you can perform the following functions using the
report window File menu:

� Use Save As to save the report.

� Use Send to email the report.
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� Use Print and Print Setup to print the report in the appropriate format.

� User Print Preview to preview the report before printing.

REPORTS LAYOUT EDITOR
The MS Report Layout Editor allows you to define font, font sizes, tab stops, and
header and footer contents. The styles and layouts can be set and saved as report
defaults; however, you can override these options whenever necessary.

MS also allows you to create and save new layouts on different MS computers.
These layouts are available for use any time a report is run for that MS computer,
regardless of whether the report is being run from that MS computer itself, or from a
remote MS computer. When you generate a report using the Report Wizard for a
remote MS computer that has saved layouts, those layouts will appear in the Report
Wizard Options page.

To open the reports layout editor:
� From the Tools menu on the main menu bar, select Reports Layouts. The

Reports Layout Editor dialog box appears.

Figure 96: Report Layout Editor

The following procedures outline how to create, edit, view and delete custom report
loyouts. Once created, a report layout is available for use with all MS reports
generated through the Report Generator function.

To assist you with creating and editing your custom report layouts, the Report
Layout Editor window contains the following options:

� Use the drop-down list for the Name text box to select an existing layout to
view, edit or delete.

� Click Preview to preview the report layout listed in the Name text box.
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� Click Update to save changes to a report layout without exiting the Report
Layout Editor.

� Click OK to save changes to a report layout and exit the Report Layout Editor.

� Click Cancel to exit the Report Layout Editor without saving changes.

Each of the following procedures begins from the Report Layout Editor dialog box in
Figure 96.

Creating a New Layout
Each layout should be identified by a specific, descriptive name, in order to make the
layout easy to identify for use with your reports.

To create a new layout:
1 Click New. The Enter New Layout Name dialog box appears.

Figure 97: Enter New Layout Name Dialog Box

.

2 Type a name in the text box and click OK. A new layout with that name and the
default layout settings is created.

Changing Headers and Footers for Layouts
The Report Layout Editor dialog box contains two text boxes entitled Text, one for
the header and one for the footer. These boxes allow you to enter specific text for the
headers and footers. MS also allows you to insert dynamic codes, which retrieve
specific values and writes them directly into the header or footer with the specified
text. Placing these dynamic codes in custom headers or footers, and thereby on the
reports generated with a custom layout, can help you identify, file and retrieve
reports later.

To create or change a header or footer for a layout:
1 In the Report Layout Editor, click in either the header or footer text box.

2 Type in or edit the text for the header or footer.

3 If you want to insert a dynamic code, place the cursor where you want the code
value to appear.

4 Click Insert Code under the appropriate text box. The Select Report Code to
Insert dialog box appears.
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Figure 98: Select Report Code To Insert

5 Select the code that you want to insert. You have six options:

� User Name: the service logon ID for MS

� Network Domain: the domain on which MS is running

� Date: the system date the report is generated

� Time: the system time the report is generated

� Report Name: the name given to the report when generated

� MS Version: the version of MS used to generate the report

6 Click OK to insert the code and return to the Report Layout Editor dialog box.

NOTE ����
Spaces are not automatically inserted around the code. If you want spaces to appear
before or after the value the code inserts, place spaces in the text box before and after
the code as appropriate.

Editing Layout Paragraph Styles
The Report Layout Editor allows you to customize the look of your reports by giving
you font, size, color and other stylistic options for each type of paragraph used in
generating report output. This makes it easier to call attention to specific information
in the reports and may make your reports easier to read and interpret.
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To edit styles for a layout:
1 Make sure the layout you want to modify appears in the Name text box and click

Edit Styles. The Styles dialog box appears.

Figure 99: Styles Dialog Box

2 Each paragraph type has a drop-down list containing all available style profiles.
For each paragraph style profile you have the following options (each paragraph
style must be edited separately):

� Select a profile from the drop-down list

� Click Edit next to the paragraph profile text box to open the Report Style
Editor

If you are selecting profiles from the drop-down lists, skip the next steps and
continue with step 5.
If you click Edit next to a paragraph profile text box, the Report Style Editor
dialog box appears.

Figure 100: Paragraph Style Editor Dialog Box

3 Select the desired characteristics for Font, Font Size, Text Color, and Alignment
from the appropriate drop-down lists.

4 Enable or disable the Underline and Bold characteristics for the paragraph by
clicking in the checkbox next to each option.
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5 Click OK to save your changes to the paragraph style and return to the Styles
dialog box. Your new style properties appear in the paragraph profile text box.

6 Once you have select or confugured all necessary styles, you can preview the
report layout by selecting the Preview button on the Report Layout Editor dialog
box. A Report Layout Preview appears.

Figure 101: Report Layout Preview

7 Close the Preview by selecting Close from the File menu or by clicking the
window close button on the far right of the title bar. You are returned to the
Report Layout Styles dialog box.

8 Once you are satisfied with your layout styles, click OK to save changes and
return to the Report Layout Editor dialog box.

9 Click Update to save your changes and leave the Report Layout Editor dialog
box open. Click OK to save your changes and close the Report Layout Editor
dialog box. Click Cancel to cancel your changes and close the Report Layout
Editor dialog box.

Switching, Renaming and Deleting Layouts
The Name drop down box allows you to easily switch from one layout to another
within the Report Layout Editor. If you have created or made edits to a report layout,
and you want to create or edit another one, you should click Update to save your
changes. If you select another layout from the Name drop-down list box or click
New without clicking the Update button, MS will prompt you to save unsaved
changes to the current layout.

The editor also allows you to rename your layouts. Renaming a layout simply saves
the report layout characteristics under a different name.
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To rename a layout:
1 Make sure that the correct layout appears in the Name text box.

2 Click Rename. The Enter New Layout Name dialog box appears.

Figure 102: Enter New Layout Name Dialog Box

3 Type the new name in the text box and click OK. The new name appears in the
Name text box in the Report Layout Editor dialog box.

The layout editor allows you to delete report layouts when they become obsolete and
are no longer useful. Deleting unused layouts makes it easier to find and select more
commonly used report layouts when creating a report.

To delete a layout:
1 Make sure the correct layout appears in the Name text box.

2 Click Delete.

3 MS will then ask you to confirm that the layout should be deleted. Click OK to
permanently delete the layout or Cancel to stop the delete operation.
The layout is deleted and no longer appears in the Name drop-down list in the
Report Layout Editor and is no longer available for use on reports.

REMOVING MS COMPONENTS

MS can be removed from the MS computer if necessary. When MS is removed, all
configuration settings and system files are deleted. When reinstalled, new settings
must be configured. Caution should be taken when removing the product, as all
settings are permanently lost (unless you created a copy of your registry using the
Repair Disk function – see Using the Repair Disk Function on page 85).

BEFORE YOU REMOVE MS
In preparation for removing MS, you must remove the MS media service from any
application pointing to that computer for MS. For specific details for removing a
media service, refer to your application’s documentation. Then you must remove the
hardware from the MS configuration.
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Before running Setup to remove MS, make sure you have followed these preparatory
steps (in the following order):

To prepare to remove MS:
1 Remove the MS media service from any application pointing to the computer

from which MS is being removed.

2 Set all drives and all devices offline.

3 Remove all hardware devices from the MS Configuration.

4 Reboot the MS computer.

5 Stop the MS service after reboot (if the service is configured for automatic
startup).

Running Setup to Remove MS
Once the preliminary steps have been completed, (see Before You Remove MS above)
you can run Setup to remove MS.

The Setup option in the MS program group provides a wizard that leads you through
the necessary steps for uninstalling MS. The Next button continues to the following
step; the Back button (when active) returns to the preceding step. The Cancel button
exits Setup, canceling the process.

To uninstall MEDIASTOR:
1 From the MEDIASTOR Media Services Program group, select Setup. The MS

Installation page appears.

Figure 103: MEDIASTOR Installation Page

2 Click Next. The Installation Options page appears.
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Figure 104: MEDIASTOR Installation Options Page

3 Select the Remove product and related items option, and then click Next. A
Warning message appears.

Figure 105: Uninstall Warning Message

The warning message reminds you that the MS configuration and program files
will be removed from each computer from which you select to remove the
program. Click Yes to continue. Click No to abort the Uninstall process.

4 If you click Yes, the Select Target Computers page appears, with the local
computer already listed in the Target Computers list.
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Figure 106: Select Target Computers Page

NOTE ����
If you have other computers registered through the MS Administrator, those
computers will also appear in the initial Target Computers list.

5 If you want to remove MS from additional computers, click Add. The Browse
Computers dialog box appears.

Figure 107: Browse Computers Dialog Box

6 Under Available Computers, navigate to and highlight the computer from which
you want to uninstall MS. Click Add. That computer is now listed under
Selected Computers. Repeat this step for each additional computer from which
you want to uninstall MS.

7 Click OK. You are returned to the Select Target Computers page.
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Figure 108: Select Target Computers Page

8 Review the list of computers in the Select Target Computers page. To remove
any computers from those listed for uninstall, highlight the computer and click
Delete.

9 If the list is correct, click Next. The Summary Page appears.

Figure 109: Uninstall MEDIASTOR Summary Page

10 Review the information in the Summary and if correct, click Finish. If you have
selected any computers on which MS cannot be uninstalled (for example, the
tasks listed in the Before You Remove MS section on page 109 was not
completed), you will receive an error message. Otherwise, a Progress bar
appears.
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Figure 110: Uninstall Progress Bar

NOTE ����
If necessary, you can cancel the uninstall process at any time by clicking Cancel.

11 After uninstall is complete, a Setup Result dialog box appears, showing the
results for each computer you specified.

Figure 111: Uninstall Result Dialog Box

Most uninstall processes require a reboot after the process. This is necessary
after the MS uninstall in order to reset any SCSI devices being used by MS on
the specified machine(s).

12 Restart all computers designated in the Result window as requiring a reboot.

MS is removed from the specified computers. Any settings related to MS in the
Windows registry, all program files in the installation path, and the MS program
group/folder are deleted.

REMOVING MS REMOTE ADMINISTRATOR

MS Remote Administrator can be removed from a client machine any time
necessary. Removing the Administrator from a remote machine does not affect any
MS services registered by the administrator; only the client system files for the
Administrator and Service Manager are deleted.
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The Setup option in the MS Remote Administrator program group provides a wizard
that leads you through the necessary steps for uninstalling MS Remote
Administrator. The Next button continues to the following step; the Back button
(when active) returns to the preceding step. The Cancel button exits Setup, canceling
the process.

To uninstall MEDIASTOR remote administrator:
1 From the MEDIASTOR Media Services Remote Administrator Program group,

select Setup. The Administrator Installation page appears.

Figure 112: Administrator Installation Page

2 Click Next. The Installation Options page appears.

Figure 113: Administrator Installation Options Page

3 Select the Remove product and related items option, and then click Next. A
Warning message appears.
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Figure 114: Uninstall Warning Message

The warning message reminds you that the Remote Administrator configuration
and program files will be removed from each computer from which you select to
remove the program. Click Yes to continue. Click No to abort the Uninstall
process.

4 If you click Yes, the Select Target Computers page appears with the local
computer already listed in the Target Computers list.

Figure 115: Select Target Computers Page

5 If you want to remove the Remote Administrator from additional computers,
click Add. The Browse Computers dialog box appears.

NOTE ����
If the computer on which you are running the Setup Wizard has the Remote
Administrator installed on it, that computer will appear in the Target Computers list.
You may delete it if necessary. If the Remote Administrator is not installed on the
local computer, this box will be empty.
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Figure 116: Browse Computers Dialog Box

6 Under Available Computers, navigate to and highlight the computer from which
you want to uninstall Remote Administrator. Click Add. That computer is now
listed under Selected Computers. Repeat this step for each additional computer
from which you want to uninstall Remote Administrator.

7 Click OK. You are returned to the Select Target Computers page.

Figure 117: Select Target Computers Page

8 Review the list of computers in the Select Target Computers page. To remove
any computers from those listed for uninstall, highlight the computer and click
Delete.

9 If the list is correct, click Next. The Summary Page appears.
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Figure 118: Uninstall Administrator Summary Page

10 Review the information in the Summary and if correct, click Finish. If you have
selected any computers on which the Remote Administrator cannot be
uninstalled, you will receive an error message. Otherwise, a Progress bar
appears.

11 If the list is correct, click Finish. A Progress bar appears.

Figure 119: Uninstall Remote Administrator Progress Bar

NOTE ����
If necessary, you can cancel the uninstall process at any time by clicking Cancel.

12 Once uninstall is complete, a Setup Result dialog box appears, showing the
results for each computer you specified.
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Figure 120: Uninstall Result Dialog Box

Most uninstall processes require a reboot after the process.

13 Restart all computers designated in the Result window as requiring a reboot.

The MS Remote Administrator is removed from the selected computers. Any
settings related to the Remote Administrator in the Windows registry, all program
files in the installation path, and the MS Remote Administrator program group/folder
are deleted.
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MANAGING HARDWARE

The MEDIASTOR (MS) Administrator allows you to add, modify or delete hardware
devices used by MS. Devices are categorized as libraries, towers, and standalone
(non-library) drives.

The following sections detail how libraries, towers, and drives are added to an MS
service. Instructions for modifying and deleting existing devices follow, as well as
information on managing the insertion, movement, and ejection of media in the
devices.

For a complete list of supported hardware devices, refer to the online help.

MANAGING HARDWARE DEVICES

Three types of hardware devices can be added to MS: libraries, towers, and
standalone drives. This chapter contains information on hardware organization in the
MS Administrator, and hardware terminology. In addition, the following sections
provide details on managing specific types of devices.

� For information on managing libraries, see Managing Libraries on page 124.

� For information on managing towers, see Managing Towers on page 159.

� For information on managing standalone drives, see Managing Standalone
Drives on page 169.
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THE HARDWARE TREE

The Hardware tree in the MS Administrator lists all devices that have been added to
the MS service. Using shortcut menus you can add, modify, and delete hardware
devices managed by MS from the Hardware tree. In addition, you can set devices
online or offline and manage the insertion, movement, and ejection of media in the
device.

WARNING ����
While MS is running and SCSI devices are in use or being configured, do not run
any other applications that access the devices. Two different applications sending
SCSI commands to the same device may cause commands to fail and may cause
damage to the hardware. For example, do not run SCSI Manager while configuring
hardware.

HARDWARE STATUS
You can configure the hardware items in the tree view of the MS Administrator to
change color depending on their status. The following table lists each color and
describes the status indicated by each color:

Table 18: Hardware Status Indicated by Color

MEDIA COLOR: MEDIA STATUS:

Red Error

Yellow Offline

Green Online and running a task

Black Online, but not running a task

To configure the tree view to indicate hardware status by color:
� From the View menu, select Enable Color. A checkmark next to the Enable

Color option signifies that the option has been enabled. If this option is disabled,
all media items are black, regardless of status.

HARDWARE DEVICE TERMINOLOGY

When you add a device to MEDIASTOR, you may need to select it from a list of
available devices. MS uses standardized naming conventions for hardware devices.
Understanding the format for a device name simplifies identification of the device in
MS.
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In addition, you will be asked to specify a file system for the device. Only one file
system can be selected for a device, even if the device has multiple drives, like a
tower or a library. A brief discussion of device names and file systems follows.

DEVICE NAMES
MS supports standalone drives, towers, and SCSI and serial libraries. When SCSI
devices are added and configured in MS, the supported devices listed in the
Windows Registry are automatically listed for use in MEDIASTOR. These devices
appear in order according to their model and their device address. SCSI and serial
addresses are displayed differently, and are configured using different methods.

SCSI Device Names
The SCSI address is the same as the character string that names this device in SCSI
Manager. Look at the icon for this device in SCSI Manager; its device name
(address) is shown in quotes under the icon.

The numbers in the device address represent the SCSI Port, Bus, Target ID, and
Logical Unit ID, respectively. For example, on a typical system with one host
adapter, a CD-ROM drive at target ID 2 would be SCSI.0.0.2.0.

Figure 121: SCSI Device Address diagram

SCSI0020

SCSI Port

Bus Target ID

Logical Unit ID
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Serial Library Device Names
If a library with serial robotics is used, the serial port designation and the robotics
controller ID must be provided. For example, the address for a serial library with one
drive attached could be COM1-0. COM1 designates the MS computer’s COM port to
which the library is connected; 0 designates the RS-232 ID for the robotics
controller. Up to fifteen devices may be daisy-chained on a serial port.

NOTE����
For more information on how to identify the RS-232 for your library, refer to the
manufacturer’s documentation.

FILE SYSTEMS
When hardware devices are configured, a file system must be selected for each
device: either Windows Native file system or OTG file system. Media can be
formatted for any file system supported by the device.

There are many different types of file systems for many different types of media,
each with benefits and costs relating to features vs. performance. OTG file systems,
for example, provide maximum performance with other OTG applications (like
DISKXTENDER), while Windows NT Native file systems provide media portability.
In addition, certain types of media may be limited to one file system or another. Tape
media, for example, can only be used with an OTG file system. Consider your
individual file system issues and needs when making a decision.

Multiple File Systems
Although multiple file systems can be used in one MS service (using multiple
devices), they cannot be mixed in the same hardware device. In addition, to be used
in MS, the file system format of a piece of media must match that of the file system
for the device where it is mounted.

Multiple file systems are recommended only for advanced systems with higher data
organization requirements. In general, however, one file system should be chosen,
and all devices and media should be formatted for that file system.

MANAGING LIBRARIES

MEDIASTOR supports a wide variety of libraries. (For a full list of supported libraries,
refer to the online help.) You can add and remove libraries in the MS system from
the Hardware tree. The Manage Media function available from the library shortcut
menu provides robotics management for libraries, allowing you to insert, eject, and
move media within the library. MS internally performs all necessary mount and
dismount operations for media read/write requests.
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ADDING A LIBRARY
MS treats libraries as single storage devices. A SCSI address exists for the library,
and one for each drive in the library. When adding a new library to the configuration,
its drives must be defined in the order that the vendor numbers its drive elements. An
Auto Configuration option is available for most supported libraries. Auto
Configuration will order the drives with their corresponding SCSI ID, which is not
necessarily in order of lowest to highest.

Any supported library currently listed in the Windows Registry, as well as any
supported serial library, can be added to the MS hardware configuration.

NOTE����
The Windows Registry contains an inventory of all SCSI devices connected,
powered on, and responding upon startup. For a list of devices supported by MS,
open the Supported Device list from the MS submenu of the Start menu.

Using the Hardware Wizard
The Hardware Wizard allows you to add a new library.

To add a new library:
1 Right-click on the Hardware node and click New from the shortcut menu to start

the Hardware Wizard.

Figure 122: Hardware Shortcut menu

2 The Add new Hardware Device page appears.
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Figure 123: Add New Hardware Device Page

3 Select the Library option and click Next. The Select New Library page appears.

Selecting a New Library
The Select New Library page lists all of the SCSI libraries currently listed in the
Windows Registry that have not yet been added to the MS hardware configuration.

You may also enable or disable the check box below the Available Library Devices
list to view (or hide) available serial library (both optical and CD-ROM) devices in
the list.

Figure 124: Select New Library Page
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To continue adding a library:
� Highlight the library you want to add and click Next. The Configuration page

appears.

Configuring the New Library
The library Configuration page provides information on the device being added, and
allows you to enter a device name and default file system for the library. You can
enable or disable automatic initialization of the library on MS startup.

Figure 125: Configuration Page

Configuration options are described in the following table:

Table 19: Configuration Page Options

OPTION: DESCRIPTION:

Device Name The name of the SCSI or serial interface to which the device is
connected.

Interface Type The type of interface the device uses to communicate with the
MS machine.

Description The device description from the device inquiry string specified
by the manufacturer.

Name The Name you assign to this Library.

Library names are used only for user interface purposes. They
do not affect the internal workings of the system and can be
any alphanumeric string desired, up to 32 characters.
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OPTION: DESCRIPTION:

File System The file system selected to be used by this Library.

All drives within a library must use the file systems specified
for the library.

Set this device
online when
the service
starts

If enabled (checked), the library is automatically set online
when MS is started. If disabled (not checked) the Library will
have to be set online manually.

This setting is checked by default; however, a library may be
disabled when a hardware problem occurs (as opposed to
removing the library from the configuration). If this check box
is not selected, the library will not be started during system
startup.

To continue adding a library:
1 Enter a Name for the Library. Library names are used only for user interface

purposes and can be any alphanumeric string, up to 32 characters.

2 Select the File System for the Library from the drop-down list. All drives within
a library must use the file system specified.

3 Select whether to set this device online when the service starts. This setting is
checked by default. To disable the option, clear the checkbox.

4 When these options are configured, click Next to move to the next step in the
wizard.

� If you are configuring a Serial Library, the next page that appears is the
Serial Information Page. For instructions, see Entering Serial Library
Information below.

� If you are configuring a SCSI library, the next page that appears is the
Drives page. For instructions, see Adding Library Drives on page 129.

Entering Serial Library Information
If you are configuring a Serial Library, a Serial Information page appears in between
the Configuration page and the Drives page of the hardware wizard. This page
allows you to choose a COM port and Device ID (if applicable) for the serial library.

NOTE����
If no serial libraries are to be configured, proceed to Adding Library Drives section
on page 129.
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Figure 126: Serial Information Page

The options displayed on the Serial Information change to display options particular
to that device.

Table 20: Serial Information Page Options

OPTION: DESCRIPTION:

COM Port The COM port to which the serial library will be connected on the
MS machine.

Device ID The device ID assigned for the RS-232 interface with the robotics
controller. Consult your hardware documentation for more
information on the device ID (also called the RS-232 ID or the
COM ID).

To continue adding a library:
1 Select the appropriate COM port to which the serial library will be connected to

the MS computer

2 If applicable, select the Device ID for the RS-232 interface

3 Click Next to continue. The Drives page appears.

Adding Library Drives
When the Drives page initially appears, no drives are listed. Library drives must be
added. If you are adding a serial library, you must add and configure your library
drives manually. For SCSI libraries, MS contains an Auto Config functionality,
which allows you to add and configure library drives automatically.
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To add library drives:
� When the drives page initially appears, it is empty. You must add the drives for

your library. You have three options:

� If you are adding a serial library, click Add. For further instructions, see
Manual Drive Configuration on page 131.

� If you are adding a SCSI library and want to add drives manually, click
Add. For further instructions, see Manual Drive Configuration on page 131.

� If you are adding a SCSI library and want to add and configure drives
automatically, click Auto Config. For further instructions, see Automatic
Drive Configuration below.

NOTE����
Drives must be added manually for serial libraries.

Figure 127: Drives Page

Automatic Drive Configuration
Some libraries support automatic drive configuration, which allows you to add and
configure the drives in one step through the interface. Auto Config automatically
adds all the drives in a library and orders them for you.
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To automatically configure library drives:
1 Click the Auto Config button. A message appears asking you to confirm the

automatic configuration.

2 Click Yes. One of two results will occur:

� If the Auto Config is successful, a status message appears. Click OK. The
drives added are listed on the Drives page.

� If the Auto Config fails, a message indicates that the drives must be added
manually. (For instructions, see Manual Drive Configuration below.)

If Automatic Configuration is successful, the drives page appears listing the drives
that were added. Your next step is to check your drive activation settings and, if
necessary, change them. For instructions, see Drive Activation Settings on page 134.

NOTE ����
If the library and drive are not on the same bus, Auto Config will fail. The drives
must be added manually. For instructions, see Manual Drive Configuration below.

NOTE ����
Auto Config is not supported for serial libraries.

Manual Drive Configuration
Serial libraries and some SCSI libraries do not support automatic configuration. Auto
Config will fail if the selected library does not support it. In those cases, the library
drives must be added and configured manually.

Manually adding library drives:
1 Click the Add button. The Select Library Drives dialog box appears, showing all

drives currently listed in the Windows NT Registry, including standalone drives.

2 Select the drive(s) to be added. Be sure to only select actual library drives.
While the system will allow you to select standalone or external drives from this
window, the configuration test run afterwards will fail.

3 Click OK to add the drives to the library configuration.

NOTE����
When manually adding drives, they must be added in the order of the drive number
and not the SCSI ID. Example: If drive 1 has SCSI ID 1050, and drive 2 has SCSI ID
1040, the SCSI addresses of the drives are not going to be in ascending order, SCSI
ID 1050 (drive 1) is going to come before SCSI ID 1040 (drive 2). In the Drives list
box 1040 (drive 2) will still appear first.
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Figure 128: Select Library Drives dialog box

Adding Reserved Drives
If you choose to add only some of the drives in a library, you must add reserved
drives as placeholders for the drives that are not added.

To add reserved drives:
1 Click Add in the Drives page again. The Select Library Drives page appears

with a Device Name listed as “Reserved.”

2 Highlight the Reserved Device Name entry and click OK to add the reserved
drive.

Figure 129: Select Library Drives Dialog Box With Reserved Name Entry
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Repeat this process until you have added a reserved drive in the place of each actual
drive in the library that is not being added. The total number of drives, actual and
reserved, listed in the Drives Page must equal the total number of drives in the
library.

Figure 130: Drives Page with Reserved drives

NOTE����
Some libraries are configured in a way that there are physically 2 drives, but the
library firmware expects 4 drives. When Auto Config is run, reserved drives will be
added for those bays in the library that the drive is missing.

Setting the Drive Order
Once drives are added, they must be properly configured, and their configuration
tested for accuracy. When you add drives manually, you will have to make sure they
are ordered according to the drive order in the library. A configuration test will tell
you if the order of the drives is correct or not. For instructions, see Performing a
Configuration Test below.

To change the order of a library drive,
� Highlight the drive and then use the Up and Down arrows to the right of the

Drives list to promote or demote the drive’s position in the list.

NOTE����
Once the drive order is set or if the drive order is changed, perform a configuration
test to determine if the order of the drives is correct or not.
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Performing a Configuration Test
When drives are added manually, a configuration test should be performed on the
library to ensure the drives are ordered properly. Media must be present in the library
in order to perform a configuration test. Automatic Configuration should order your
drives properly when they are added, but you may wish to perform a configuration
test anyway.

To perform a configuration test,
� Click Test Config on the Drives page. A status message appears while the

library and its drives are assessed.

After the test is complete, a message returns stating whether the test succeeded or
failed. Click OK to exit the message and return to the Drives page.

If the configuration test fails, verify each of the following:

� The drives are ordered properly.

� Any standalone or external drives have been selected.

� There is media in the library.

After doing so, perform another configuration test to ensure accuracy.

You will next want to check, and if necessary, change your drive activation settings
on the Drives Page.

NOTE����
The Test Config function is not supported for serial libraries.

Drive Activation Settings
Once drives have been added and their order set, you may want to enable or disable
individual drive activation settings. By default, the Set drive online when library is
set online option is enabled. However, a drive can be set to remain inactive until
manually set online if necessary.
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Figure 131: Drives Page

NOTE����
At least one drive must be configured to be set online when the library is set online.
Otherwise, the library will remain offline.

To configure drive activation settings
1 Highlight a drive from the Drives list.

2 Click on the Set drive online when library is set online checkbox to enable or
disable this option.

3 Once the drives are listed and configured correctly on the Drives page, click
Next. The Auto Clean Page appears.

Configuring Drive Auto Clean Options
The Auto Clean page allows you to set up automatic cleaning options for the drives
in the library based on read/write usage. This allows you to store a cleaning cartridge
in the library and clean the drives automatically, without manual intervention. Your
options are:

� Disable automatic drive cleaning for this library.

� Clean drives when total configured read/write activity is exceeded.

� Clean drives when configured read OR write activity is exceeded.



Chapter Five: Managing Hardware

136 MEDIASTOR System Guide

Figure 132: Auto Clean Page

If you configure Auto Clean for your library drives, the cleaning cartridge must be
resident in the library at the time you configure Auto Clean, and you must enter the
shelf number where the cleaning cartridge is located. This allows MEDIASTOR to find
the cleaning cartridge and insert it into the library drives when appropriate.

To configure auto clean options:
1 You have the following options:

� Select Disable automatic drive cleaning for this library

� Select Clean drives when total read/write activity is exceeded, and enter the
total number of hours the drive must be in use before the drive is cleaned.

� Select Clean drives when read or write activity is exceeded and enter
separately the total number of hours each drive must be in use for read or
for write before the drive is cleaned.

2 If you selected an option other than Disable automatic drive cleaning for this
library, enter the shelf number where the cleaning cartridge is located.

3 Click Next. The Drive Options page appears.

Configuring Drive Options
The Options page contains two option settings: media dismount timeout and number
of shelves to use for inventory of the library. Each option is described in the
following sections.
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Figure 133: Drive Options Page: Idle Drives Dismount

Idle drive dismount seconds:
Dismount media after __ seconds of inactivity: select this option to allow the
library to dismount media from a drive after the specified number of seconds has
passed without a read or write request for that media. The default is 60 seconds.

Do not automatically dismount the media: select this option to leave media in a
drive regardless of how long the media has been inactive. Media will be dismounted
when another piece of media must be mounted in the drive for a read or write
request.

Figure 134: Drive Options Page: Maximum Shelves For Inventory
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Maximum shelves to use for inventory:
Use all shelves in this library: select this option to use all of the library shelves to
hold media for the media service. This is the default.

Use only the first __ shelves: select this option to only use a select number of
shelves (consecutively starting with the first shelf) to hold media for the media
service.

If you select the Use only the first __ shelves option, only shelves up to and
including the designated shelf will be used (allows you to partially utilize a library
with a damaged shelf or to use only a specified number of shelves in a large library).
This feature can be used to prevent automatic inventory of a large number of shelves,
which could take a long time.

Completing the Wizard Process
Once library options are defined, clicking Finish adds the library to MEDIASTOR. In
most cases, MS requires that the computer be rebooted when new devices are
configured. If reboot is required, MEDIASTOR will prompt you before rebooting.

Figure 135: Reboot MS Computer

Click Yes to reboot the MS computer. Once the computer reboots, the device is
added to the MEDIASTOR configuration.
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MODIFYING A LIBRARY
Several aspects of a library’s configuration can be changed at any time, if necessary.
You can modify the library name or file system setting, add or remove drives as
needed, change the drive event settings, and reconfigure library options.

Modifying a library takes you back through the steps of the wizard used to add the
library in the first place. You can change the information on each of the pages in the
same way you set the library up when you added it to your MEDIASTOR
configuration.

NOTE����

The library must be set offline before any modifications can be made.

To modify a library:
1 Right-click the library to be modified from the Hardware tree.

2 Select Modify from the shortcut menu. A verification message appears.

3 Click Yes to verify modification. If the library is online at the time you select to
modify the library, another message appears asking if you want to set the library
offline.

Figure 136: Set Library Offline Message

4 Click Yes. The library is set offline and the Configuration page appears.
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Changing Library Configuration
The Configuration dialog box allows you to make the necessary changes to the
library configuration, including name and file system. Check or uncheck the option
to automatically set the device online when MS starts.

Figure 137: Drive Configuration dialog box

To change library configuration settings:
� Make necessary changes to the Name, File System or library activation setting.

Once changes are complete, click Next to proceed to the Drives dialog box.
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Changing Drive Settings
The Drives page allows you to add or remove drives and enable or disable drive
activation settings.

Figure 138: Drives dialog box

To add, delete or check the configuration of library drives:
1 Select one of the following functions from the Drives page:

� Click Add to add drives and follow the instructions under Manual Drive
Configuration on page 131.

� Highlight a drive a click Delete to delete a drive from the library
configuration. You may need to add a reserved drive in the place of the
deleted drive. For instructions, see Adding Reserved Drives on page 132.

� Click Auto Config to automatically add and order all drives in the library to
the configuration (if supported by the library).

� Click Test Config to check the current library drive order.

2 Make any necessary changes and click Next to proceed to the Auto Clean dialog
box.
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NOTE����
Library drives cannot be removed from the configuration when there is a hardware
problem because this would violate the drive numbering scheme for library drives.
For example, removing drive #1 would make drive #2 become drive #1, and MS
could not address the drive in the library. For this reason, when hardware problems
arise, disable the drive instead. This forces the drive to be ignored during runtime
while preserving drive numbering.

Changing Drive Auto Clean Options
The Auto Clean dialog box allows you to change whether or not you want
MEDIASTOR to automatically clean the library drives, configure how often the drives
should be cleaned, and change where in the library the cleaning cartridge is stored.

Figure 139: Drive Auto Clean Dialog Box

To configure auto clean options:
1 You have the following options:

� Select Disable automatic drive cleaning for this library.

� Select Clean drives when total read/write activity is exceeded, and enter the
total number of hours the drive must be in use before the drive is cleaned.

� Select Clean drives when read or write activity is exceeded and enter
separately the total number of hours each drive must be in use for read or
write activity before the drive is cleaned.

2 If you selected an option other than Disable automatic drive cleaning for this
library, enter the shelf number where the cleaning cartridge is located.

3 Click Next. The Drive Options page appears.
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Configuring Drive Options
The Options page contains two option settings: media dismount timeout and number
of shelves to use for inventory of the library. Each option is described in the
following sections.

Figure 140: Drive Options page

Idle drive dismount seconds:
Dismount media after __ seconds of inactivity: select this option to allow the
library to dismount media from a drive after the specified number of seconds has
passed without a read or write request for that media. The default is 60 seconds.

Do not automatically dismount the media: select this option to leave media in a
drive regardless of how long the media has been inactive. Media will be dismounted
when another piece of media must be mounted in the drive for a read or write
request.
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Figure 141: Drive Options page

Maximum shelves to use for inventory:
Use all shelves in this library: select this option to use all of the library shelves to
hold media for the media service. This is the default.

Use only the first __ shelves: select this option to only use a select number of
shelves (consecutively starting with the first shelf) to hold media for the media
service.

If you select the Use only the first __ shelves option, only shelves up to and
including the designated shelf will be used. This allows you to partially utilize a
library with a damaged shelf, or to use only a specified number of shelves in a large
library. This feature can be used to prevent automatic inventory of a large number of
shelves, which could take a long time.

Completing Library Modification
Once changes are complete, click Finish to exit the wizard and save changes. Click
Cancel to exit without saving changes. Click Back to return to the Configuration
Page. Click Help to access context-sensitive help for the wizard.

NOTE����
You may be required to reboot to allow changes to be made to your SCSI
configuration.
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DELETING A LIBRARY
A library can be deleted from the MS hardware configuration at any time. Once a
library is deleted, it is permanently removed from configuration. In order to use this
library, it must again be added through Add Hardware wizard. Care should be taken
when deleting a library, as it may be more helpful to set the library offline if it is to
be used again. This is helpful if a problem occurs with the library and it is necessary
to remove it only temporarily from the configuration.

NOTE����
A library must be set offline before it can be deleted.

To delete a library from MEDIASTOR:
1 Right-click the library to be deleted in the Libraries tree.

2 Click Delete from the shortcut menu.

Figure 142: Library shortcut menu

3 When prompted, click Yes to confirm the deletion or No to abort. Clicking Yes
removes the library from the Libraries tree.

Figure 143: Confirm library deletion message

NOTE����
You may be required to reboot to allow changes to be made to your SCSI
configuration.
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LIBRARY PROPERTIES
The Properties option allows you to view and edit properties for an MS library. The
Properties dialog box consists of four tabs containing drive information and library
options.

To view Library Properties:
� Right-click the desired library, and select Properties from the shortcut menu.

Figure 144: Library shortcut menu

The Library Properties dialog box appears. Library Properties are summarized on the
following tabs: General, Drive Events, Options, and Statistics. All but the Statistics
tab correspond to pages in the wizard and display the options you configured when
setting up your library in MS. Each of the tabs is discussed in the following sections.

The General Tab
The General tab provides identifying information for the library. This tab is not
editable. If you need to change this information, use the Modify shortcut menu
command. For further instructions, see Modifying a Library on page 139.

Figure 145: Library Properties General Tab
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Table 21: Library Properties: General Tab Information

ITEM: DESCRIPTION:

Device Name The name of the SCSI or serial interface to which the device
is connected.

Interface Type The type of interface the device uses to communicate with the
MS machine.

Description The device description from the device inquiry string
specified by the manufacturer.

Status Whether the library is online or offline.

Name The name assigned to this Library.

Library names are used only for user interface purposes. They
do not affect the internal workings of the system and can be
any alphanumeric string desired, up to 32 characters. The
name that appears is the name given to the library when it was
added to the MS system.

File Systems The file systems selected when the library was added to MS.

Auto Set Online This option indicates whether the device is set online when
MS is started. Yes means the option is enabled. No means that
it is disabled.

The Auto Clean Tab
The Auto Clean tab allows you to change whether or not you want MEDIASTOR to
automatically clean the library drives, configure how often the drives should be
cleaned and change where in the library the cleaning cartridge is stored.

Figure 146: Library Properties Auto Clean Tab
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The Options Tab
The Options tab contains two option settings: media dismount timeout and number
of shelves to use for inventory of the library. Each option is described in the
following sections.

Figure 147: Drive Options Tab: Idle Drive Dismount

Idle drive dismount seconds:
Dismount media after __ seconds of inactivity: select this option to allow the
library to dismount media from a drive after the specified number of seconds has
passed without a read or write request for that media. The default is 60 seconds.

Do not automatically dismount the media: select this option to leave media in a
drive regardless of how long the media has been inactive. Media will be dismounted
when another piece of media must be mounted in the drive for a read or write
request.
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Figure 148: Drive Options Tab: Maximum Shelves For Inventory

Maximum shelves to use for inventory:
Use all shelves in this library: select this option to use all of the library shelves to
hold media for the media service. This is the default.

Use only the first __ shelves: select this option to only use a select number of
shelves (consecutively starting with the first shelf) to hold media for the media
service.

If you select the Use only the first __ shelves option, only shelves up to and
including the designated shelf will be used (allows you to partially utilize a library
with a damaged shelf or to use only a specified number of shelves in a large library).
This feature can be used to prevent automatic inventory of a large number of shelves,
which can take a long time.
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The Statistics Tab
When you select a drive in the Drives list and click the Statistics tab, the mount
information and Drive I/O totals for that drive are shown.

Figure 149: Library Properties Statistics Tab

MANAGING MEDIA IN A LIBRARY
When adding media to a library, certain hardware issues must be addressed. The
specific library being used dictates the procedures for adding the media. Some
libraries require that the device be taken offline before inserting media, while other
devices allow media insertion when online.

Library procedures differ by model. For example, some libraries have a mailslot into
which media is placed before it is put on a shelf or mounted in a drive. Some
libraries use magazines that hold several pieces of media, so that when a magazine is
removed, multiple pieces of media are removed as well. Libraries using magazines
must be taken offline before ejecting the magazine. Once the magazine has been re-
inserted, the library can be placed online and inventoried. Always be sure to
inventory those shelves where the media status has changed, even if you’ve switched
media on two different shelves.

Setting a Library Offline
If a library is experiencing hardware problems or needs to be opened for
maintenance or troubleshooting, it should first be taken offline. Once the problem is
corrected, the library may then be placed back online.
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To set a library offline:
1 Right-click the library in the Hardware tree. If the library is online, the Set

Offline option is active in the shortcut menu.

2 Select Set Offline from the shortcut menu. A verification message appears.

Figure 150: Set Offline Verification message

3 Click Yes to set the device offline, or No to abort the procedure.

Setting a Library Online
A library must be online in order for MS to perform media functions in that library.
If the library is offline, then all drives are inactive, and programs cannot write to or
read from the media. You can, however, view shelf position and label information
for offline media in a library. For instructions, see Managing Media in a Library on
page 153.

To set a library online:
1 Right-click the library in the Hardware tree. If the library is offline, the Set

Online option is active in the shortcut menu

2 Select the Set Online option from the shortcut menu. The Set Library Online
dialog box appears, which allows you to select an inventory option for the
library. For more details, see Library Inventory below.

3 Select the appropriate Shelf Inventory option and the enable or disable the
Hardware Inventory option.

4 Click OK. The library is inventoried (if applicable) and set online.

NOTE����
Media will not be mounted to a library drive that is offline. This is helpful for
troubleshooting, repair, and maintenance of library drives without deleting the
library from MS. Never service any device while it is online, including offline drives
which reside in an online library.

Library Inventory
When you select the Set Online option in a library shortcut menu, the Set Library
Online dialog box appears. The Set Library Online dialog box allows you to select an
Inventory option for the library you are setting online. Those options are described in
the following sections.
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Figure 151: Set Library Online Dialog Box

Shelf Inventory
Three option buttons are available for setting the shelves to be inventoried when
setting the library online. These options include:

Table 22: Set Library Online Dialog Box: Shelf Inventory Options

OPTION: RESULT:

Do not inventory any
shelves

Sets the library online without inventorying shelves (the
latest shelf inventory is assumed to be accurate).

Inventory specified
shelves

Inventories only the shelves listed in the Shelves text
box. Enter the number of each shelf to be inventoried.
To inventory a certain range of shelves, specify the first
and last shelf numbers from lowest to highest. You can
also specify individual shelves by listing the shelf
numbers separated by commas.

Inventory all shelves
in this library

Inventories every shelf in the library. Note that an
inventory of the entire library may take a long time.

NOTE����
If a library is configured not to be set online automatically on startup, the first time
the library is set online, all shelves are inventoried.
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NOTE����
MS stores which shelves contain media and the applicable media labels in the
Windows Registry. When a library inventory is performed, MS checks each shelf for
changes in the status of the shelves or the media. For shelves selected for inventory,
MS mounts the media and reads the labels.

Hardware Inventory
A Hardware Inventory option is also available to force a reset of the Hardware
Media Inventory. Select the Hardware Inventory check box to direct the library to
perform a full inventory of all shelves, full and empty, upon setting the library
online.

NOTE����
Hardware reset may take a long time. It should only be done when media has been
manually inserted, removed, or moved while the library was offline or powered off.
This should not be done every time a library is set online.

Managing Media in a Library
Quick access to all aspects of library media management is available through the
Manage Media feature. Depending on the limitations of the library, you may be able
to insert, move, and eject media using this dialog box. You can also monitor media
status.

To access media management for a library:
� Right-click on the name of the library in the Hardware tree and select Manage

Media from the shortcut menu.

Figure 152: Library shortcut menu

The Manage Library Media dialog box appears.
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Figure 153: Manage Library Media dialog box

The Manage Library Media dialog box lists the library drives and shelves, along with
what media is located on each shelf and the status of the media. Each piece of media
is listed with an icon that represents the media type.

Media types are listed in the following table:

Table 23: Media Types and Icons

ICON: TYPE:

CD-ROM Media

WORM Media

Erasable Optical Media

 DVD-RAM Media

Tape Media
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The following table defines the meaning of each status term:

Table 24: Status Indications

STATUS: MEANING:

Online Media is in device.

Error An error occurred while reading media.

Format Pending Media is scheduled to be formatted.

Format In Progress Media is being formatted.

Format Failed Media format was unsuccessful.

Label Pending Media is scheduled to be labeled.

Label in Progress Media is being labeled.

Label Failed Media label was unsuccessful.

Restore Pending Media is scheduled to be added to an extended drive,
and the files on the media restored to the drive.

Restore in Progress Media is being added to the extended drive.

Restore Failed Media restore was unsuccessful.

Prefetch Pending Media is scheduled for prefetch.

Prefetch in Progress Media is being prefetched.

Prefetch Failed Media prefetch failed.

Compact Pending Media is scheduled for compaction.

Compact in Progress Media is being compacted.

Compact Failed Media compaction failed.

Library Inventory
Pending

Library requires inventory of shelves.

Library Inventory in
Progress

Library is being inventoried.

Library Inventory Failed Library inventory was unsuccessful.

Mount/Dismount Media is being moved from shelf to drive or drive to
shelf.

Unassigned Media has not been added to extended drive and is
currently in a library or drive.

Unlabeled Media has not been labeled but contains a valid
format.

Foreign An unrecognized format is present, such as
NTFS/FAT in an OTG system, or vice versa.

Unformatted Media does not contain a recognized format.
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STATUS: MEANING:

Library Inventory
Unknown

An error has occurred; the shelf should be re-
inventoried.

Copy Media is a copy of an original piece of media.

Offline Media is not in a library or drive.

Duplicate Media is a duplicate (identical name and serial
number).

Unknown Media type is unknown.

The Managing Library Media dialog box also contains four buttons: Insert, Eject,
Move and Close. Clicking Close will close the dialog box. The Insert, Eject, and
Move functions are discussed in detail in the following sections.

NOTE����
Some options may not be available, as when the library does not support certain
commands, or has no mailslot. In those cases, the appropriate buttons are disabled.

Inserting Media
Some library models have individual procedures for inserting media, such as opening
up a door to place media into the shelves. This type of model also requires the library
be taken offline while media is inserted, and then set online and inventoried once the
media is in place. For information about inserting media into your library, refer to
the individual library documentation.

If supported by the library, the Insert Library Media function is available through the
Manage Library Media dialog box.

To insert media into a library:
1 Click the Insert button in the Manage Library Media dialog box. The Insert

Library Media dialog box appears.

Figure 154: Insert Library Media dialog box
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2 There are two options for inserting media:

� To insert media to specific shelves, enable Insert media to specified shelves
and enter the numbers of the appropriate shelves in the Shelves text box.

� To automatically insert media to available shelves, enable Insert media to
first available shelves and specify the quantity of media inserted.

NOTE����
If specific shelves are selected in the Manage Library Media dialog box at the
time you click Insert, MS will automatically enable the Insert media to specified
shelves option and enter those shelf numbers in the Shelves text box

3 Click OK. The media is inserted onto the shelves as configured. The status of
the shelf reads “Inventory Pending” until the media is mounted.

NOTE����
If the library in use has no mailslot, special considerations apply. The library must be
set offline before you manually place media in the shelf or magazine location. Once
the desired media is inserted, the library must be set back online, and MS will
prompt you to inventory the library.

Moving Media
From the Manage Library Media dialog box you can move a piece of media from
one library shelf to another. The Move feature allows you to optimize system
performance by keeping the most frequently used pieces of media closest to the
library drives. It also allows you to group media for organization purposes, such as
each department in the workplace.

To move media in a library:
1 Click the Move button in the Manage Library Media dialog box. The Move

Library Media dialog box appears.

Figure 155: Move Library Media dialog box

2 In the Move Media On Specified Shelves text box, enter the number(s) of the
shelf/shelves where the media to be moved is currently located.
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3 In the To Empty Shelves Starting At Shelf text box, enter the number of the
shelf where MS should start to place media. MS will begin to move the media to
that shelf and continue to place media on each available shelf in sequence until
all moved media is remounted.

NOTE����
If specific shelves are selected in the Manage Library Media dialog box at the
time you click Move, MS will automatically enter those shelf numbers in the
Move Media On Specified Shelves text box.

4 Click OK. The specified media is moved.

Ejecting Media
From the Manage Media dialog box, you can eject a piece of MS media from the
library. You can choose to eject a specific piece of media, or some quantity of the
least frequently used media. MS continues to track ejected media and prompts you to
reinsert the media when read and write requests are received.

Ejecting media from a library:
1 Click the Eject button in the Manage Library Media dialog box. The Eject

Library Media dialog box appears.

Figure 156: Eject Library Media dialog box

2 There are two options for ejecting media:

� To eject media on specific shelves, enable Eject media from specified
shelves and enter the numbers of the desired shelves in the Shelves text box.

� To eject media the least frequently used pieces of media, enable Eject least-
used media and specify the quantity of media to be ejected.

NOTE����
If specific shelves are selected in the Manage Library Media dialog box at the time
you click Eject, MS will automatically enable the Eject media from specified shelves
option and automatically enter those shelf numbers in the Shelves text box.

3 Click OK. The specified media is ejected.
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NOTE����
If the library in use has no mailslot, special considerations apply. The library must be
set offline before you manually remove media from the shelf or magazine location.
Once the media is removed, the library must be set back online, and MS will prompt
you to inventory the library.

MANAGING TOWERS

A tower is a group of standalone (non-library) drives in which you manually mount
and dismount media during runtime. You can manage the drives in each tower, set
them online or offline, or manage media in them through the Administrator module.
From the shortcut menu on each tower’s node in the Hardware tree, you can add,
modify, and delete towers and their drives.

ADDING A TOWER
Any drive currently listed in the Windows Registry can be added to the MS tower
configuration.

NOTE����
The Windows Registry contains an inventory of all SCSI devices connected,
powered on, and responding upon startup. For a list of devices supported by MS,
open the Supported Device list from the MS submenu of the Start menu.

Adding a Tower with the Hardware Wizard
To add a new Tower:
1 Right-click on the Hardware node. Click New from the shortcut menu to start

the Hardware Wizard.

Figure 157: Hardware shortcut menu

2 The Add New Hardware Device page appears.
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Figure 158: Add New Hardware Device page

3 Select the Tower option and click Next. The Configuration page appears.

Configuring a Tower
The tower Configuration dialog box allows you to create a device name and select a
media type for the tower. You can also enable or disable automatic initialization of
the tower on MS startup on this page.

Figure 159: Configuration dialog box
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Configuration options are described in the following table:

Table 25: Configuration Page Options

OPTION: DESCRIPTION

Name The name you assign to this Tower.

Tower names are used only for user interface purposes. They
do not affect the internal workings of the system and can be
any alphanumeric string desired, up to 32 characters.

Type The media type to be used by the tower. This determines the
File System to be used for the Tower. OTG and Windows
Native file systems cannot be mixed in a tower.

MS detects the type of tower and enters that type by default. If
only one type of media can be used with the tower being
added, only that option appears.

Automatically
set this device
online when the
service starts.

If enabled (checked), the tower is automatically set online
when MS is started. If disabled (not checked) the tower will
have to be set online manually. At least one drive must be
configured to set online when the tower sets online. The tower
cannot set online without any drives.

This setting is enabled by default; however, a tower may be
disabled when a hardware problem occurs (as opposed to
removing the tower from the configuration). If this check box
is not selected, MS will not automatically set the tower online
during system startup.

To continue adding a Tower to MS
1 Enter a Name for the Tower. Tower names are used only for user interface

purposes and can be any alphanumeric string, up to 32 characters.

2 Select the Type of media for the Tower. This will determine what File System
will be used for the media in the tower.

3 Select whether to Automatically set the device online when the service starts.
This option is checked by default. To disable the option, clear the checkbox.

4 When all options are configured correctly, click Next. The Drives page appears.

Adding Tower Drives
When the Drives page initially appears, no drives are listed. Tower drives must be
added manually.
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Figure 160: Tower Drives page

To add drives to a tower:
1 Click the Add button on the Drives page. The Select new Tower Drive(s) dialog

box appears. This dialog box lists all drives currently listed in the Windows
Registry, including standalone drives.

Figure 161: Select New Tower Drive(s) dialog box

2 Highlight the drives to be added from the list and click OK. The Drives page
reappears listing the drives that have been added.
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NOTE����
More than one drive can be selected at a time. To select two or more in sequence,
click on the first drive, then press and hold the <SHIFT> key while clicking the last
drive in the group. To select two or more out of sequence, press and hold the <CTRL>
key while clicking on each drive.

For each drive added, the Tower Drives page shows the SCSI Device Name along
with the File System being used for the drive.

Figure 162: Tower Drives page

3 Make sure the tower drives are listed in the same order that they exist in the
tower. To change the order of a drive, select the drive and then use the Up and
Down arrows to the right of the Tower Drives list to promote or demote the
drive’s position in the list.

4 Check the initialization settings for each drive. You can configure MS to set
particular drives online when the tower is set online. Select a drive name in the
Drives list and enable or disable the Set drive online when tower is set online
option. All drives are set online by default.

NOTE����
At least one drive must be configured to set online when the tower sets online. The
tower cannot be set online without any online drives.
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Completing the Wizard Process
� After drives have been added and configured, click Finish to add the tower to

the hardware configuration. The tower appears in the Hardware tree.

NOTE����
Adding some devices will cause MS to prompt you to reboot.

MODIFYING A TOWER
Once a tower has been added to the hardware configuration, it appears in the Tower
Tree. A tower’s configuration can be modified at any time, if necessary. Modifying a
Tower takes you back through the wizard used to add the tower to your MEDIASTOR
configuration. You may edit each option if appropriate.

NOTE����
The tower must be set offline before any modifications can be made.

To modify a tower:
1 Right-click the tower to be modified from the Tower tree.

2 Select Modify from the shortcut menu. A verification message appears.

3 Click Yes to verify modification. The Configuration page appears.
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Changing Tower Configuration
The Configuration page allows you to make necessary changes to the tower
configuration, including the name and whether to automatically set the tower online
when MS starts.

Figure 163: Tower Configuration page

To change a tower configuration:
� Make any necessary changes to the tower name and tower activation setting and

click Next to proceed to the Drives page.
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Changing Drive Settings
The Drives page allows you to change the file system or drive activation setting for
each tower drive.

Figure 164: Tower Drives page

To change tower drive settings:
1 Click on the drive you want to modify. At this point you can do the following:

� Select a different file system (if available) from the File System Drop down
box.

� Enable or disable the Set drive online when tower is set online option.

� Click Delete to delete the selected drive.
You may also add another drive using this window. For instructions, see Adding
Tower Drives on page 161.

2 Click Finish to save changes and exit the window. Click Cancel to exit without
saving changes. Click Back to return to the Configuration page.

NOTE����
You may be required to reboot to allow changes to be made to your SCSI
configuration.

DELETING A TOWER
A tower can be deleted from the MS hardware configuration at any time. Once a
tower is deleted, it is permanently removed from configuration. In order to use this
tower again, it must be added through the Add Hardware wizard. Care should be
taken when deleting a tower, as it may be more useful to set the tower offline if the
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tower is to be used again. This is helpful if a problem occurs with the tower and it is
necessary to remove it only temporarily from the configuration.

To delete a tower from MS:
1 Right-click the tower to be deleted in the Tower tree. The shortcut menu

appears.

Figure 165: Tower shortcut menu

2 Select Delete from the shortcut menu.

3 When prompted, click Yes to confirm the deletion or No to abort. Clicking Yes
removes the tower from the Tower Tree.

Figure 166: Delete Tower confirmation message

NOTE����
If an OTG file system was used on the device, you must reboot to allow Windows
drivers to reclaim the device for use within Windows. Additionally, drive letters may
not be reassigned to devices using Windows file systems until after reboot.

TOWER PROPERTIES
The Properties option allows you to view certain properties of an MS tower. This
dialog box contains one tab of tower information, the General tab.

NOTE����
Properties can also be viewed for individual drives within the tower. Drive properties
for tower drives include the General tab, with general drive information, and the
Statistics tab. For details on these tabs, see Standalone Drive Properties on page 175.
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To view tower properties:
� Right-click the desired tower and select Properties from the shortcut menu. The

Tower Properties dialog box appears.

Figure 167: Tower Properties General Tab

The information provided is described in the following table:

Table 26: Tower Properties Dialog Box Items

ITEM: DESCRIPTION:

Tower Type Indicates what type of media the tower uses.

Status Indicates whether the tower is online or offline.

Name The name assigned to this Tower.

Tower names are used only for user interface purposes. They
do not affect the internal workings of the system and can be
any alphanumeric string desired, up to 32 characters. The
name that appears is the name given to the tower when it was
added to the MS system.

Drive Count Indicates the number of drives contained in the tower.

Auto Set Online Indicates whether the device is automatically set online when
MS starts. Yes means the option is enabled, No means it is
disabled.

MANAGING MEDIA IN A TOWER
When a tower is set online, MS inventories the media inserted to determine if it
recognizes the file format. If the media has never been formatted, or if it has been
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formatted for a file system other than the one configured for the drive, MS identifies
the media as ‘foreign.’

Setting a Tower Offline
If a tower is experiencing hardware problems or needs to be opened for maintenance
or troubleshooting, it should first be taken offline. Once the problem is corrected, the
tower may then be placed back online.

To set a tower offline:
1 Right-click the tower in the Hardware tree. If the tower is online, the Set Offline

option is active in the shortcut menu.

2 Click Set Offline in the shortcut menu. A verification message appears.

3 Click Yes to set the tower offline or No to abort the procedure.

NOTE����
As some tower drives support automatic eject (for example, HP), and some do not
(for example, Ricoh), MS does not automatically eject media when set offline. Media
must be ejected using the front panel of the drive.

Setting a Tower Online
A tower must be online for MS to perform media functions using drives in that
tower. If the tower drives are offline, they are inactive and you cannot view media
statistics, or write to or read from the media.

To set a tower online:
1 Right-click the tower in the Hardware tree. If the tower is offline, the Set Online

option is active in the shortcut menu.

2 Click Set Online in the shortcut menu. A verification message appears.

3 Click Yes to set the tower online or No to abort the procedure.

MANAGING STANDALONE DRIVES

Standalone drives can be useful as alternate devices, especially in the case of library
malfunction.

You can add standalone drives to MS from the Standalone Drive node of the
Hardware tree. Once a drive has been added, you can set the drive online or offline,
modify, delete, or view drive properties.
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ADDING A STANDALONE DRIVE
Standalone drives are non-library drives in which you manually mount and dismount
media during runtime. Any supported standalone drive currently listed in the
Windows Registry can be added to the MEDIASTOR hardware configuration.

NOTE����
The Windows Registry contains an inventory of all SCSI devices connected,
powered on, and responding upon startup. For a list of devices supported by MS,
open the Supported Device list from the MS submenu of the Start menu. You can
also open SCSI Manager to see if the configuration file is loaded for the device. If it
is, you can configure the device in MEDIASTOR.

Adding a Standalone Drive with the Hardware Wizard
To add a new standalone device:
1 Right-click on the Hardware node. Select New from the shortcut menu to start

the Hardware Wizard.

Figure 168: Hardware shortcut menu

The Add New Hardware Device Page appears.

Figure 169: Add New Hardware Device page

2 Select the Standalone drive option and click the Next button. The Select New
Drive page appears.
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Adding a Standalone Drive
The Standalone Drive page lists of all the standalone drives currently listed in the
Windows Registry that have not yet been added to MS.

Figure 170: Select New Drives page

To add a standalone drive:
� Highlight the standalone drive you want to add and click Next. The

Configuration Page appears.
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Configuring the Standalone Drive
The Configuration page provides information on the device being added, and allows
you to configure a device name and file system for the device. You can enable or
disable automatic initialization on MS startup in this page as well.

Figure 171: Standalone Drive Configuration page

Configuration options are described in the following table:

Table 27: Configuration Page Options

OPTION: DESCRIPTION:

Drive Name The Name you assign to this standalone drive.

Drive names are used only for user interface purposes. They
do not affect the internal workings of the system and can be
any alphanumeric string desired, up to 32 characters.

File System The file system selected to be used by this drive.

Set this device
online when the
service starts

If enabled (checked) the drive is automatically set online when
MS is started. If disabled (not checked) the drive will have to
be set online manually.

This setting is checked by default, however a drive may be
disabled when a hardware problem occurs (as opposed to
removing the drive from the configuration). If this check box
is not selected, the drive will not be started during system
startup.
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To configure the Standalone Drive:
1 Enter a Name for the drive. Drive names are used only for user interface

purposes and can be any alphanumeric string, up to 32 characters.

2 Select the File System for the drive from the drop-down list.

3 Select whether to set this device online when the service starts. This setting is
checked by default. To disable the option, clear the checkbox.

4 When all options are configured correctly, click Next. The Options page
appears.

Completing the Standalone Drive wizard
Once your standalone drive options are configured, click Finish to add the drive to
MS. Click Cancel to exit the wizard without adding the drive. Click Back to return to
the Configuration page.

NOTE����
You may be required to reboot to allow changes to be made to your SCSI
configuration.

MODIFYING A STANDALONE DRIVE
Once a standalone drive has been added to the MS hardware configuration, it appears
in the Standalone Drive tree. A drive can be modified at any time if necessary. You
can modify the name and file system.

NOTE����
The drive must be set offline before any modifications can be made.

To modify a standalone drive:
1 Right-click the drive to be modified in the Standalone Drive tree and select

Modify from the shortcut menu.

2 Click Yes to verify modification. The Configuration page appears.



Chapter Five: Managing Hardware

174 MEDIASTOR System Guide

Changing Standalone Drive Configuration
The Configuration page displays device information about the standalone drive and
allows you to make necessary changes including the name, file system and whether
to automatically set the drive online when MS starts.

Figure 172: Standalone Drive Configuration page

Once you have made the necessary changes, click Finish to save your changes.

NOTE����
You may be required to reboot to allow changes to be made to your SCSI
configuration.

DELETING A STANDALONE DRIVE
A standalone drive can be deleted from the MS hardware configuration at any time.
Once a drive is deleted, it is permanently removed from configuration. In order to
use this drive again, it must be added through the Add Hardware wizard. Care should
be taken when deleting a drive, as it may be more useful to set the drive offline if it
is to be used again. Setting a drive offline is helpful if a problem occurs with the
drive and it is necessary to remove it temporarily from the configuration.

NOTE����
A standalone drive must be set offline before it can be deleted.

To delete a standalone drive:
1 Right-click the drive to be deleted in the Standalone Drive tree

2 Select Delete from the shortcut menu.
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Figure 173: Standalone drive shortcut menu

3 When prompted, click Yes to confirm deletion or No to abort. Clicking Yes
removes the standalone drive from the Standalone tree.

Figure 174: Delete confirmation message

NOTE����
You may be required to reboot to allow changes to be made to your SCSI
configuration.

STANDALONE DRIVE PROPERTIES
The Properties option allows you to monitor an MS standalone drive. This window
contains either two or three tabs of drive information.

To view the drive properties:
� Right-click the selected standalone drive and choose Properties.

The Drive Properties window appears. The Drive Properties window consists of
the following tabs: General and Statistics. In addition, when media has been
added to the drive, there is a Media tab.
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General Tab
The General tab provides general information about the standalone device and the
configuration.

Figure 175: Standalone drive Properties: General tab

Table 28: Drive Properties Dialog Box: General Tab Items

ITEM: DESCRIPTION:

Device Name Name of the interface to which the device is connected.

Description The device description derived from the inquiry string for the
device provided by the hardware manufacturer and referenced
in the Windows NT/2000 registry.

Device Type The type of media used by the device in which the drive is
contained.

Drive Type The type of media the drive uses.

Status Whether the drive is online or offline.

Name The Name assigned to this Drive

Drive names are used only for user interface purposes. They
do not affect the internal workings of the system and can be
any alphanumeric string desired, up to 32 characters. The
name that appears is the name given to the drive when it was
added to the MS system.

File Systems The file system selected when the drive was added to MS.

Auto Set Online Whether or not the device is set online when MS starts. Yes
means the option is enabled; No means it is disabled.
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Media Tab
The Media tab provides general information about media currently in the drive. This
tab appears only when there is media in the drive and the drive is online.

Figure 176: Standalone drive Properties: Media tab

Table 29: Drive Properties Dialog Box: Media Tab Items

ITEM: DESCRIPTION:

Name The name of the piece of media, taken from the volume label
on the media.

Serial Number The serial number for the piece of media.

Label Time The date and time the media was labeled.

Size The amount of data on the media.

Status The current status of the media.

Class The media classification being used to track the function of
the media (such as original or copy).

Type The type of media in the drive.

File System The file system for the media.

View All Media
Properties

Click this button to view the Media Properties for the media in
the drive. The Properties dialog box that appears contains four
tabs that provide more detailed information about the media,
including space and location of the media.
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Statistics Tab
The Statistics tab provides statistics on drive usage. To clear collected statistics and
restart the statistics collection process, click the Clear Statistics button.

Figure 177: Standalone drive Properties: Statistics tab

Table 30: Drive Properties Dialog Box: Statistics Tab Items

ITEM: DESCRIPTION:

Mount Count The number of times media has been mounted in the drive.

Flip Count The number of times media in the drive has been flipped.

Read File Count The number of files read from media in the drive.

Read Byte Count The total number of bytes of files read from media in the
drive.

Write Byte Count The total number of bytes of files written to media in the
drive.

Write File Count The number of files written to media in the drive.

Media Errors The total number of errors that have occurred relating to
media in the drive.

Hardware Errors The total number of errors that have occurred relating to the
drive hardware.

MANAGING MEDIA IN A STANDALONE DRIVE
Standalone drives always require the drive be taken offline while media is
ejected/inserted. Once inserted, place the drive online to read the media.
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When a drive is set online, MS inventories the media inserted to determine if it
recognizes the file format. If the media is unsupported by MS or has been formatted
for a file system other than the one configured for the drive, MS will identify the
media as ‘foreign.’

NOTE����
As some standalone drives support automatic eject (for example, HP), and some do
not (for example, Ricoh), MS does not automatically eject media when set offline.
Media must be ejected using the front panel of the drive.

Setting a Standalone Drive Offline
If a device is experiencing hardware problems or needs to be opened for maintenance
or troubleshooting reasons, it should first be taken offline. Once the problem is
corrected, the device may then be placed back online. Once a drive is offline, it is
inactive and you cannot view media statistics or write to or read from the media

To set a standalone drive offline:
1 Right-click the drive in the Hardware tree. If the drive is online, the Set Offline

option is active in the shortcut menu.

2 Click Set Offline in the shortcut menu. A verification message appears.

3 Click Yes to set the drive offline or No to abort the procedure.

Setting a Standalone Drive Online
A drive must be online in order for MS to perform media functions using that drive.

To set a standalone drive online:
1 Right-click the drive in the Hardware tree. If the drive is offline, the Set Online

option is active in the shortcut menu.

2 Click Set Online in the shortcut menu. A verification message appears.

3 Click Yes to set the drive online or No to abort the procedure.
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MANAGING MEDIASTOR MEDIA

By adding media to the MEDIASTOR hardware devices, you create a supply of
storage media that you can allocate for use by connected applications like
DISKXTENDER. Media are listed in the MEDIASTOR system as soon as they are
inserted in the device and inventoried.

Media that have been added to the system but are not yet in use by an application
appear under the Scratch Pool media tree. Media that have been allocated to an
application can be found under the specific application node of the Application Pool
media tree.

When a piece of media is initially added to a media device, the system evaluates the
media. After MS scans the media, it is then placed in one of the seven nodes in the
media tree, depending attributes like whether the media is formatted, labeled, or
contains a recognized file system. Once media attributes are determined, the media is
added to the appropriate media type node.

Although unassigned (Scratch Pool) media are listed in a separate place from
assigned (Application Pool) media, the media management functionality is common
to all MS media.

This chapter deals primarily with accessing information about the media and how to
move the media between the Application and Scratch Pools.

MEDIA FUNCTIONS

When a piece of media is highlighted in the tree view or in the contents view of the
Administrator window, the Edit menu contains commands specific to the
management of media in the media pool. The commands available for media in the
Edit menu are the same commands that appear in the shortcut menu when you right-
click a piece of media in the tree view or the contents view.
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Shortcut and Edit menu commands allow you move media between the Scratch Pool
and Application Pools, to view properties for the media, and to delete the media from
MEDIASTOR.

What menu commands are available to media is partially determined by the current
status of the media selected. For example, media in the Scratch Pool will logically
have the Allocate Media to Application Pool command available but the Move
Media to Scratch Pool command will be grayed out. Any media with the status of
“online” will not have the Delete command available. Only offline media can be
deleted.

MEDIA STATUS
You can configure the media items in the tree view of the MS Administrator to
change color depending on their status. The following table lists each color and
describes the status indicated by each color:

Table 31: Media Status Indicated by Color

MEDIA COLOR: MEDIA STATUS:

Red Error

Yellow Offline

Green Online and running a task

Black Online, but not running a task

To configure the tree view to indicate media status by color:
� From the View menu, select Enable Color. A checkmark next to the Color

option signifies that the option has been enabled. If this option is disabled, all
media items are black, regardless of status.

ACCESSING THE MEDIA SHORTCUT MENU
For any piece of media, the shortcut menu allows you access to the media
allocation/removal, delete and properties commands. The Shortcut menu is accessed
by right-clicking a piece of media from the tree view or the contents view of the MS
Administrator.

The commands available for media are the same whether accessed through the
shortcut menu or through the Edit option on the main menu. Those commands are
discussed in detail in the following sections.

ALLOCATE MEDIA TO APPLICATION POOL
The Allocate Media to Application Pool command opens the Allocate Media to
Application Pools dialog box. This dialog box allows you to assign any media in the
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Scratch Pool to any specific Application Pool, regardless of which piece of Scratch
Pool media is highlighted when the command is selected.

To allocate media to application pools:
1 You have two choices:

� Highlight a piece of Scratch Pool media in the tree view or the contents
view and select the Allocate Media to Application Pool command from the
Edit menu.

� Right-click a piece of Scratch Pool media in the tree view or the contents
view and select the Allocate Media to Application Pool command from the
shortcut menu.

The Allocate Media to Application Pools dialog box appears.

Figure 178: Allocate Media to Application Pools Dialog Box

2 From the Application Media Pools drop down list, select the application pool to
which you want to allocate media.

Figure 179: Allocate Media to Application Pools Dialog Box
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3 Highlight the media you want to assign or allocate to that application pool. You
can use a standard Windows <Shift> or <Ctrl> technique to select multiple
pieces of media.

4 Click Allocate. The media pool selected appears to the right of the media in the
Media list.

Figure 180: Allocate Media to Application Pools Dialog Box

5 To assign media to multiple application pools (if applicable), repeat the steps 2-
4.

Figure 181: Allocate Media to Application Pools Dialog Box

6 If you allocate media to an application media pool incorrectly, highlight the
media and click Deallocate.

7 When finished, click OK. In the tree view, the selected media is moved to the
appropriate application pool(s).
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MOVE MEDIA TO SCRATCH POOL
The Move Media to Scratch Pool command automatically moves the selected piece
of media from the Application Pool back to the Scratch Pool. Be sure the media is
not in use or required by the application from which you are removing it.

To move media to the scratch pool:
1 You have two choices:

� Highlight a piece of Application Pool media in the tree view or the contents
view and select the Move Media to Scratch Pool command from the Edit
menu.

� Right-click a piece of Application Pool media in the tree view or the
contents view and select the Move Media to Scratch Pool command from
the shortcut menu.

2 A warning dialog box appears reminding you that once removed the media will
no longer be available to the application.

Figure 182: Move Media to Scratch Pool Warning Message

3 Click Yes to remove the media from the Application Pool and place it in the
Scratch Pool.

DELETE MEDIA
The Delete command allows you to remove media from the MEDIASTOR interface.
Once deleted you can remove the media from the media device. If you do not
remove the media from the hardware device, it will reappear in the media pool the
next time the device is inventoried (if the media is still present at that time).

The hardware device must be set offline before media in the device can be deleted.
In addition, only Scratch Pool media can be deleted from MEDIASTOR.
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To delete media from media pools:
1 Make sure the hardware device where the media is located is offline and that the

media you want to delete is not allocated to an Application Pool.

2 You have two options:

� Highlight a piece of Scratch Pool media in the tree view or the contents
view and select the Delete command from the Edit menu.

� Right-click a piece of Scratch Pool media in the tree view or the contents
view and select the Delete command from the shortcut menu.

3 A verification message appears. Click Yes to delete the media. The media is
removed from the Scratch Pool.

You may now remove the media from the hardware device and set it online.

NOTE ����
If you do not remove the deleted media from the hardware device, you can set the
device online without inventorying the media and the deleted media will not appear.
Deleted media still resident in the device will reappear in MS the next time the
device is inventoried.

MEDIA PROPERTIES

The Media Properties dialog box contains multiple tabs with information pertaining
to the selected piece of media. The tabs that may appear for a piece of media are as
follows:

� General

� Location

� Space

� Statistics

Accessing the Media Properties and what information is provided in each of the tabs
is described in the following sections.

OPENING MEDIA PROPERTIES
The Properties command is always available for every piece of media in the MS
system, regardless of the current use, assignment, or status of the media. The media
Properties window consists of up to four tabs, including: General, Space, Location,
and Statistics. What tabs appear depends on the type of media and its current status.
For example, the Statistics tab does not appear for Blank media.
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To open the media properties dialog box:
1 You have the following choices:

� Right-click the media and select Properties from the shortcut menu.

� Highlight the media and select Properties from the Edit menu.

� Highlight the media and press <F2>.
The Media Properties dialog box appears with the General tab active by default.

2 Activate a tab by clicking the tab title.

3 Make any necessary changes to the aspect of the Media Properties selected.

4 Once any changes have been made, you have the following choices:

� Click OK to save changes and close the dialog box.

� Click Apply to save changes to the active tab without closing the dialog
box.

� Click Cancel to discard all changes and close the dialog box.

The General Tab
The General Tab provides identifying information for the media. For all except
foreign media, you can use this tab to enter a brief Description, which is used for
media reports.

Figure 183: Media Properties: General Tab

The information found in the General tab is described in the following table:

Table 32: Media Properties Dialog Box: General Tab Items

ITEM: DESCRIPTION:

Name Name assigned to the media when labeled.

Serial Number Serial number of the media.
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ITEM: DESCRIPTION:

Label Time Date and time the media was labeled.

Status Current status of media. Status settings include:

� offline

� online

� compact pending/ in progress/ failed/ paused

� format pending/ In progress/ failed

� label pending/ In progress/ failed

� restore pending/ in progress/ failed

� file report pending/ In progress/ failed

� library inventory pending/ in progress/ failed/ unknown

Class There are seven valid classes to describe the media:

� original

� copy

� duplicate

� blank

� foreign

� unknown

� unformatted

Type The type of storage media:

� NAS

� CD-ROM

� DVD-RAM

� WORM

� Erasable Optical

� Tape
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ITEM: DESCRIPTION:

File System The media’s file system. There are 11 valid file systems:

� unknown

� otg optical (OSS)

� otg tape (TSS)

� iso 9660 joliet

� FAT

� NTFS

� iso 9660

� iso 9660 ms

� hsg

� hsg ms

� audio

� photocd

Description An editable field where you can enter a media description to be
used for media reports. The maximum number of characters
that can be entered into the Description edit box is 64.

NOTE ����
For Foreign media, the Information tab displays “N/A” for media name, serial
number, and label time. The Description field is unavailable for editing.

Media Serial Numbers
Because media can be taken from one MS system and imported or placed in another,
media name is not sufficient for tracking media. While not recommended, MS does
allow more than one piece of media with the same name. Therefore, MS must use the
serial number of media to track it and the files migrated to it.

MS can support more than one piece of media with the same name on an extended
drive, provided they have different serial numbers. If MS identifies two pieces of
media with the same serial number, it will classify one as Duplicate and require that
it be reformatted and given a new serial number before it can be used.
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Media serial numbers provide a way to track all MEDIASTOR media uniquely,
irrespective of the MS system in which they were formatted. The serial number is an
eight-byte integer, represented as a hexadecimal string in the following format:
“XXXXXXXXYYYYYYYY.” The serial number is broken down as described in
the following table:

Table 33: Serial Number Interpretation

POSITION: DESCRIPTION:

(XXXXXXXX) The serial number from the Windows system boot drive
(usually drive C:). Windows assigns this number when the
hard drive is formatted. This number is unique for all hard
disks.

(YYYYYYYY) The encoded date/time that the media was labeled, expressed
in seconds elapsed since Midnight, January 1, 1970.

The Location Tab
The Location tab provides information about the physical and logical location of the
media. You can also enter an offline location for the media, which is used for mount
requests and media reports.

Figure 184: Media Properties: Location Tab
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The information found in the Location tab is described in the following table:

Table 34: Media Properties Dialog Box: Location Tab Items

ITEM: DESCRIPTION:

Drive Specifies the drive in which the media is mounted.

Library Specifies the library in which the media is located, and its
location in the library (drive and/or shelf number).

Name Name of the media pool to which the media is assigned.

Application The name of the application using the media.

Offline Location Text field into which you can enter up to 32 characters to
describe the physical location where offline media are stored
(for example, Second Floor Storage Room, Shelf 25D). This
location is shown when a MEDIA NOT FOUND error
appears.

NOTE ����
For foreign media, the Location tab displays “N/A” for Folder and the Offline
Location field is unavailable for editing.

The Space Tab
The Space tab provides statistical information on the physical and logical capacity of
the media.

Figure 185: Media Properties: Space Tab
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The information found in the Space tab is described in the following table:

Table 35: Media Properties Dialog Box: Space Tab Items

ITEM: DESCRIPTION:

Bytes per Sector Number of bytes written to the media per sector
(determined by media).

Number of Sectors Total number of sectors on media.

Total Space Total media space, in bytes.

Sectors per
Cluster

Number of sectors per cluster.

Free Clusters Number of free clusters on the piece of media.

Used Clusters Number of used clusters on the piece of media.

Total Clusters Total number of clusters on the piece of media.

Free Space Free space in bytes on the piece of media.

Used Space Written space in bytes on the piece of media.

Total Space Total space in bytes on the piece of media.

NOTE ����
For foreign media, the Space tab displays “N/A” for all Logical Capacity
information.

The Statistics Tab
The Statistics tab provides statistics relating to media mounts, file input and output,
and media errors.
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Figure 186: Media Properties: Statistics Tab

The information found in the Statistics tab is described in the following table:

Table 36: Media Properties Dialog Box: Statistics Tab Items

ITEM: DESCRIPTION:

Mount Count Number of mounts per current session.

Last Mount Time Time the media was last mounted.

Read File Count Number of read requests during current session.

Read Byte Count Number of bytes of files read during current session.

Last Read Time Time the media was last read.

Write File Count Number of write requests during current session.

Write Byte Count Number of bytes of files written during current session.

Last Write Time Time the media was last written.

Media Errors Number of errors encountered per current session.

NOTE ����
The Statistics tab does not appear for foreign media.
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SCSI MANAGER

SCSI (Small Computer System Interface) is a hardware interface that allows for the
connection of up to seven peripheral devices, such as libraries, or optical and CD-
ROM drives, to a single SCSI board, called a SCSI host bus adapter. Thus, seven
different devices are using only one expansion slot in the computer.

SCSI Manager is a software utility that provides an interface for viewing SCSI
devices, as well as a tool for troubleshooting. Shipped with OTG MEDIASTOR (MS),
SCSI Manager offers such useful features as viewing SCSI device profiles and
status, browsing media data and performing SCSI commands to manipulate the
library. Through the SCSI Manager, you can see libraries and drives and view
inquiry strings, without going through MS. SCSI Manager also provides
configuration information that indicates whether or not the device is supported in the
current version of MEDIASTOR.

A working knowledge of SCSI, including SCSI commands and hardware
connectivity, is necessary to fully utilize SCSI Manager features. The greater your
SCSI knowledge, the more powerful this utility will be. For example, when you
contact technical support, SCSI Manager provides a common interface in which the
support representatives can guide you through troubleshooting hardware problems.
For information on SCSI commands, refer to the SCSI Command Reference guide
provided with the SCSI device (for example, library).

STARTING SCSI MANAGER

SCSI Manager is one of the utilities packaged with MS and can be accessed through
the Utilities folder in the OTG MEDIASTOR program group in the Windows Start
menu.
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To start SCSI Manager:
� Select the SCSI Manager option from the Utilities option in the OTG

MEDIASTOR program group accessed through the Windows Start menu. The
SCSI Manager window appears.

Figure 187: SCSI Manager With Device List

The SCSI Manager window contains a Device List dialog box, which lists all
SCSI devices connected to the computer.

INITIALIZING/SHUTTING DOWN SCSI MANAGER
SCSI Manager initializes automatically when started, and upon initialization, looks
for all SCSI devices and opens a Device List window.

SCSI Manager can be shutdown and re-initialized at any time. This allows SCSI
Manager to be running in a shutdown mode, so that SCSI devices can be seen and
used by other applications/services, such as Jukebox Manager or MS.

NOTE����
SCSI Manager cannot initialize if the MS service or Jukebox Manager is running.
Only one of these services can access devices at once.
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To initialize SCSI Manager:
� Select Initialize from the File menu. When SCSI Manager is initialized, a check

mark appears by the Initialize command in SCSI Manager’s File menu.

Figure 188: SCSI Manager File Menu

To shut down SCSI Manager:
� Select Shutdown from the File menu. A check mark now appears by the

Shutdown command in the menu. When SCSI Manager is shut down, all device
windows are closed.

EXITING SCSI MANAGER
Upon exit, SCSI Manager is automatically shut down. All devices can now be used
by other services, including MS.

To exit SCSI Manager:
� Select Exit from the File menu.

SCSI MANAGER INTERFACE

SCSI Manager is an easy-to-use tool that allows you quick and easy access to SCSI
devices. Using this menu-driven interface, you can view, test and control the SCSI
devices connected to the MS computer. You can determine the features associated
with each device, and isolate troubleshooting problems.
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DEVICE TYPES
When SCSI Manager is initialized, it seeks out all SCSI autochangers and drives
currently connected to the system. The following table lists the types of supported
devices:

Table 37: Supported Devices

DEVICE: DESCRIPTION:

CDROM Standalone CD-ROM drive

TAPE Standalone tape drive (tape media cannot be browsed)

DVD-RAM Standalone DVD drive

OPTICAL MEMORY Standalone optical drive

WORM MEMORY Standalone WORM drive

JUKEBOX Library, either optical, DVD-RAM, CD-ROM, WORM,
or tape

NOTE ����
Serial libraries are not accessible through SCSI Manager. Only SCSI devices will
appear. For information on accessing and controlling serial libraries, see Chapter
Eight: Jukebox Manager on page 227.

DEVICE LIST

When you first initialize SCSI Manager, a Device List dialog box appears listing all
of the SCSI devices connected to the system. The following table lists the
information that appears for each device:

Table 38: Device List Dialog Box Columns

COLUMN: DESCRIPTION:

Name The SCSI device address.

Description The device vendor and model.

Configuration Whether or not the device driver is loaded in our supported
device list. If the device driver is not loaded, you will not be
able to see the device when adding hardware to MS.

Driver This is the driver that has control of the device. If the device is
configured with Windows Native File System (NTFS), the
drivers listed are SCSIDISK, SCSICDRM, SCSITAPE, If the
device is configured with an OTG File system, SCSIALL is
listed as the driver.
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From the Device List dialog box, you can activate a device window, or view a profile
for a selected device.

When you close a device window or shut down SCSI manager, the Device List
dialog box also closes. It can be reopened from the System menu (when SCSI
Manager is initialized).

To open the device list dialog box:
1 Select Device List from the System menu. The Device List appears.

Figure 189: Device List Dialog Box

2 From this window you have three options:

� Highlight a device and click Profile to display a Device Profile for the
device highlighted in the list.

� Highlight a device and click Select to display a device window for the
device highlighted in the list (or double-click the device).

� Click Close to close the Device List window.

DEVICE PROFILE
The Device Profile lists pertinent information about the device (standalone drive or
library). Since all devices are different and have slightly different functionality, the
Device Profile is helpful for determining the SCSI ID, description and type of media
supported for the device, and particular functions of the drive or library. For
example, some libraries require that the library perform the media eject and some
require that the drive performs the media eject, with no intervention from the library.
The Device Profile tells you which features a specific device supports and therefore
whether those commands are applicable for the device.
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To view a device profile:
1 Highlight the appropriate device and click Profile. The Device Profile appears

with the SCSI address listed in the title bar.

Figure 190: Device Profile

2 Click OK to close the Device Profile.

DEVICE WINDOWS
Each device window is the interface to the specific SCSI device. Command status
and results are displayed in this window, providing a concise view of device events.

The device window is clear of all data until a command is performed. All commands
for a device must be performed while that device window is active. Any command
executed affects the active window.
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To activate a device window:
� In the Device List, highlight the device and click Select, or double-click the

device. The device window appears.

Figure 191: Device Window

Device windows display the device description (including SCSI ID) in the title bar,
so you can easily note which device is being displayed in the active window.

Figure 192: Device Window Title Bar

When a command is performed, it is listed in the upper part of the device window,
along with status and other statistics. These statistics give insight into the inner
workings of the SCSI command. The buttons at the right of the window become
active and inactive, depending upon the command performed. If an option is
available after a command is performed, the button is enabled for use. This chapter
describes each command and further options that can be performed.

SCSI CONCEPTS

Before using SCSI Manager, you should be familiar with certain areas and terms.
Following are some concepts that are important for use with SCSI Manager.
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HEX
Hex is short for hexadecimal, which means 16. This is a base 16 numbering system
used as shorthand for representing binary numbers. Each half byte (four bits) is
assigned a hex digit as listed in the following table:

Table 39: Decimal And Hexadecimal Represented As Binary

DECIMAL: HEXADECIMAL: BINARY:

0 0 0000

1 1 0001

2 2 0010

3 3 0011

4 4 0100

5 5 0101

6 6 0110

7 7 0111

8 8 1000

9 9 1001

10 A 1010

11 B 1011

12 C 1100

13 D 1101

14 E 1110

15 F 1111

In a hex number, each digit position has a value 16 times greater than the one to its
right. Two hex digits make up one byte; for example, A7 is equivalent to decimal
167 (10 X 16 + 7 X 1).

When commands are performed in SCSI Manager, the results appear in hex
numbers, which is why it is important to understand the hexadecimal numbering
scheme and how it relates to decimal and binary numbers.

CDB (COMMAND DESCRIPTOR BLOCK)
A SCSI command and its parameters are sent as a block several bytes long (6, 10 or
12 bytes) called the Command Descriptor Block (CDB). A CDB contains the
Operation Code, Logical Unit Number (LUN), block address, and transfer length
fields. The CDB is required for all SCSI Manager commands. For more detailed
information, refer to the SCSI specification and particular device manual.
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SENSE DATA
When a command is carried out, its status is reported on two levels: a brief status in
the Status field in the upper part of the device window, and a more detailed status in
Sense Data. The Status field reports information such as whether execution of a
command was successful or an error occurred, or other information such as “busy.”
This status does not give any detailed information.

If the status reads “Check Condition,” it means that some condition exists which
prevented successful completion of that command. It could be an error in the CDB, a
hardware problem, or some external problem. Issuing the Request Sense command
will give you detailed information on the condition, referred to as Sense Data. Sense
Data is a set of flags and indicators that are continuously updated to reflect the
current status. It is presented in a hierarchical manner, starting with general
conditions and proceeding to specific conditions, as follows:

1 SENSE-KEY

2 ADDITIONAL SENSE CODE (ASC)

3 ADDITIONAL SENSE CODE QUALIFIER (ASCQ)

The Sense Key defines the class of error or condition information. There are fifteen
Sense Keys, which classify the device condition as a hardware or software problem,
fatal or recoverable error, and so on. The ASC together with the ASCQ provide more
detailed information. For specific descriptions, refer to the SCSI specification and
particular device manual.

Example:
ERR 16:34 (00151) [DE_JUKE.c, 1828] DE: Jukebox error encountered on
DISMOUNT

Operation
00 00 00 ….DeviceName: SCSI2000

….ScsiCdb: a5 00 02 bc 01 f4 00 00 00
…
….BusStatus: 4h
….TargetStatus: 2h, CHECK CONDITION
….SenseData: 70 00 06 00 00 00 00 0a 00
…. 00 00 00 29 00 00 00 00 00
….SenseKey: 6h, UNIT ATTENTION
….AddSenseCode: 29h
….AddSenseQual: 0h
….ScsiError:  9824, SCSI_ERR_DEV_RESET
….JukeError:  9728, JUKE_ERR_DEV_RESET

ELEMENT
The term Element refers to components in a library. These include individual storage
slots, mailslots, optical, CD-ROM and tape drives, and picker mechanisms. Many
SCSI commands refer to this term, for example, Read Element Status and Position to
Element, which positions the transport element (picker) in front of another element
(for example, a drive).
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BUFFER
A buffer is a reserved segment of memory used to hold data while it is being
processed. In SCSI Manager, the buffer is contained and displayed in the bottom part
of the device window, and includes information about the specific SCSI device.
When commands are performed, the results are shown in the buffer area, at the
bottom portion of the dialog box. This buffer contains a scroll bar in order to view
complete results.

Buffer length refers to the amount of space allotted in the bottom display portion of
the device window. Each command using the buffer has a default buffer length, in
bytes. This number is usually adequate, but can be changed if necessary.

MEDIA BROWSING

The media contained in a device can be browsed, sector by sector, to view its
contents. Browsing is disabled by default, so that in order to browse media, you must
enable browsing in the device window.

NOTE ����
Media must be mounted and spun-up in the drive before you can enable browse for
the media.

Figure 193: Browsing Disabled
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To enable browsing:
� Click Enable Browse in the device window. The contents and active buttons in

the device window and available menu commands change to reflect that
browsing is enabled.

Figure 194: Browsing Enabled

NOTE����
When browsing is enabled, no other SCSI commands can be performed for the
device. For example, commands in the Drives and Jukebox menus are not available
while browsing is enabled.

Once you click Enable Browse, the window changes to display “Read Sector” in the
Command line, and SCSI Manager is ready to read the media. In addition, the Enable
Browse button changes to Disable Browse.

Browsing allows you to read sectors one-by-one or read specific sectors on the
media. In addition, you can search for occurrences of a data pattern on the media.

To move from sector to sector in order, click the forward or backward arrows, or
select Next Sector or Previous Sector from the Drive menu’s Browse command. You
can also search for a specific sector or group of sectors, or go directly to a specific
sector, which then places the specified sector’s data in the device window.

These functions and others available while browsing is enabled are outlined in the
following sections.

To disable browsing:
� Click Disable Browse. The device window changes to reflect that browsing has

been disabled and previously unavailable SCSI commands are now available in
the SCSI Manager menus.
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Searching Sectors
To search for a specified sector or group of sectors:
1 With browsing enabled, click Search in the device window, or select Search

from the Drive menu’s Browse option. The Search dialog box appears.

Figure 195: Search Dialog Box

2 Enter a starting sector number.

3 Enter a search direction: forward or backward.

4 Enter a search option: blank sector, written sector, ASCII pattern, or Hex
pattern. Enter the pattern if necessary.

5 Click OK to perform the search. The search results appear in the lower portion
of the device window.

Goto Sector
To go to a specific sector:
1 With browse enabled, click Goto in the device window, or select Goto Sector

from the Drive menu’s Browse option. The Goto Sector dialog box appears.

Figure 196: Goto Sector Dialog Box

2 Set the appropriate option: First sector, Last sector, or Other sector. If Other is
chosen, enter the sector number.

3 Click OK. The Sector information appears in the lower portion of the device
window.
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Speed Test
A Speed Test can be performed to determine the time required to read a specified
number of sectors on a piece of media.

1 With browsing enabled, select Speed Test from the Drive menu’s Browse
command. The Speed Test dialog box appears.

Figure 197: Speed Test Dialog Box

2 Enter the starting sector number and number of sectors to be read.

3 Click Default to change the information to the default settings, if necessary.

4 Click OK to start the speed test. After the test is performed, a message appears
stating the number of seconds required to read the specified number of sectors.

DATA FILES

You can create a data file that contains all of the data appearing in the buffer, which
is displayed in the lower part of the device window. This allows you to save
information at the time it appears. Data files saved with a .DAT extension can be
opened in SCSI Manager and appear in the lower part of the active device window.

WRITING DATA FILES
When creating a data file, you must decide between Binary and ASCII format.
Binary information is stored in a binary coded form, such as data, text, images,
voice, and video. One byte (8 bits) can hold values from 0 to 255. Two contiguous
bytes (16 bits) can hold values from 0 to 65,535.

An ASCII file contains data made up of ASCII characters. It is essentially raw text.
In ASCII format, each byte in the file contains one character that conforms to the
standard ASCII code. Program source code, DOS batch files, macros, and scripts are
written as straight text and stored as ASCII files. ASCII text files become a common
denominator between applications that do not import each other's formats. If both
applications can import and export ASCII files, files can be transferred between
them.
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NOTE����
You must enable browsing to write data files, because there must be data in the
buffer (lower part of the device window) to write to a file. Other data can be
accessed through an Inquiry, Read Sector command, Request Sense, Custom
command, Read Capacity, Receive Diagnostics, or Mode Sense.

To write a data file:
1 With browsing enabled, select Write Data File from the File menu. The Write

Data File dialog box appears.

Figure 198: Data File Format Dialog Box

2 Select a format option: Binary or ASCII.

3 Click OK. A dialog box appears allowing you to select a file location and file
extension for the data file. The default location is C:\WINNT\OTG
MEDIASTOR\BIN\. The default file extension is DAT.

Figure 199: Write Data File Dialog Box

4 Enter a File Name and click Save to save the file.

READING DATA FILES
Saved data files can be accessed through SCSI Manager, with the file data displayed
in the lower portion of the device window. Use the scroll bar on the right side if
necessary to view the entire file.
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NOTE ����
You must disable browsing to read data files, because the buffer (lower part of the
device window) must be empty in order to read the data file to the buffer.

To read a data file:
1 With browsing disabled, select Read Data File from the File menu. The Read

Data File dialog box appears.

Figure 200: Read Data File Dialog Box

2 Highlight the file to be opened and click Open (or double-click the file).

3 The data file information appears in the device window.

Figure 201: Device Window—Data File

DEVICE WINDOW COMMANDS

Certain functions are available through the device window when specific commands
are performed. These functions, represented by the buttons to the right of the device
window include Sense Structure, Sense Dump, and SCSI Request.
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Figure 88: Device Window

Sense Structure/Sense Dump
Clicking the Sense Structure or Sense Dump buttons after they become active in the
device window displays additional Sense data. Displaying Sense data can be useful
for troubleshooting problems with the device. The following figures show examples
of what data appears when these buttons are selected.

Figure 88: Sense Structure
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Figure 89: Sense Dump

Click OK in either dialog box to close it.

SCSI Request
SCSI Request is always available in the device window. Clicking the SCSI Request
button requests a current status of the SCSI device, and returns the device status in a
standard format with a Sense Code in byte 2 and Additional Sense Code (ASC) and
Additional Sense Code Qualifier (ASCQ) in bytes 12 and 13. (For information, see
SCSI Concepts on page 201.)

Figure 202: SCSI Request

Click OK to close this dialog box.

COMMON MENU COMMANDS

Some commands are not available through buttons in the device window. These
functions are accessed through the Common Menu in the SCSI Manager and are
performed on the device that corresponds with the open device window.

The Common menu in SCSI Manager contains commands commonly used for
communicating with SCSI devices.
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Figure 203: Common Menu Commands

COMMON MENU FUNCTIONS
This section lists each menu item and its functionality. Each of the procedures in the
following sections assumes you have the appropriate device window open for the
device on which you want to perform the command.

NOTE ����
Common menu commands can only be accessed when browsing is disabled.

Test Unit Ready
This command determines the ready state of a device. If the device is in a ready state
when it receives the command, it returns a status of “Ready.” If the device is not in a
ready state, the status is “Not Ready” or “Not Found.” A device is in a ready state
when all SCSI devices are connected properly and it operates without error. A drive
in a library is in a ready state when the media is loaded and spun up, and read or
write operations can complete successfully.

NOTE����
This is the first command that should be performed on a device. It is a basic method
for testing whether the device is functional.
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To test unit ready:
� Select Test Unit Ready from the Common menu. The command appears in the

device window and the device is tested.

Figure 204: Test Unit Ready

The results appear in the Status and Sense fields in the upper portion of the
device window.

Rezero Unit
Rezeroing is typically done on libraries. This command calibrates the device and
places it into an initialized state. Usually this command is performed automatically
when the device is powered on; however, certain devices do not perform this
command automatically. Failure of this command could indicate hardware
difficulties, like a jammed drive, making it potentially helpful as a diagnostic tool.

To rezero unit:
� Select Rezero Unit from the Common menu. The command appears in the

device window and the device is calibrated.

Figure 205: Rezero Unit
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The results appear in the Status and Sense fields in the upper portion of the
device window.

NOTE����
A drive can only be rezeroed when media is present in the drive.

Inquiry
This is an important command during diagnostic testing, especially if you are
unfamiliar with the hardware. It sends controller and drive information to the
initiator. The result is a display of what is commonly called the “inquiry string”,
which includes: the device manufacturer, product name, and firmware version.

To execute an inquiry:
1 Select Inquiry from the Common menu. The Inquiry Command dialog box

appears.

Figure 206: Inquiry Command Dialog Box

2 The Vital Product Data option is disabled by default. However, certain products
have additional page codes that can be used during inquiry that are unique to the
device. Select Yes to activate the Vital Product Data Page Code text box.

3 If activated, enter the page code, as specified in the device manual.

4 Enter a buffer length (or accept the default of 36). If a page code is entered, the
buffer length must be changed to accommodate more data. Clicking Reset
changes any altered information back to the default settings.

5 Click OK to complete the command. The results appear in the lower portion of
the device window.
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Figure 207: Device Window With Inquiry Data

6 The Data Structure button on the device window becomes active. Clicking Data
Structure displays an additional dialog box with further details. This information
is read-only.

Figure 208: Data Structure: Inquiry Dialog Box

7 Select OK to close this dialog box and return to the device window.

Request Sense
After every command, the status of that command is checked for errors. If an error
occurs, a “Check Condition” status is reported, and Sense Data is updated. Sense
Data is preserved until retrieved by a Request Sense command or until the same
drive receives another command. Initiating the Request Sense command at the time
an error is returned allows you to determine the specific error condition.
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NOTE����
The first command after a “Check Condition” status resets the Sense Data. This
means that if a Request Sense command is not issued at this point, the error
information will be lost.

To request sense:
1 Select Request Sense from the Common menu. The Request Sense Command

dialog box appears.

Figure 209: Request Sense Command Dialog Box

2 Enter a buffer length (or accept the default of 18). Clicking Reset changes any
altered information back to the default settings.

3 Click OK to complete the command. The results appear in the lower part of the
device window.

Send Diagnostics
This command initiates certain predefined diagnostic tests/exercise routines, in order
to perform a self-test. The information specified for this command is unique to the
device being used. If the test is not successful, the status will read “Check
Condition,” and a Request Sense command should be performed to describe details
about the failure (For information, see Request Sense, above.)

To send diagnostics:
1 Select Send Diagnostics from the Common menu. The Send Diagnostics

Command dialog box appears.

Figure 210: Send Diagnostics Command Dialog Box

2 Set the appropriate options. Clicking Reset changes any altered information
back to the default settings.
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3 Click OK to complete the command.

Receive Diagnostics
The Receive Diagnostics command collects and displays the information gathered
using the Send Diagnostics command.

To receive diagnostics:
1 Select Receive Diagnostics from the Common menu. The Receive Diagnostics

Command dialog box appears.

Figure 211: Receive Diagnostics Command Dialog Box

2 Enter a buffer length. Clicking Reset changes any altered information back to
the default settings.

3 Click OK to complete the command.

Mode Sense
This command retrieves element parameter information, including element
addresses, number of drives, and element characteristics. The results are unique to
the device being used.

To execute mode sense:
1 Select Mode Sense from the Common menu. The Mode Sense Command dialog

box appears.

Figure 212: Mode Sense Command Dialog Box

2 Enter the appropriate information. Clicking Reset changes any altered
information back to the default settings.

3 Click OK to complete the command.
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Custom Command
For any command that is not available through a menu option, a customized
command can be performed directly from SCSI Manager. For detailed information
on Command Descriptor Blocks, lengths needed, and so on, refer to the SCSI
reference manual for the specific device.

To execute a custom command:
1 Select Custom Command from the Common menu. The Custom Command

dialog box appears.

Figure 213: Custom Command Dialog Box

2 Enter the appropriate information. Clicking Reset changes any altered
information back to the default settings.

3 Click Send to complete the command.

JUKEBOX MENU COMMANDS

The Jukebox menu in SCSI Manager contains commonly used commands for SCSI
device controls.

Figure 214: SCSI Manager Jukebox Menu
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JUKEBOX MENU FUNCTIONS
SCSI Manager’s Jukebox menu provides functions for working with a library and its
elements. Elements include storage slots, mailslots, drives, and the picker
mechanism.

NOTE ����
Jukebox menu commands can only be accessed when browsing is disabled.

Initialize Element Status
The Initialize Element Status command checks all elements for relevant status. This
command acts as a kind of soft reset, to make sure the element is ready to receive
commands. This information is retained and is available through the Read Element
Status command.

� Select Init Element Status from the Jukebox menu. The command appears in the
device window.

Figure 215: Initialize Element Status Result

The status reads “success” when the initialization is successful.
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Read Element Status
This command gives the exact status of the various elements within the library.

To read element status:
1 Select Read Element Status from the Jukebox menu. The Read Element Status

Command dialog box appears.

Figure 216: Read Element Status Command Dialog Box

2 Select the element type from the drop-down list. Enter the Start Element
Address, Number of Elements, and Return Buffer Length in the text boxes.

3 Click Help to display a dialog box with Hex values needed for the specific
device. Click Reset to return any changed information to the default settings.

4 Click OK to complete the command.
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Moving Media
This command moves media between library elements.

NOTE����
When inserting media into a drive that uses the NTFS or FAT file system, use the
FSMOUNT.EXE utility from a command prompt to mount the file system after the
media is mounted. For details on using FSMOUNT.EXE, refer to the OTG
Knowledge Base (accessed through the OTG MEDIASTOR program group).

To move media between library elements:
1 Select Move Medium from the Jukebox menu. The Move Medium Command

dialog box appears.

Figure 217: Move Medium Command Dialog Box

2 Enter the Source and Destination Element Addresses and select whether or not
to invert the media (if the media is dual sided).

3 Click Help to display a dialog box with Hex values needed for the specific
device. Click Reset to return any changed information to the default settings.

4 Select OK to complete the command.

NOTE����
An advantage of using SCSI Manager over Jukebox Manager to perform such a
command is that while both interfaces will perform the move, SCSI Manager
provides the SCSI commands behind the action.

Position to Element
This command positions the picker (transport element) in front of the specified
element. This is useful for setting the picker to rest in front of a certain drive for
faster performance, or to a location that is out of the way from blocking access to a
storage element that requires manual intervention.
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To position to element:
1 Select Position to Element from the Jukebox menu. The Position to Element

Command dialog box appears.

Figure 218: Position To Element Command Dialog Box

2 Enter the Transport and Destination Element Addresses and select whether or
not to invert the picker.

3 Click Help to display a dialog box with Hex values needed for the specific
device. Click Reset to return any changed information to the default settings.

4 Click OK to complete the command.

Removing Media
This command specifies whether or not media can be ejected from the library using
the Eject button on the front panel of the library. The Allow command may need to
be sent in order to eject media from a drive that is locked. Likewise, sending a
Prevent command will lock access to a drive from any other thread trying to access
it.

To allow media removal:
1 Select Medium Removal from the Jukebox menu. The Medium Removal

Command dialog box appears.

Figure 219: Medium Removal Command Dialog Box

2 Select whether to Allow or Prevent media from being removed from the drive,
either by the Eject button on the front panel of the library or a SCSI command.
Click Reset to return any changed information to the default settings.

3 Click OK to complete the command.
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DRIVES MENU COMMANDS

The Drive menu in SCSI Manager contains commands for carrying out drive-related
functions.

Figure 220: SCSI Manager Drives Menu

DRIVES MENU FUNCTIONS
SCSI Manager’s Drives menu provides functions that deal specifically with drive
performance and media read/write capabilities. This section lists each function that
can be performed using this menu.

NOTE ����
Drive menu commands can only be accessed when browsing is disabled.
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Reading Sectors
You can read information from a piece of media one sector at a time, or multiple
contiguous sectors at a time. The Read Sector command reads specified sectors and
displays their contents.

To read media sectors:
1 Select Read Sector from the Drive menu. The Read Sector Command dialog box

appears.

Figure 221: Read Sector Command Dialog Box

2 Set the appropriate Relative Address, Force Unit Access and Disable Page Out
options. The default for each of these options is No.

3 In the Logical Block Address text box, enter the first sector to be read (the first
starting sector is 0).

4 In the Logical Block Count text box, enter the number of sectors to be read.

5 Click OK. The sector data appears in the lower portion of the device window
and is saved in a memory buffer. Click Reset to return any changed information
to the default settings.

NOTE����
Media must be mounted in a drive and spun up using the start/stop unit command to
perform a read sector.

Writing Sectors
The Write Sector command is used in conjunction with Read Sector. Once
information has been read, it is buffered, and appears in the lower portion of the
device window. All or part of the information can be written to a new media location
to a specific sector or range of sectors. For WORM media, this information can be
written only if there are unused sectors. Information cannot be rewritten to WORM.
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NOTE����
Be sure that the number of sectors in the data buffer is at least as large as the number
of sectors to be written. For example, if ten sectors are to be written, at least ten
sectors must have been read and placed in the data buffer.

To write media sectors:
1 Use the Read Sector command to display the sector data to be copied. (For

instructions, see Reading Sectors on page 224.)

2 Select Copy Data from the System menu.

3 Activate the device window for the device containing the media to which the
information is to be copied.

4 Select Paste Data from the System menu. The information is pasted into the
buffer.

5 Select Write Sector from the Drive menu. The Write Sector Command dialog
box appears.

Figure 222: Write Sector Command Dialog Box

6 Set the appropriate Relative Address, Force Unit Access, and Disable Page Out
options.

7 Select the sector or range of sectors to which the data should be written using
the Logical Block Address and Logical Block Count text boxes.

8 Click OK. The data is written to the specified sector(s) on the media. Click
Reset to return any changed information to the default settings.

Read Capacity
This command reads the capacity of the media in the drive. The result is a hex value
with total number of sectors.
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To determine read capacity:
1 Select Read Capacity from the Drive menu. The Read Capacity Command

dialog box appears.

Figure 223: Read Capacity Command Dialog Box

2 To read partial sectors, select Yes and enter a starting sector number. Selecting
No (default) reads the entire media.

3 Click OK. The results appear in the lower part of the device window.

4 Click Data Structure to display a dialog box containing the read results.

Starting and Stopping Unit
This command starts or stops the rotation of the media in the drive and/or ejects the
media from the drive.

To start or stop the unit:
1 Select Start/Stop Unit from the Drive menu. The Start/Stop Unit Command

dialog box appears.

Figure 224: Start/Stop Unit Command Dialog Box

2 Select the appropriate options: Start or Stop, and Yes or No for media load/eject,
depending on whether or not it is desired to eject or load media. In some
instances, media may need to be ejected in order to be spun down.

3 Click OK to complete the command. Click Reset to return any changed
information to the default settings.
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Formatting Media
A low-level format can be performed on a piece of media in a drive.

To format drive media:
1 Select Format from the Drive menu. The Format Command dialog box appears.

Figure 225: Format Command Dialog Box

2 Select the appropriate options.

3 Click OK to complete the command. Click Reset to return any changed
information to the default settings.

CCHHAAPPTTEERR
EEIIGGHHTT

JUKEBOX MANAGER

Jukebox Manager is a software utility that provides an interface for viewing system
libraries, as well as a tool for troubleshooting. Shipped with MEDIASTOR (MS),
Jukebox Manager offers such useful functions as viewing library profiles,
performing a library inventory, and inserting, ejecting, moving, mounting,
exchanging, flipping, and dismounting media. Library contents are quickly and
easily displayed without having to go through MS.
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Jukebox Manager provides only a general overview of the library and its contents,
including whether or not media exists in drives and shelves. It does not specify any
information about the media or their contents, nor does it allow media-related
functions. This is sufficient for some diagnostic procedures; however, if more
detailed diagnostics are necessary, it may be more helpful to use SCSI Manager.

NOTE ����
Jukebox Manager does provide bar code information for tape and optical media if the
library supports volume tags.

STARTING JUKEBOX MANAGER

Jukebox Manager is one of the utilities packaged with OTG MEDIASTOR (MS) and
can be accessed through the Utilities folder in the OTG MEDIASTOR program group
in the Windows Start menu.

To start Jukebox Manager:
� Select the Jukebox Manager option from the OTG MEDIASTOR program group,

accessed through the Windows Start menu. The Jukebox Manager window
appears.

Figure 226: Jukebox Manager

The Jukebox Manager window contains a Jukebox List dialog box, which lists
all SCSI libraries on the system. Serial libraries appear only after they are
configured in MS.
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INITIALIZING/SHUTTING DOWN JUKEBOX MANAGER
Jukebox Manager initializes automatically when started and upon initialization,
looks for all SCSI libraries and opens a Jukebox List window.

Jukebox Manager can be shutdown and re-initialized at any time.

NOTE����
Jukebox Manager cannot initialize if MS or SCSI Manager is running. Only one of
these services can access devices at a time.

To initialize Jukebox Manager:
� Select Initialize from the File menu. The Jukebox List window appears. When

Jukebox Manager is initialized, a check mark appears by the Initialize command
in Jukebox Manager’s File menu.

Figure 227: Jukebox Manager File Menu

To shut down Jukebox Manager:
� Select Shutdown from the File menu. A check mark now appears by the

Shutdown command in the menu. When Jukebox Manager is shut down, all
library windows are closed.

EXITING JUKEBOX MANAGER
Upon exit, Jukebox Manager is automatically shut down. Jukeboxes can now be used
by other services, including MS.

To exit Jukebox Manager:
� Select Exit from the File menu.

JUKEBOX MANAGER INTERFACE

Jukebox Manager is an easy-to-use interface that allows you quick and easy access to
system libraries. Using this menu/button-driven interface, libraries can be viewed,
tested, and controlled. You can determine what features are associated with each
library, narrow down troubleshooting problems and potentially recover from a
hardware error.
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JUKEBOX LIST
When Jukebox Manager is initialized, it seeks out all libraries currently connected to
the system and lists them in a Jukebox List window.

The Jukebox List window lists all of the libraries along with their SCSI addresses
and their descriptions. The description for each library is the actual inquiry string
from the device. This can be helpful when working with a Technical Support
representative to try to resolve an issue. From this dialog box, you can open a
Jukebox window or open a Profile for the selected library.

If you close a Jukebox window or shutdown Jukebox Manager, the Jukebox List
window also closes. It can be reopened from the Jukebox menu (when Jukebox
Manager is initialized).

To open the jukebox list:
1 Select List from the Jukebox menu. The Jukebox List appears.

Figure 228: Jukebox List

2 From the Jukebox List dialog box, you have three choices:

� Highlight the desired library, then click Profile to display an active Jukebox
Profile

� Highlight the desired library, then click Select (or double-click the library)
to display an active Jukebox window.

� Click Close to close the Jukebox list.

JUKEBOX PROFILE
The Jukebox Profile lists pertinent information about the library. Since all libraries
are different and have slightly different functionality, the Jukebox Profile is helpful
for determining not only the SCSI ID and description of the library, but particular
functions of the library, like whether or not double-sided media is supported.
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To view a jukebox profile:
1 Highlight the desired library in the Jukebox List, and then click Profile. The

Jukebox Profile appears, with the SCSI address listed in the title bar.

Figure 229: Jukebox Profile

2 Click OK to close the Jukebox Profile and return to the Jukebox List window.

JUKEBOX WINDOW
The Jukebox window shows some basic information about the library, including
description, SCSI address, library type, interface type, number of drives, and number
of shelves. All commands for a library must be performed while that library window
is active. Any command executed affects the active window.
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To open a jukebox window:
� Highlight a library in the Jukebox List and click Select (or double-click the

library). The Jukebox window for that library appears.

Figure 230: Jukebox Window

In addition to basic information about the library, the Jukebox window also provides
a shelf-by-shelf view of the library. Shelves are listed to the left of the window and a
scroll bar allows you to browse all of the shelves. The center of the window lists the
drives in the library, as well as the mailslot. Each shelf, drive, and mailslot appears at
all times whether or not it contains media.

The Jukebox window lists the SCSI Address in the title bar, so you can easily note
which library’s information is being displayed in the active window.

Figure 231: Jukebox Window Title Bar

Commands are performed simply and quickly using either the Jukebox menu
commands or the corresponding buttons at the right of the Jukebox window. The
following sections explain the commands that can be performed through Jukebox
Manager.

To close the jukebox window:
� Click Close or select Close from the Jukebox menu. The Jukebox window is

closed and you are returned to the Jukebox List.

NOTE����
All procedures outlined in the following sections assume you have opened the
Jukebox window for the library for which you want to perform that function.
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JUKEBOX INVENTORY

When a library is inventoried in Jukebox Manager, an account is taken for all
shelves, full and empty. After an inventory, the Jukebox window shows whether or
not each shelf, drive, or mailslot currently contains media.

Figure 232: Jukebox Window With Media Information

To inventory a library:
� Click Inventory in the Jukebox window, or select Inventory Jukebox from the

Jukebox menu.

An “Inventory in Progress” status message appears while the library is inventoried.
Once the inventory is complete, the Jukebox window shows media and their
locations within the library.

INSERTING MEDIA

A piece of media can be inserted into the library onto any empty shelf. The
maximum number of drives supported for each jukebox is 128.

To insert media:
1 Place the piece of media into the mailslot.

2 Highlight the empty shelf where the media should be inserted.

3 Click Insert in the Jukebox Window, or select Insert Media to Shelf from the
Jukebox menu.

A status message reads “Inserting media” while the media is placed onto the shelf.
Once inserted, the media appears on the shelf in the library window.
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NOTE����
You will be prompted to insert media into the mailslot if this has not been done
before clicking Insert.

EJECTING MEDIA

A piece of media can be ejected from any shelf in the library, provided the media is
not currently mounted in a drive. To eject media from a drive, you have to move it to
a shelf first. For instructions, see Moving Media below.

To eject media:
1 Highlight the shelf from which the media should be ejected.

2 Click Eject, or select Eject Media From Shelf from the Jukebox menu.

3 A status message reads “Ejecting media” while the media is ejected. Once
ejected, the media is placed into the mailslot. In the Jukebox window, the media
now appears in the mailslot.

4 Remove the piece of media from the mailslot.

MOVING MEDIA

A piece of media can be moved from one shelf location to another, provided the
target location is empty.

To move a piece of media:
1 Highlight the shelf with the media to be moved.

2 Click Move, or select Move Media From Shelf to Shelf from the Jukebox menu.
The Move Jukebox Media dialog box appears.

Figure 233: Move Jukebox Media Dialog Box

3 Enter the location of the shelf to which the media should be moved. The default
location is the next empty shelf.

4 Click OK to move the media.

A status message reads “Moving Shelf nn to Shelf nn,” where nn represents the shelf
numbers. In the Jukebox window, the media now appears in the new shelf location.
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MOUNTING MEDIA

A piece of media in a shelf can be mounted into an empty drive.

NOTE����
When mounting media into a drive that uses the NTFS or FAT file system, use the
FSMOUNT.EXE utility from a command prompt to mount the file system after the
media is mounted. For details on using FSMOUNT.EXE, refer to the OTG
Knowledge Base (accessed through the OTG MEDIASTOR program group).

To mount a piece of media:
1 Highlight the shelf containing the piece of media to be mounted.

2 Highlight the drive in which the media should be mounted.

3 Click Mount, or select Mount Media in Drive from the Jukebox menu.

4 The Mount Jukebox Media dialog box appears. Select an invert option: No
mounts the media with side A up; Yes inverts the media so that it is mounted
with side B up;

Figure 234: Mount Jukebox Media Dialog Box

5 Click OK to mount the media.
A status message reads “Mounting…” while the media is mounted in the drive.
In the Jukebox window, the media appears in the selected drive along with its
shelf number. In the Shelves part of the display, the media now appears with the
drive number, to indicate that it is mounted.
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Figure 235: Jukebox Window after Mounting Media

DISMOUNTING MEDIA

Media in a drive can be dismounted and placed back into a shelf. When dismounted,
Jukebox Manager places the piece of media back into the shelf where it was located
before mounting.

NOTE����
When inserting media into a drive that uses the NTFS or FAT file system, use the
FSMOUNT.EXE utility from a command prompt to mount the file system after the
media is mounted. For details on using FSMOUNT.EXE, refer to the OTG
Knowledge Base (accessed through the OTG MEDIASTOR program group).

To dismount a piece of media:
1 Highlight the appropriate drive in the library window.

2 Click Dismount, or select Dismount Media From Drive from the Jukebox menu.

The piece of media is dismounted and placed back on its original shelf.

FLIPPING MEDIA

Media in a drive can be flipped, or inverted (if dual sided), while in the drive.

To invert a piece of media:
1 Highlight the appropriate drive in the library window.

2 Click Flip, or select Flip Media in Drive from the Jukebox menu.
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The media is inverted. The Jukebox window reflects this by displaying the media
with an "I" (for Inverted) after its shelf name (such as S18-I), in both the shelf list
and the drive list.

Figure 236: Jukebox Window After Flip
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